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Congratulations on the purchase of a Leica iCON site software.

This guide is intended to introduce you to the iCON site software, and explain
how it connects and operates with other Leica Construction products. It can
act as a quick field reference manual, whilst also providing concise information
relating to configuration, data transfer, and the functionality contained within
different field applications.

The content of this document is subject to change without prior notice. Ensure
that the product is used in accordance with the latest version of this docu-
ment.

Updated versions are available for download at the following Internet address:
myWorld@Leica Geosystems > myProducts.

This manual applies to the Leica iCON site software.

Name Description/Format = 'ﬁ]
Leica iCON This guide is intended to introduce you to the - v
site How-To  iCON site software, and explain how it con-

Guide nects and operates with other Leica Construction

products. Included are detailed descriptions of
special settings and functions.

Refer to the following resources for all Leica iCON site documenta-
tion/software:

« the Leica USB documentation card

« myWorld@Leica Geosystems

The symbols used in this manual have the following meanings:

Type Description

= Important paragraphs which must be adhered to in practice
as they enable the product to be used in a technically cor-
rect and efficient manner.

Some features are only accessible when using a specific instrument, for
example a Total Station. In appropriate sections of this manual, this will be
indicated with special icons: for Total Station, [ for a GPS instrument,
or + €8 for both instrument types.

*  Windows® is a registered trademark of Microsoft Corporation in the
United States and other countries

All other trademarks are the property of their respective owners.

myWorld@Leica Geosystems offers a wide range of services, information and
training material.



https://myworld.leica-geosystems.com
https://myworld.leica-geosystems.com
https://myworld.leica-geosystems.com

With direct access to myWorld, you are able to access all relevant services
whenever it is convenient for you.

The availability of services depends on the instrument model.

Service

Description

myProducts

Add all products that you and your company own
and explore your world of Leica Geosystems: View
detailed information on your products and update
your products with the latest software and keep up-
to-date with the latest documentation.

myService

View the current service status and full service his-
tory of your products in Leica Geosystems service
centres. Access detailed information on the services
performed and download your latest calibration cer-
tificates and service reports.

mySupport

Create new support requests for your products that
will be answered by your local Leica Geosystems
Support Team. View the complete history of your
support requests and view detailed information on
each request in case you want to refer to previous
support requests.

myLearning

Welcome to the home of Leica Geosystems online
learning! There are numerous online courses — avail-
able to all customers with products that have valid
CCPs (Customer Care Packages).

myTrustedServices

Add your subscriptions and manage users for Leica
Geosystems Trusted Services, the secure software
services, that assist you to optimise your workflow
and increase your efficiency.

mySmartNet

HxXGN SmartNet is the GNSS correction service built
on the world's largest reference station network,
enabling GNSS-capable devices to quickly determine
precise positions in the range of one to two centi-
metre accuracy. The service is provided 24/7 by a
highly-available infrastructure and professional sup-
port team with more than 10 years of experience
reliably delivering the service.

myDownloads

Downloads of software, manuals, tools, training
material and news for Leica Geosystems products.
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1

Operating Principles

1.1

System Overview

Instruments and con-
nectivity

Data storage, con-
nectivity of controller

Firmware updates

System information

iCON site is pre-configured to be compatible with following Leica Total Sta-
tion/GPS instruments:

Function Name Connectivity with
controller
Manual Total Station Leica Builder Cable
Leica iCON iCB60 Short-range Bluetooth

Leica iCON iCB50
Leica iCON iCB70

Robotic Total Sta- Leica PowerTracker Cable
tion Leica iCON iCR50 Short-range Bluetooth
Leica iCON iCR60 Long-range Bluetooth

Leica iCON iCR70
Leica iCON iCR80
Leica iCON iCR80S
Leica TS16, TS60

Leica MS60
GPS antenna and Leica iCON iCG30 Cable
receiver Leica iCON iCG60 Short-range Bluetooth

Leica iCON iCG70

= For further information on the specific instrument, please refer to the
associated manual provided with the product.

The 7" controller can record and store data internally. Data can be transferred
to an Office PC using a USB connection.

Device Internal storage
7" 128 GB hard drive
= For further information on the specific instrument, please refer to the

associated manual provided with the product.

Before installing any firmware updates, tap System and then Active Licences
to check the maintenance status. Ask your agency or your Leica Geosystems
representative for information about maintenance renewal.

iCON site will conduct a maintenance check before any update
installation.

To retrieve system information, tap System and then About.

e The software version and the build installed are displayed.

- This software contains copyright-protected software that is licensed
under various open source licenses. The copyright information and a link
to detailed information is displayed.

e« The MAC ID of the hardware the software runs on is displayed as well.

An internet connection is needed to view the detailed copyright
information.

Operating Principles



Activate optional fea-
tures

The software offers some optional features or applications like Roading. Such
optional features are licensed.

=< A list of optional features can be found in the Equipment List on
myWorld.

Activating features protected by an entitlement

Features that are protected by an entitlement can be activated on the control-
ler unit or on an instrument with a display unit by tapping System and then
Add Licences. Enter the entitlement received from your representative and

tap ’/.

To update an entitlement tap the o button that can be found in the Func-
tion bar at the bottom of the screen.

= An internet connection is needed to activate an entitlement.

Activating features protected by a license key
Some features are protected by license keys that need to be uploaded to the
instrument from an SD card or a USB flash drive.

e On TPS with display license upload can be handled directly on the TPS
instrument.
e For TPS without display license upload has to be steered via the controller.

Below short instructions on uploading licenses using the controller are given.

= For further information ask your agency or your Leica Geosystems
representative.
1. Insert the memory device into the instrument and turn the instrument on.
Make sure that the instrument is properly connected to the controller.

2. Tap Devices, then tap on ) next to the instrument name to edit its
profile.

3. Tap Sensor Utilities, then tap Upload licence key in the Sensor Utilities
screen.

4. Select the license *.key file to be uploaded and tap the Start Upload
button.

1.2

The Software User Interface

1.2.1

Equipment

Display formats

Operating Principles

iCON site is available in different display formats, depending on the equipment
you are using:
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The applications used in each display format have the same functionality.

1.2.2 Navigation Concept
Startup 1. iCON site software starts automatically after the device is switched on.
2. In case the iCON site software was exited, you can re-enter by selecting

10

iCON from the Start menu or Desktop within Windows.
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Logout/Shutdown The Power key in the Home Menu navigates to the Exit/Shutdown screen,
giving the following options:

~ 9

Shutdown controller and
sensor

Exit

«  Exit:
Closes iCON site.
«  Shutdown controller and sensor:
Shuts down controller and connected sensor.

Principles of opera-

i Upon launching iCON site, Home Menu is the first screen to be displayed.
ion

Description of the Home Menu elements:

{"Measure

®%40.000

Import & Delete

SiteC rApplications
| .
Jobs2 Files2 l ®
f !
@
o | Stakeout Slopes Volumes cut &Fill
|
Files 1 I %% I g
0 Y i
I wic caibration Setup Calculator
h I
|
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A Bxport e

Reports

Stake List Management
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a Back key for last used applic- e Power button
ation f  Project and jobs management
b lcon of last used application g  Applications container
h
i

N

Status bar 1 Settings container
d Status bar 2 Data management

Operating Principles 11
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Element

Description

Status bar

Contains icons that indicate status of the
controller, and the connected instrument. In
the Home Menu, the Status Bar is minimised
and read-only.

Power button

Exit the software or shutdown the controller
and sensor.

Project and jobs manage-
ment

Contains options to manage projects and
jobs.

Data management

Contains options to import, export or delete
data, to manage stakeout lists and to create
reports.

Applications container

Displays the different applications available
for use.

Settings container

Contains options for editing user informa-
tion, units and tolerances, and connected
device settings.

Licenses can be added here.

The software allows for a user configurable content of the Home

Menu, using the User Permissions feature. Therefore the Home
Menu configuration may differ from the one shown in this manual.
Refer to User Permissions for more information.

Operating Principles



Applications Once an application is selected, you are directed to the Map screen.

Description of the Map screen elements:

* A\ B3 No data loaded

006804_007

a Application key k  Limit Box indicator
b Status 1 | dlipping Filter indicator
c Status 2 m Isolation mode indicator
d Information bar n Main map area
e Warning bar (only displayed if 0 Measure bar
there is an issue) p Home key
f  Scale bar q Toolbox
g North indicator r  Favourites
h  Button for panning mode s Map handler
i Button for rotation mode (3D)
j  Button for auto-centring the
map view
Element Description
Application key Displays name of current active project, active job

and active coordinate system.

Displays Leica ConX status information, if Leica ConX
licence is activated.

Displays TPS setup information, when connected to
a total station.

Displays Base Station information, when connected
to an iCON iCG70.

Status 1 Displays status of connected Total Station or GPS
instrument. Contains options to directly edit func-
tion/status of the instrument.

Operating Principles 13
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Element Description
Status 2 * For I displays status of target, for example
pole and prism information, and controller.

* For €8 displays status of the communication
devices (radio or modem). Contains options to
edit relative settings.

Warning bar Displays any issues with the operation that may

compromise usability.

Information bar

Displays information about the current measure-
ment, the selected points, and all configured values.
Tap and hold to configure.

North indicator and
scale bar

Indicates scale and orientation of display.
Tap the North indicator to reset the map to 2D view.

Indicator for Clip-
ping Filter

Displayed if Clipping Filter mode is active. Allows
quick access to the Clipping Filter function.

Indicator for Limit
Box

Displayed if Limit Box mode is active. Allows quick
access to the Limit Box function.

Indicator for Isola-
tion mode

Displayed if Isolation mode is active. Allows quick
access to the Isolate function.

Main map area

Graphically displays pre-loaded data and measured
data.

Measure bar

Displays main command keys, for example Measure
or Store.
Tap and hold to configure the Measure bar.

ality is present.

Home key Navigates back to the Home Menu.
Toolbox Contains functions relevant to the active application.
Favourites Contains Camera, Calculator and TPS setup, when
connected to a TPS.
You can add Measure Bar functions into the Favour-
ites. Refer to Measure bar for information about
configuring Favourites.
Map handler Change zoom level and view mode. Define data dis-
played in the main map area. Access to point list.
= Depending on the specific application being used, different function-

If you tap the Home key while in an application, you return

to the Home Menu. The Title bar contains a Back key with an
option of navigating directly back to the previous application,
for example Measure:

{ Measure

@8 &7 50.000

Applications
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Status bar Status bar displays the status of the controller, the status of the connected
instrument, pole and prism information, and information about the current
application. It consists of three keys:

a Application key

C
|

a
|
e

006800_003 C Status 2

Key Description

Application key « Displays key information about the current job,
— project and application.
O « An additional icon displays the current status of

Leica ConX or any other cloud services.

»  Once tapped, the Application key allows you
to access the Station information details by
tapping Station Info as well as the details of
the active cloud service by tapping the current
status icon of the respective cloud service.

Status 1 Instrument status.

»  Select the Measure Mode from Single Manual,
Single Auto, and Continuous with lock.

«  Select Visibility settings. (not available for
iCON iCR70/iCON iCR80)

»  Switch Laser Pointer, Guidelight, and Com-
pensator on or off.

+ Use Hz = 0 to easily set the current orientation
as zero orientation.

»  Use the Check Setup function to start a Total
Station setup check.

Operating Principles 15



Key Description

Status 2 Pole and controller status.
«  Define Prism Type and Prism Height.
ﬁ 2.000— Use Turn to point to simply select a point
and have the Robotic Total Station automatically
turned to that point.

« Battery and memory status is also displayed.

«  Start the Move & Search pilot.

e Prism search controls are found in the Search
Settings.

« Use Search Sector to define a sector for the
automatic prism search, which helps to reduce
prism location time.

« To ban fixpoints from a PowerSearch set Tar-
get Snap to On. PowerSearch will then ignore
prisms with known position. All prisms used for
a station setup calculation and all measured
control points are excluded from any Power-
Search.

= Target Snap can only be used with a
iCON iCR60, iCON iCR70, iCON iCR80, TS16,
TS60, MS60 and the appropriate license.

«  With Tune out targets the Leica iCON iCR60,
TS16, TS60, MS60, iCON iCR80 or iCON iCR70
(with additional licence) starts a scan: the Total
Station searches three times the full circle and
scans for target points. All scanned targets are
included in the Exclusion List. An existing Exclu-
sion List is overwritten. All points within the
Exclusion List are excluded for automatic or
manual prism searches.

= Status 1 and Status 2 contain more information/functionality once
tapped, allowing the status of instrument and pole to be changed.

= The content of Status 1 and Status 2 changes depending on the
functionality of the connected Total Station.

Status 1: Status 2:

TotalStation Simulator Controller/Target

@ ﬁ @ ®D _ L@ ][ 0.000===;
@ @ @0 ‘ ][ @o

Measure Mode Visibility Laser Pointer Guidelight Prism Type Prism Height Turn to point

Level & Search

Hz=0 Move & Search Search Sector Target Snap

Compensator Settings

Tune out
targets

Operating Principles



Status bar [d:d

Status bar displays the status of the controller, the connected instrument,
position quality information, and information about the current application. It
consists of three keys:

a Application key

b Status1
Cc Status 2
Key Description
Application key - Displays key information about the current job,

— project, application and the active coordinate
@ system.
« An extra icon displays the current status of
Leica ConX or BIM 360 Docs.
Once tapped, the Application key allows you to
access the Leica ConX Information details by
tapping the current Leica ConX status icon.

Status 1 Instrument/Antenna status.

«  Displays position, tilt angles and satellite inform-
ation.

« Allows you to alter the antenna height and to
activate tilt functionality.

«  Select the Measure Mode, for the instrument
used as rover. Refer to 1.3.4 Measure Mode for
more information.

= Tilt functionality is only available for the
iCON iCG70 antenna.

Status 2 Communication status.
«  Displays connection status of radio, modem and
Bluetooth.

»  Displays battery and memory status.

Status 1 and Status 2 contain more information/functionality once
tapped, allowing the status of the antenna to be monitored and
changed, and the position quality to be reviewed.

Status 1: Status 2:

iCON GPS 60

SHNINRC)

Measure
Mode

Controller/Target

Position Satellite Antenna

Battery &
Memory

Operating Principles
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Status bar for
internal GPs [

Warning bar

18

The status bar is only available when the profile for internal GPS is set up
and no other profile is active. Refer to 1.5.6 Setting up a GPS Profile for the
Internal GPS of CC80.

Status bar displays the status of the controller, position quality information,
and information about the current application. It consists of three keys:

a b C _—
| | a Application key

b Status 1
c Status 2

Key Description

« Displays key information about the current job,
project, application and the active coordinate
system.

Leica ConX as well.

Once tapped, the Application key allows to
access the Leica ConX Information details by
tapping the current Leica ConX status icon.

« An additional icon displays the current status of

Status 1 Controller/Internal GPS status:

%Lé’ E?Fﬁ 1400 Tap to display position information.

Tap to display satellites information.

&
Tap to alter the controller height.
Tap to select the Measure Mode, for the

instrument used as rover. Refer to 1.3.4 Measure
Mode for more information.

Status 2 « Indicates that internal GPS is enabled.
«  Displays battery and memory status.

Displays any issues that are affect-

ing operation. /\ B No data loaded

= The number on the Warning bar indicates the total number of
warnings that are currently active.

Operating Principles



The warning bar can be tapped to

display the full message, which: No active coordinate
« displays further information

about the problem(s),
«  provides navigation to areas

where the problem can be fixed. Please import a valid coordinate
system.

- system set

= By pressing OK without
fixing the problem, the :
warning will be ignored OK

until it is detected again.
Recommended Actions

Information bar Displays information that is relevant to the current action being carried out.
This will be in one of three forms:

«  Guidance text whilst carrying

« Data from last made measure-
ment.

11+ 1.500
1.000 ~ 2.100

«  Directional guidance whilst

staking out. Turn Telescope.

2 70.394

The white dots at the base of the Information bar indicate the total number
of active pages, which can be scrolled through by tapping on the left hand
side or right hand side of the Information bar.

Configure the Information bar

p=m The display format and content of the Information bar can be con-
figured according to your preferences.
Tap and hold for 2 seconds within the Information bar area.
A menu is displayed where you can define the number of pages in
the Information bar, and the amount of content on each page. The
content available depends on the connected instrument.

Depending on the application, different help pictures are available to

@ demonstrate the meaning of the Information bar values. To display
the help pictures, tap the info button at the top right corner.

S Several help pictures may be available in the Info bar help
screen. Scroll down to display all available pictures.

If you put the same value into more than one box, the text and icon size will
enlarge, as shown in the examples. This can be useful to focus on specific
values.

Operating Principles 19



Main map area The main area of the screen displays all points, lines, and arcs that have been
measured, as well as any other data that is loaded to the active job.

11}« 1.500
A o . = 1.000[ ~ 2.100
& =
L 00

Measure Store
OEIENESE

Map handler The Map handler is available whenever the Map screen is open.

d

006799_002

a Point List, including Point search and Point edit

b  Continuous Centring, Toggle between Map view and Arrow view, Ori-
entation Configuration, Viewing options, Configure the 5" or 7" mul-
tiview display

C Zoom out, Zoom to full extent

d Zoom in, Smart Zoom

e Map View manager

Key Description

Point List, including «  Shows a list of points.

Point search «  Points can then be edited, created,
deleted, but also certain properties
can be edited for points, the same
value can be applied to multiple
points.

«  Allows you to make a Point search.
Refer to 2.5 Point List, Searching
for a Point for more information.
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Key

Description

View panel

Depending on the application, following
options are available:

Turn Continuous Centering of the
measured position On or Off.
Toggle between Map view and
Arrow view in the main map area.
Use Orientation Config to define
the view direction of the Arrow view
and the Bullseye view.

Use Viewing Options to configure
which attributes are shown for each
point in the map.

Use Limit Box to reduce the amount
of visible data in the map view.

Use Isolate to reduce the number
of visible IFC objects by hiding single
objects or several objects of a spe-
cific object class.

Turn on Quick Codes to get the
code list displayed on the left-hand
side of the screen for quick access.
Multiview Config: Allows you to
configure the 5" or 7" multiview
display.

Side View is a kind of cross-section
view and only available when using
Stake Elevation.

In 5" or 7" display mode, with Mul-
tiview active, use Stakeout Point
List to get the points to be staked
displayed.

Use Perspective View to change
from the standard 2D Map view to
the perspective 3D view.

Zoom in, Smart Zoom

Zoom in.

Smart Zoom: Tap and hold to
enable Smart Zoom functionality.
Refer to 1.4.1 Smart Zoom for more
information.

Zoom out, Zoom to full
extent

Zoom out.

Smart Zoom: Tap and hold to dis-
play full extent of loaded data with
location of data being indicated by a
surrounding blue box.

Map View manager

1 BE B

Select which data from the active project
is displayed and selectable in the Map
screen. Refer to Map View manager for
more information.

Operating Principles
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Measure bar

Function bar

22

The Measure bar contains the main commands you will use whilst working, for
example Measure, Store, and Code. It consists of between one and three
keys, for example:

Measure Store Measure Store Code

You can configure the content of the keys according to how you want to
work.

Tap and Hold on the Measure bar for two seconds to configure.
@ A configuration menu opens, where different commands can be
specified. Available commands differ slightly, depending on the
open application.

= For some tasks the Measure bar will be automatically altered to allow
for the operation to be completed. Once the task is finished, the
Measure bar will return to the user defined state.

= Information about Favourites menu configuration:

e Within the Measure bar configuration screen, Tap and
Hold any key to add it to the Favourites menu. This
provides easy access to the functions you are likely to
use regularly, by simply selecting it from the Favourites
keyyy.

- To remove a key from Favourites, open the Favourites
menu, and tap and hold the relevant key.

The Function bar contains a link to the Home Menu, and all functionality
relevant to the open application. It also contains a calculator, and in some
applications it will contain a link to Setup. Depending on the open application,
function and appearance of the Function bar differs slightly.

a b C
| ; a Home key
@l’ X b  Toolbox
006802 002 c Favourites
Key Description
Home key Navigates back to the Home Menu.
A
ol
Toolbox Contains functions relevant to the open applica-
W tion.
Favourites Contains different functions that can be defined
ﬁ according your requirements. Refer to Meas-

ure bar (Information about Favourites menu
configuration) for information about configuring
Favourites.
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Wizards A number of Wizards facilitate common works. Each Wizard leads you through
a series of steps, where settings and statuses can be changed.
Example of Wizard Page
a C
Tomrane [ ) Ik
icade ‘ i lwildcard i lNoCodes i
i g
"""" % w |
Py ! ! )
a Previous Wizard step e (Cancel and exit
b Current Wizard step f  Reset to default settings
¢ Next Wizard step g Accept changes and continue
d Wizard step content
Element Description
Previous Wizard step Allows to return to previous Wizard step, if
applicable.
Current Wizard step Shows title of Wizard step that is displayed.
Next Wizard step Move to next Wizard step by tapping this
key. It is only possible to move to the next
step once all required fields are defined in
the current setup.
Wizard step content Settings that can be edited by tapping each
individual key.
Cancel and exit Exits the Wizard immediately, with no
changes saved.
Reset to default settings Resets all changed settings back to default
value.
Accept changes and exit Save changes and finish Wizard.
Only active once all Wizard steps have been
completed.
1.2.3 Icons
Description Icons provide information related to basic instrument and controller status.

Status bar: General
icons

Operating Principles

Displayed icons depend on which instrument is used, and the instrument con-

figuration.
Icon Description
Indicates connected instrument.

23



Icon Description

B i Indicates memory or data storage device type. Dis-
= = played in the Battery & Memory screen, accessible
through Status 1 or Status 2.

E E E Indicates battery status.
o]

Status bar: Total Sta- Icon Description

i ifici ’ : : :
lon specitic icons Indicates prism lock setting.
TPS

Indicates the selected prism.
: %

Indicates prism height setting. Allows you to define
two user settings for prism height.

Indicates measure mode.

Indicates compensator/level status.

Indicates that a geometric scale factor is applied to
the project.

?j Indicates that a PowerSearch is running.
Status bar: GPS spe- Icon Description
cific icons, (€8 Position status

Displays the current position solution: fixed, xRTK,
float, navigated, and no position.
Number of visible satellites
Displays the number of satellites used in position
calculation with the current satellite settings.
Tilt functionality of antenna

f 'Jb When tilt functionality is activated, the antenna icon
displays the status of initialisation: ready or not ini-
tialised.

2y = Radio status

Bl (s Displays the real-time mode of the radio.
Modem status

@| Displays the real-time mode of the modem.
SmartLink status
Displays the SmartLink status converging or con-

&% &y verged.

|
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Cloud Services - Icon Description

status icons
Status bar:

Internet connection not established.

Internet connection established.

Connected to the web page of the currently used
cloud service.

Uploading data to the web page of the currently
used cloud service.

Downloading data from the web page of the cur-
rently used cloud service.

Data transfer problem occurred.

Remote view/control in progress.

SISO

Import dialogue:

& Files that are available for downloading from the
server of the currently used cloud service..

Map screen icons Icon Description

User Point

Control Point

A
g Point being staked
"

Staked and stored outside tolerance

Staked and stored within tolerance
& & &
o @ @

Delete point

Point with one or several linked images.

. - Reference Line
& &

E P Selected Line

Target point position.
Measured; within tolerance; outside tolerance

G—i O
O—i G
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Move & Search Pilot

icons,

26

The Move & Search Pilot is available in the Status 2 menu.

It is only available when connected to a Robotic Total Station. It enables
remote control of the vertical and horizontal rotation of the telescope on
the Total Station. PowerSearchl), an intelligent prism search method, can be
triggered from this control.

Description

Switch to Joystick control.

PowerSearch left/right. Activates an intelligent prism
search in the specified direction.

Activates a PowerSearch of a predefined "window".
This window can be defined in Search Sector in
Status 2.

Activates a local PowerSearch. If no prism is found, a
full PowerSearch occurs.

Switch to PowerSearch.

ATR search. Instrument searches locally for a prism.

LI

Moves instrument in specified direction. Tap key
again to increase speed. Three speeds are available.

Cancel current search.

= To close the Move & Search Pilot, tap outside the control, in the Map

screen.

1) Depending on the connected total station called SpeedSearch or AutoSearch

instead.
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1.3

General Working Information

1.3.1

Prism Types and Prism Heights

Description

Settings for Prism Type and Prism Height Status 2

can be found in the Status bar 2 accessible from any
application, except Draw.

Set prism type step-
by-step

Operating Principles

L. From within the current application, tap in the Status bar

and select Prism Type .

12w A subscreen disp_/ays
N N the last three Prism
- types used, with

the currently active
Prism type being
highlighted.

2. To display all Prism types, tap the expand
button. @

UserPrism1  UserPrsm2  UserPrism3

3. Select the prism type you want to use by tapping the relevant sym-
bol, either from the default or the user-defined ones, for example
Leica 360.

== To define a User Prism, tap one of the relev-
ant icons. Or alternatively, to edit an existing
User Prism, tap and hold the relevant icon.
The User-Definable Prism screen pops up.
Enter the Leica or the absolute constant in

[mm] and tap 4 to confirm.
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4. The software proceeds with the current application and the newly
set prism type active.

I=>= The user defined prism is stored within the software and on the
instrument. Therefore it will be available on a second instrument, for
example when a Controller is connected to the instrument.

Set prism height L. From within the current application, tap in the Status bar

and select Prism Height .

A @ 14|
5 )
Controller/Target i )
H,
2 27I7 3.

I

step-by-step

2. Choose from pre-defined prism heights, either from the default or
the user-defined ones, by tapping on the relevant icon. Alternatively,
tap on the height entry field, enter the desired height and tap ¢ to

confirm.
= To enter the prism height in another unit, first clear the
entry field, then select the unit and finally enter the height
value.

I To define the user-defined prism height,
tap and hold one of the relevant icons.
The numerical keyboard pops up. Enter the
desired height and tap v to confirm. The
new height is set under the user-defined
icon.

ST
When you select reflectorless or tape , the default height

is set to 0.000 m. When you select any prism mode again, the prism
height is set back to the original setting.

Default prism heights Prism type Default height

[m], for [ft decimal], for [ft fractional], for
CPR1 poles  CPR2/3 poles CPR2/3 poles

Reflectorless, 0.000 0.000 0%,

Tape

MPR122 0.049 0.162 0°/35

without pole

MPR122 with 0.200 1.000 19/,

pole plate or tip
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Prism type Default height

[m], for [ft decimal], for [ft fractional], for
CPR1 poles  CPR2/3 poles CPR2/3 poles
MPR122 with 2.000 6.500 61/,
pole
MPR122 User 0.000 0.000 0%,
Defined 1 or 2
1.3.2 Automatic Search
Automatic search set- L. From within the current application, tap in the Status bar

tings step-by-step
and select Search Settings .

In the Search Set-
tings screen define

Search Settings

e — the behaviour of the
Predict For: 3s 1s .
Total Station after a
3s :
prism loss.

Search With: Cube Search »

After Cube Search

Use Search Window

Final Power Search

o

2. Define the time that the software calculates the predicted position
of the prism at Predict For:. Within this defined time period, the
system automatically searches for the prism at the calculated posi-
tion. If no prism is found, the search at the Total Station is stopped
or it continues with the next option, according to the settings in
After Prediction.

3. Additionally, with After Prediction define the behaviour of the Total

Station when the prism is not found at the predicted position.

Set Search With: to:

« No Search, to prevent the Total Station from starting a prism
search.

- ATR Search, to start an ATR search.

+  Window Search, to start a search within the defined search
window. That window is defined in Search Sector.

+ Powersearch, to start a PowerSearch.

e Cube Search, to start a dynamic PowerSearch. This is a search,
performed in a cubic area with defined dimensions around the
last known position. If the instrument has a Dynamic Lock
license loaded, Cube Search allows to find the moving prism.
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4. When using ATR Search or the Cube Search, additionally define the
behaviour after an unsuccessful prism search.
« To start a search within the defined search window set Use
Search Window to On.
« Set Final Power Search to On, to start another - and final -
PowerSearch.
= Cube Search can only be used with a iCON iCR60,
iCON iCR70, iCON iCR80S or iCON iCR80 Total Station and
the appropriate license.

Final Power Search is also available when using Window Search.

133 Geometric Scale Factor
Description The geometric scale factor is used to correct distances for the distortion

introduced by the use of a map projection.

The geometric scale factor can only
be set when creating a project. Input

New Project

Created 07.11.2021

EEETTTTe——— the desired value under Geometric
Import Data » Scale

: .

= o e You can input either the

~ Geometricscle Factor or the ppm or

Factor 0.9998870 mm/km (+/_) Value If d
R scale factor is entered, the

ppm value will be updated
accordingly and vice versa.

= The entered scale factor value affects only all Total Station measure-
ments, GPS measurements are not affected.

An additional icon & is displayed in the Status Bar, when a geomet-
ric scale factor is applied to a project.

Explanation
P1, P2 Known points

dl Ground distance
d2 Ellipsoid distance
d3 Grid distance

a Sea level

b  Elevation, 1000 m

C Height Scale factor

d Map Projection Scale

factor
e Combined Scale factor

Relation of ground distance to grid distance:

e Scale to central meridian and distance from central meridian defines the
Map Projection Scale factor, while the height above reference defines the
Height Scale factor.

- Both, the map projection and height scale factors define the PPM scale
factor.
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1.3.4 Measure Mode [€8
Description Settings for Measure Mode can be found in the Status 1:
Status bar accessible from any application, except ICON GPS 50
Draw. =
il
set Measure Mode 1. From within the current application, tap
step-by-step

bar and select Measure Mode .

A subscreen opens automatically, with the

currently active measurement mode high-

lighted.

2. «  Select Instant to have the current position measured and
recorded immediately after pressing Measure, when back in the
application. Instant is the default setting.

» Define a time period according to your needs at Averaging
Time (sec):. Now select Average (time) as measurement
mode. When you press Average back in the application, the
instrument measures for the time period defined and record the
calculated average data.

»  Select Average (manual) as measurement mode. Back in the
application press Start to start measuring. Press Stop to stop
the measuring manually. A screen pops up showing the relev-
ant information. You can store the calculated average data or
refuse them.

«  Define the number according to your needs at Averaging
Measurements:. Now select Average (# of meas.) as meas-
urement mode. When you press Average back in the applic-
ation, the instrument performs the number of measurements
defined and records the calculated average data.

3. The software proceeds with the current application and the newly

set measurement mode active.

I These Measure Mode settings are relevant for the instrument used

as rover.

1.3.5

Coordinate Quality Value [€3

Display coordinate
quality values step-
by-step

Operating Principles

=

Coordinate quality values are recorded together with every GPS
measurement. Like other measuring information, these CQ values
can be arranged to be displayed in the Information bar.

Tap and hold for 2 seconds within the Information bar area.

Within the Info bar configuration screen, tap on the arrow of the
page you want to integrate the CQ values.
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3. Select the CQ values to display: CQ 1D for the height information,
CQ 2D for the plain information and CQ 3D for the combination of
both. Tap ¥ when finished. Tap ¥ again in the Info bar configura-
tion screen to confirm.

Info bar configuration Page Configuration o
E N I> =

T CINCT TECT AT

N proj.Lin . Chainage
_ N P IR poior |- s

L L T ST Y

== In the Information bar, the CQ values are shown with one star for
height, two stars for plain and three stars for the combination.

1.4 Map View: Functions and Configuration Options
14.1 Smart Zoom I3 + €3
Enable Smart Zoom 1.

Tap and hold from the Map handler to enable Smart Zoom

step-by-ste
e P functionality. The function is accessible in all applications and all

map views. Map turns to Smart Zoom mode, turns to green ,
automatic centring is turned off.

2. Tap anywhere on the map, where you want to zoom, even on blank
space. Map is centred to the tapping area and zoomed in by one
zoom level.

3. Proceed as many times as desired. When the zoom limit is reached a

warning is displayed.

Tap anywhere on the map for zooming in.

A Czm To exit the smart zoom mode tap the zoom +

G

Tap anywhere on the map for zooming in.
To exit the smart zoom mode tap the zoom +

I Smart Zoom functionality is not available, if the map is in Bullseye
view, Arrow view, or Cross Section view.

=7 10 display the full extend of the active data tap and hold from
the Map handler.

Disable Smart Zoom . . .
Tap the green to disable Smart Zoom functionality.
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Automatic centring remains off until manually turned on again.

Enable Smart Zoom to 1.
specific data sets

Tap and hold from the Map handler to enable Smart Zoom to
specific data sets. The function is accessible in all applications and all
map views. Automatic centring is turned off.

= T ooool e locations where
A = ) I = 10.000] n 10.000' data can be found
- 0 are indicated by blue
squares.
é Measure  Point ID Code

2. Tap a square to zoom in to the specific data set.
ST . .
To select another data set tap and hold again. The map view
will be zoomed to full extent showing all data sets in blue squares.
I Smart Zoom functionality is not available, if the map is in Bullseye
view, Arrow view, or Cross Section view.
1.4.2 Additionally Available View Modes
Rotation mode i iCON site offers a three-dimensional view, except for Draw.
(3D view) step-by-
1.
step To change from panning mode to rotation mode, tap .
Now it is possible to rotate the current view three-
dimensional. The North indicator changes accord-
ingly as well.
Turn Telescope.
4 37.433 i
2| 22.305
Measure Store Point ID
2_ KA
Tap MM to freeze the current 3D view and enable panning mode
again.
= On the CC80 controller, you can also pan the Map view using two

fingers without the need to change to panning mode.

Operating Principles
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== Tap the North indicator to set the view back to

Turn Telescope.
t 37.433 ‘
2| 22.305

the standard Map view.

Measure Store Point ID

Perspective view = iCON site offers a perspective view.
step-by-step

1. To change from the standard Map view to the perspective view, tap

View and enable Perspective View .

The map view
changes to perspect-
ive view.

The North indicator
changes accordingly
as well.

Measure Point ID

| &

2 To change the height of the perspective camera, tap and pan up

or down.
@b KA

To move the position of the perspective camera, tap M and drag
the map in the required position.
To rotate the view in three-dimensional direction, tap and drag
the map in the required direction.

3.

To disable the perspective view, tap View and deselect Per-
spective View .

Use the Arrow view when staking out points. The arrow view displays the
pole position in relation to a user-defined orientation direction (refer to Con-
figuring the Orientation direction within 1.4.4 Defining the Orientation Config-

Arrow view
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urations). Arrows and corresponding distances are displayed to indicate how
to find the point to be staked.

1.
Tap . to access View in the Map handler.

2. Tap Arrow to toggle between Map view and Arrow view.

)

-
SOpoint_P03_1

<=
de= -5.156

t 0.550

PO2 f

Map View Arrow view

i  Activate Multiview to display Map view and Arrow view side by side.

= Once the pole/rover is within 2 m distance
to the selected point, both Map and Arrow
view are automatically changing to a Bullseye
view.
Dynamic labels show the distance to the tar- |
get in X and Y directions with reference to

the defined orientation. See also: Configur-
ing the Orientation direction. When the cur-
rent position is within tolerance, the labels
turn to a green colour.

To select a different point to be staked in
the Arrow view and Bullseye view, tap any-
where in the Map.

Bullseye view

Multiview 1. -
Tap to access View in the Map handler.

2.
Tap to access Multi view configuration.

== In 5" display mode, the split-screen option "2/3 and 1/3" is not avail-
able.

3. In the Multi view configuration screen, select the required View.
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1.4.3

- : The Map screen
m Multi view configuration ’.5 then dIVI de d

Sl into separate
screens.

Two Views

i To change the active section, tap in the relevant section. The Map
handler zoom controls are effective in the active section.

Continuous and Automatic Centring

Centring the Map
View

1.4.4

In order to make the map view automatically being centred, tap the but-
ton at the top left side of the map view. To switch automatic centring off, tap
the button again.

= As soon as you pan the map view, automatic centring is automatically
turned off.

You can also activate Continuous Centering via the Map Handler>View
function. See also: Map handler

When Continuous Centering is active, the map view will always be centred at
the measuring position. When inactive, the map view will be centred when the
measuring position reaches the edge of the map.

Defining the Orientation Configurations

Configuring the map
orientation

36

Access View in the Map handler and tap Orientation Config to define the
map orientation.

= The current active Orientation is highlighted in yellow.
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Overview of the available orientation methods

Method Description

NESW North, east, south and west: Aligns the
‘ map view according to the compass ori-
n entation selected.
WfE

Movement Aligns the map view dynamically accord-
% ing to current moving direction.

Line Aligns the map view according to a ref-
erence line selected. The line can be

| defined with a start point and an end
Y point, but @ multi-line is also possible.

Heading Available with iCON iCG70T when tilt
functionality is active.

e Aligns the map view dynamically accord-
ing to the antenna heading.

Configuring the Ori- 1. Access View in the Map handler.
entation direction

2. Tap Orientation Config to display the avail-
able orientation methods.
The current active Orientation is highlighted
in yellow.

3. Tap an orientation method to change the
view direction of the Arrow view and the
Bullseye view.

J: -0.188

t 4.709

T

Example:
Known Point

Overview of the available orientation methods

= Depending on the connected device, different orientation methods
are available. The method TPS is only available for TPS devices. For
GPS there are the additional methods Sun and North instead of TPS.

Method Description

TPS o} only: Aligns the view along the line
y‘ﬂ ™ of sight, from pole to Total Station.
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Method Description

Known Point Aligns the view from pole to another
‘ﬂ ™ point of the map. That point needs to
= be selected during configuration to this
‘ method.

Last Point Aligns the view from pole to the last
J‘E el staked and stored point.

North ® 3 only: Aligns the view from pole
‘E ™ to North direction of the coordinate sys-

‘ tem.

Sun g;v':{ 48 only: Aligns the view from pole to
‘E ™ the direction of the sun.
1.4.5 Viewing Options I3 + 3
== When a text is too long for its text field, tap and hold the text and the
complete text is displayed as running text.

Selecting the point = By default, the sole information for a point shown in the map is
information in the the Point ID. Anyway, iCON site allows you to configure to show two
map step-by-step different information for all points in the map, one above and one

below the point symbol.

1. From within the current application, access
View in the Map handler and tap Viewing
Options.

1= Displaying the Point Information can easily be switched On/Off
using the relevant key.

i Within the Draw application, Line Dimension is additionally avail-
able. Switch it On to have the 2D length displayed for relevant ele-
ments.

2. To change the point information above the point symbol, activate
the upper button in the section Point Information.
To change the point information below the point symbol, activate
the lower button in the section Point Information.
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Viewing Options

B " Identification
Line Information m m
Possibl nformation
Code

o] ==
Road Shading

=

s D D =N

Contrast |50

3. Now select the information you want to be displayed. Select from:

1. Id: The name or Point ID of the point.

2. H: The Height of the point.

3. Code: The Code (or layer name) of the point.

4. Cut/Fill: The stored Cut/Fill value for a stakeout point.

5. Attribute 1 to Attribute 10: Point attributes from imported

HeXML files.

6. None: No information is displayed at the selected position.

4. Tap ¢ to accept the settings and return to the map.

The settings for these viewing options are used, independent from
the Project or Job. It is possible to define and use different settings
for the different applications.

The information is shown according to the current settings, in the
chosen distance unit and the number of decimals set.

Show or hide line
names

If necessary, line names can be displayed in map view. If enabled, the line
name is displayed to the centre of a line segment or a polyline.

1. From within the current application, access View in
the Map handler and tap Viewing Options.
2. Line Information is set to Off by default.

To display the line information in map view, set Line Information to
On.

Viewing Options

Point Information On Point Information

. . Identification

Line Information m

TrT—

Code
= =

Road Shading

Contrast |50 |

Tap v to accept the settings and return to the map.

Operating Principles
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Set the visibility of
points in the map
step-by-step

Surfaces viewing
options

40

1. When laying out numerous points, the map view may start to look
crowded. It might become difficult to discern between different ele-
ments such as reference points, staked points, control points or
lines.

You have 2 options to reduce the number of visible elements during
stakeout procedure:
- Fade Staked Points
Already staked points are displayed in faded colour.
« Stakeout List Points Only
Only points of the active stakeout list and the corresponding
lines and arcs are displayed. This option includes the fading of
staked points.

2. From within the current application, access View in
the Map handler and tap Viewing Options.

3. To activate the fading of points, set Fade Staked Points to On.

To hide all points and lines not belonging to the active stakeout list,
set Stakeout List Points Only to On.

4.

Tap ¥ +to confirm.

Map view with option "Stakeout List Points Only"

being activated:

zmo SOpoint_2_1

Q)
S ;
New List 1

© 3 foundations

© 6 foundations

© 7 noCodes SOpoint_4_1

© 8 noCodes

t SR AR S JNEP

© 9 noCodes

1.

From within the current application, access View in
the Map handler and tap Viewing Options.

Viewing Options

Stakeout List Points Only m
Fade Staked Points Possible Information
EE N 8
. Cut/Fill
Surface Triangles m m
= =
Background Images
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2. If needed, set the graphical appearance for Surfaces:

«  Set Surf. Triangles to On to display triangles between surface
points.

+ Set Shading to On to have the surface triangles displayed in
different shades.

«  Set Surf. Triangles and Shading to On to have a combination
of both displayed.

+ Set Road Shading to On to have the road design displayed in
different shades. When this setting is On it is possible to select
the cross slopes directly from the map in Roading application.

Tap v 1o accept the settings and return to the map.

= The settings for these viewing options are used, independent from
the User, Project, Job or application used.
The information is shown according to the current settings, in the
chosen distance unit and the number of decimals set.

Contrast of Back-

If needed, change the contrast of an imported background image.
ground Image

1. From within the current application, access View in
the Map handler and tap Viewing Options.

2. For Contrast within Background Images, enter a value between 0
and 100.
« Value is 0: The background image is not visible.
« Value is 100: The background image is fully visible.

Viewing Options

B " Identification
Line Information m
[ swee ] e
Code
=3 =n
Road Shading

BacKioxllimages Attribute 9 Attribute 10

Contrast ‘ 50

Tap v 1o accept the settings and return to the map.

The settings for these viewing options are used, independent from
the User, Project, Job or application used.

Using an online map

. If needed, the online map from "Bing maps" can be used as background image
as background image

in map view. Before you can enable the map as background image, you need
to get a key for using Bing maps.

Steps to get the key for using Bing maps

1. Open the link https://www.bingmapsportal.com/ in a web browser.

2. If you already have an account, sign in. Otherwise, create an account.

3. In the account settings, access "My keys" and request a new key.
|
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4. Save the key as *.txt file.

Steps to enable Bing maps

= Requirements:
« Internet connection is established.
« A coordinate system is loaded to the active project.
»  Measured or imported data are loaded to the active project or
software is connected to a GPS sensor.

1. Select System from the Home Menu.

2. Select Online Map.

System Online Map

Layer Bing - Aerial >

Key

Backup and Restore

User Permissions

Touch Screen Mode

Copy key from clipboard

Low resolution

Y o
3. Enter the key for the online map or copy it from the *.txt file.
To paste the key from clipboard, tap Paste.
4. To display the online map in satellite view, set the layer mode to
"Aerial".
To display the online map in standard view, set the layer mode to
"Road".
5.

Tap ¥ to activate the online map and return to the map view.

Online map is
displayed as
background
image in map
view.

ﬁ "-LPointID ‘ Code
A f |

I To turn off the online map, set the layer mode to "None".

1.4.6 Reducing the Number of Visible Elements/Objects in Map View
Isolating IFC objects = The Isolate function for IFC objects is only available in the Layout
in the map view Objects and the Verification applications.

|
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Operating Principles

The isolation mode allows you to reduce the number of visible IFC objects to
a single object or to several objects of a specific object class. This function
correlates to the visibility settings of the IFC Tree View (refer to Using IFC
Tree View step-by-step.

Isolating IFC objects step-by-step

I Make sure that an IFC file is loaded and activated in the Map View
manager.

1. From within the Layout Objects application, =

=
access View in the Map handler and tap Isolate. LOJ

2. The isolation screen is displayed.
The isolation screen allows you to define the objects that should be
visible in isolation mode.

F FJ—T
Choose the desired selection method (Object or Class L=

and select one or several objects for isolation mode.

)

Selected

Select objects for isolation objects are
highlighted in
blue, all objects
to be hidden
are displayed in
their original
colour.

4. Tap the Accept button to activate the isolation mode and return to
the map view.

isolation mode.
Only the selec-
ted objects are
visible.

5. = The map view

To indicate that isolation mode is active, the Isolate
icon is displayed in the top left corner of the map
view. The icon disappears when all objects are vis-
ible in the map view.

= Tap the icon to quickly access the isola-
tion screen.
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Hiding IFC objects in
the map view

44

i When isolation mode is active, the Isolate option is highlighted in
yellow when accessing View in the Map handler.

5= You can use the Limit Box function to further reduce the amount of
visible data. Refer to Limit Box.

Toolbar in the isolation screen

Toolbar but- Description
ton

Selection method: Object
@ Activate this button to select specific objects for isolation
mode. Only the selected objects will be visible.
= This button is activated by default.

Selection method: Class

Activate this button to select all objects belonging to a spe-
cific object class at once. It is sufficient to select just one
object. All other objects belonging to the same class will also
be visible in the isolation mode.

Tap this button to deselect all selected objects or to turn off

the isolation mode and make all objects visible again.

Tap this button to discard all changes and return to the map
view. If applicable, the previously made isolation settings are
being kept.

Tap this button to activate the isolation mode and return to
the map view.

The Isolate function for IFC objects is only available in the Layout
Objects and the Verification applications.

The isolation mode allows you also to reduce the number of visible IFC objects
by hiding single objects or several objects of a specific object class. This func-
tion correlates to the visibility settings of the IFC Tree View (refer to Using
IFC Tree View step-by-step.

Hiding IFC objects step-by-step

= Make sure that an IFC file is loaded and activated in the Map View
manager.

1. From within the Layout Objects application,
access View in the Map handler and tap Isolate. m

2. The isolation screen is displayed.
The isolation screen allows you to define the objects that should be
hidden in isolation mode.

3. Choose the desired selection method (Object or Class) and select one
or several objects to be hidden.
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Selected

Select objects for hiding obje cts to be
hidden are
highlighted in
green, remain-
ing objects are
displayed in
their original
colour.

4. Tap the Accept button to activate the isolation mode and return to
the map view.

=3
CICESESEY

To indicate that isolation mode is active, the Isolate
icon is displayed in the top left corner of the map
view. The icon disappears when all objects are vis-
ible in the map view.

= Tap the icon to quickly access the isola-
tion screen.

= When isolation mode is active, the Isolate option is highlighted in
yellow when accessing View in the Map handler.

I You can use a combination of the isolating and hiding functions.
Select objects for isolation first, then select objects to be hidden.

== You can use the Limit Box function to further reduce the amount of
visible data. Refer to Limit Box.

Toolbar in the isolation screen

Toolbar but- Description
ton

Selection method: Object
Activate this button to select specific objects for isolation
mode. The selected objects will be hidden.

= This button is activated by default.
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Toolbar but- Description
ton

Selection method: Class

Activate this button to select all objects belonging to a spe-
cific object class at once. It is sufficient to select just one
object. All other objects belonging to the same class will also
be hidden in the isolation mode.

. Tap this button to deselect all selected objects or to turn off

the isolation mode and make all objects visible again.

Tap this button to discard all changes and return to the map
m view. If applicable, the previously made isolation settings are
being kept.
Tap this button to activate the isolation mode and return to
the map view.
Isolating DXF ele- = Available for iCON build and iCON site Plus.
ments in the map ) ) ) ) o
view The Isolate function for DXF elements is available in all applications
except the Layout Objects application.
The isolation mode allows you to reduce the number of visible DXF elements
based on the DXF layers. This function correlates to the settings of the Map
view manager (refer to 2.4 Displaying Data).
Isolating DXF elements step-by-step
== Make sure that a DXF file is loaded and activated in the Map View
manager.
1. From within any application (except Layout
Objects), access View in the Map handler and tap m
Isolate.
2. The isolation screen is displayed.
The isolation screen allows you to define the DXF layers that should
be visible in isolation mode.
|
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Operating Principles

Select a line, point or arc of a specific DXF layer
that should be visible in isolation mode.

Select line, arc, surface or point for
isolation

As soon as an element is selected, a preview of
the isolation mode is given: selected elements are
highlighted in blue, elements of the same layer are
highlighted in orange. All elements to be hidden
are displayed in their original colour.

Tap the Accept button to activate the isolation mode and return to
the map view.

The map view is displayed in isolation mode. Only
the selected elements/layers are visible.

= R
%][ 0.000
v Select an element to stakeout
2

19 20

6@ A 5
m

To indicate that isolation mode is active, the Isolate
icon is displayed in the top left corner of the map
view. The icon disappears when all elements are
visible in the map view.
= Tap the icon to quickly access the isola-
tion screen.

When isolation mode is active, the Isolate option is highlighted in
yellow when accessing View in the Map handler.

You can use the Limit Box function to further reduce the amount of
visible data. Refer to Limit Box.
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Hiding DXF elements
in the map view
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Toolbar in the isolation screen

Toolbar but- Description
ton

= This button is deactivated by default when work-
@ ing with DXF files.

Selection method: Layer
When selecting a DXF element, all objects belonging to the
same layer are also selected for isolation mode.

= This button is activated by default.

Tap this button to deselect all selected elements or to turn
off the isolation mode and make all objects visible again.

Tap this button to discard all changes and return to the map
m view. If applicable, the previously made isolation settings are

being kept.

Tap this button to activate the isolation mode and return to
the map view.

= Available for iCON build and iCON site Plus.

= The Isolate function for DXF elements is available in all applications
except the Layout Objects application.

The isolation mode allows you to reduce the number of visible DXF elements
based on the DXF layers. This function correlates to the settings of the Map
view manager (refer to 2.4 Displaying Data).

Hiding DXF elements step-by-step
= Make sure that a DXF file is loaded and activated in the Map View

manager.
1. From within any application (except Layout
Objects), access View in the Map handler and tap @
Isolate.
2. The isolation screen is displayed.

The isolation screen allows you to define the DXF layers that should
be hidden in isolation mode.
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Select a line, point or arc of a specific DXF layer
that should be hidden in isolation mode.

Select line, arc, surface or point for
hiding

As soon as an element is selected, a preview of
the isolation mode is given: selected elements are
highlighted in blue, elements of the same layer are
highlighted in green. All remaining elements are
displayed in their original colour.

Tap the Accept button to activate the isolation mode and return to
the map view.

The map view is displayed in isolation mode. The
layers of the selected elements are hidden.

b

To indicate that isolation mode is active, the Isolate
icon is displayed in the top left corner of the map
view. The icon disappears when all elements are
visible in the map view.
= Tap the icon to quickly access the isola-
tion screen.

When isolation mode is active, the Isolate option is highlighted in
yellow when accessing View in the Map handler.

You can use the Limit Box function to further reduce the amount of
visible data. Refer to Limit Box.

49



Toolbar in the isolation screen

Toolbar but- Description
ton

= This button is deactivated by default when work-

% ing with DXF files.

Selection method: Layer
When selecting a DXF element, all objects belonging to the
same layer are also selected for isolation mode.

= This button is activated by default.

Tap this button to deselect all selected elements or to turn
off the isolation mode and make all objects visible again.
Tap this button to discard all changes and return to the map
@ view. If applicable, the previously made isolation settings are
being kept.
Tap this button to activate the isolation mode and return to
the map view.
Limit Box = Available for iCON build and iCON site Plus.

This function allows you to reduce the amount of visible data in the map view
by defining the dimensions of a so-called limit box.

Data filtered by the limit box can be:

« Point Cloud and Design data

e User-created data, such as points, lines and arcs that have been meas-
ured or created in apps such as Draw or Divide and Offset.
See also: How to Sketch a Plan

Adjust elevation range or enter limit
values

== The Limit Box function has replaced and now also
serves as elevation filter.

== The Limit Box function is available in all applications. For some
applications an additional licence is required.
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1. From within the current application, access View in
the Map handler and tap Limit Box.
The Limit Box toolbar is displayed. A transparent

box is created around all active data in the map.

2. »  You can define the limit box by shifting all six faces of the box.
The active faces are highlighted in a darker colour.
- Top and bottom face: Tap and hold the blue circles (the
filled blue circle for the top face) and drag them up and
down. Alternatively, enter the values of the desired elevation

range.

-+

3.022

£IR

4
-1.688

- Left and right face: Tap and hold the red circles (the filled
red circle for the right-hand side face) and drag them left

and and right.

- Front and back face: Tap and hold the green circles (the
filled green circle for the back side face) and drag them back

and and forth.

To rotate the limit box around its vertical axis, tap

==l and enter

the desired rotation angle or tap and hold one of the dark blue
circles in one of the corners and drag the corner around.

The limit box

updated
according to
the changes.

To align the limit box tap one of the mid point circles to

enable the snap tool and select a line or two points. Tap to

align the limit box.

Operating Principles
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The limit box
preview is
updated
according to
the changes.

To reset the limit box to the fullest extent possible, tap .
To discard the changes and return to the map view, tap m
To save the current limit box configuration, tap .

To reset the limit box to the last saved configuration tap k&=

To accept and activate the changes of the limit box, tap .

Elements out-

defined limit
box disappear
from the map
view. While the
Limit Box is act-
ive, the Limit
Box icon is dis-
played in the
top left corner
of the map

= [ view.

= Tap the Limit Box icon to quickly access the Limit
Box function. The icon disappears when the limit
box is reset to the total extent. '

i When the Limit Box is active, the Limit Box option is highlighted in
yellow when accessing View in the Map handler.

Clipping Filter This function allows you to reduce the amount of visible point cloud data in

the map view.

== The Clipping Filter function is only available when the licence "Grid
& Scan” is active.

1. From within the current application, access View in
the Map handler and tap Clipping Filter.
The Clipping Filter toolbar is displayed.

2. Define the clipping area by tapping as many points as desired for the
area corners.
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The defined
clipping area is
highlighted in
orange.

Window Filter Mode

3. « To clip all point cloud data inside the defined area, activate the

button .

» To clip all point cloud data outside the defined area, activate the

button -

To cancel and return to the map view without clipping, tap m

To accept and apply the clipping for the defined area, tap .

Select data to verify or tap ref. button for AI/ da ta inSIde/

areference outside the
defined clipping
area are faded
out in the map
view. While a
clipping filter is
active, the Clip-
ping Filter icon
is displayed in
the top left
corner of the
map view.

4. To apply another clipping filter on top, open the Clipping Filter tool-
bar again and repeat the previous steps.

= To erase all applied clipping filters, open the Clipping Filter toolbar,

select and tap to accept.

== Tap the Clipping Filter icon to quickly access the
Clipping Filter function. The icon disappears when %

no clipping filters are applied.

== When the Clipping Filter is active, the Clipping Filter option is high-
lighted in yellow when accessing View in the Map handler.

1.4.7 Special Options for IFC Files

Using IFC Tree View = IFC Tree View is only available in the Layout Objects application.
step-by-step

The IFC Tree View allows you to display the tree structure of an imported

IFC file, to select/deselect objects within the tree structure and to hide/show

objects in the map view.
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Using the Map view manager, it is possible to predefine which IFC entities of
the IFC file should be visible in the IFC Tree View and the map. Refer to 2.4
Displaying Data.

Access and navigation within the tree view

ST

In 7" display mode or in onboard mode of an iCB/iCR with KDU, activ-
ate Multiview to display IFC Tree View and map side by side.

From within the Layout Objects application, o0
access View in the Map handler and tap IFC Tree [kt
View. —

The tree view of the IFC file is displayed.

Select objects, point, line or arc

3 IFCTest Project 1.0.ifc o= Cano

[ Project Number ‘
& Default O
[ ifcBuilding

& Levelo

P Curtain WallCurt...
or_Glazing:332592

[ ifeDoor

Doors_Assembly_Sgl:
1810x2110mm:318347

Doors_ExtDbl_Flush:
1810x2110mm:311758

KUK NI NN

Tap the "closed folder" icon to expand the tree view.
All subordinate object groups or objects are displayed.
Tap the "open folder" icon to collapse the tree view.
All subordinate object groups or objects are hidden.

== If no folder icon is displayed, the lowest possible level of

the tree view is reached.

S

When the IFC Tree View is active, the IFC Tree View option is high-
lighted in yellow when accessing View in the Map handler.

Select/deselect objects using the tree view

- Tap the name of an object to select or deselect it.

- Tap the name of an object group to select or deselect all of its subordin-
ate objects/object groups.

« Itis not possible to select hidden objects/object groups.

54
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Selected objects/object groups are highlighted in blue in the map view and in
yellow in the tree view. All superordinate objects/object groups of a selected
object are marked with an orange dot.

&2 De " . A
&7 mo Select additional objects, point, lineor
\

arc to layout

E'n. IFC Test Project 1.0.ifc

E’. Project Number

IfcBuildin
® g

Level 0
Fe

B Curtain Wall:Curt...
or_Glazing:332592

IfcDoor
%o

Doors_Assembly_Sgl:
1810x2110mm:318347

NININININININ(S

Doors_ExtDbl_Flush:
1810x2110mm:311758

Show/hide objects using the tree view

« To hide an object in the map view, uncheck its checkbox in the tree view.
The object is hidden in the map and cannot be selected anymore. For all
superordinate objects of the hidden object, the colour of the checkmark in
the tree view changes to orange.

e To hide all subordinate objects of an object group in the map view,
uncheck the checkbox of the object group in the tree view.

All subordinate objects of the object group are hidden in the map and
cannot be selected anymore.

«  To show a hidden object/object group, activate the checkbox in the tree
view.

2o

& mo Select additional objects, point, line or

arc to layout

E‘v. Default ‘\/
E‘ IfcBuilding ‘\/
E‘l. Level 0 ‘\/
B Curtain Wall:Curt...
or_Glazing:332592
B3  ifcboor
EW. IfcWallStandardCase |/

gg;%\;valltne'aull Wall: D
g;;::‘lzvallzbehult Wall:
g:;isz:a\;blall:ne'aull Wall: ﬁ

When one or more objects are hidden in the map view, the Isolate icon is
displayed in the top left corner of the map view. The icon disappears when all
objects are visible in the map view.

F, =1

=

= Tap the ic_on to_quickly chan_ge the isolation settings. Refer to Isolat-
ing IFC objects in the map view.

Operating Principles
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Customise the wire- If necessary, you can customise the wireframe of an IFC object to reduce the

frame of an IFC object number of displayed points on the wireframe. When selecting an IFC object

step-by-step after customising it, only the defined wireframe points are displayed on the
IFC object.

= If the option Detect Hangers has been enabled during import of the
IFC file, it is not possible to customise the IFC wireframes of this file.
To be able to customise the wireframes, ensure to disable the option
when importing an IFC file.
Refer also to the specific section on importing IFC files in the para-
graph Importing data to the project step-by-step.

= The customised wireframe of an IFC object can be saved as profile to
the active project. When importing other IFC files to the project, the
saved profile is automatically applied to all IFC objects of the same
type within the imported file.

1. Within the application Layout Objects, select the IFC objects to be
customised.

Select additional objects, point, line or
arc to layout

2. Select Point Creation from the toolbox.

The toolbar for point creation is displayed.

Tap this button to start Window Selection mode. This
mode allows you to select several points at once by
defining a selection area.

Activate this button to create centre points for the selec-
ted elements.

Activate this button to create mid-points for the selected
elements.

Activate this button to create endpoints for the selected
elements.

Before accepting, activate this button to copy the cus-
tomised wireframe definition onto other IFC objects of
the same type that are within the IFC file and active in
the map.

Before accepting, activate this button to save the cus-
tomised wireframe to the current active project.

Tap this button to deselect all selected elements and
reset the wireframe to the original.

Tap this button to accept the defined wireframe points
and save the customised wireframe.
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Select lines, arcs or circles and activate the corresponding toolbar
button to create midpoints, centre points or endpoints for the
selected elements. Follow the onscreen instructions.

For quick selection or deselection, use the Window Selection
mode.

The custom wire-
frame points are
highlighted in blue.

Tap to select endpoints of lines.

|-
s}

To copy the wireframe definition to other objects or to save the
wireframe definition as profile, ensure to activate the respective but-
tons before saving the customised wireframe.

To accept and save the customised wireframe, tap « .

Select additional objects, point, line or When the IFC ODJ eCt
S is selected again,
only the user-defined
wireframe points are
visible.

Displaying IFC attrib-
utes in the informa-
tion bar

Operating Principles

Attribute Info Config is only available in the Layout Objects applic-
ation.

The Attribute Info Config function allows you to assign up to ten IFC attrib-
utes of an object class to a value in the information bar. Thus, the IFC attrib-
utes of an object can be quickly looked up in the information bar when select-
ing the object.

Assigned IFC attributes will be copied to the point information when laying out
the IFC object. See also: Layout objects step-by-step

1. From within the Layout Objects application,
access View in the Map handler and tap Attribute A/
Info Config.
The Attribute Info Config screen is displayed.

2. Selecting an object class

« To select an object class, tap the field IFC Class.
« In the section Class Name, tap the name of an object class to
change its attribute settings.
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Attribute Info Configuration

Class None None
IfcDoor
IfcWallStandardCase

IfcWindow

% Z

i If one or several objects of the same class are selected when access-
ing the Attribute Info Config function, the field IFC Class already
displays the corresponding object class. The section Infopanel
Attributes is displayed.

3. Assigning Attributes to an information bar value

The section Infopanel Attributes displays the attribute settings of

the selected object class. By default, all ten attributes are set to

None.

« Tap any of the attributes within Infopanel Attributes to display
the section Attributes. The section contains a list of all available
attributes for the selected object class.

- Tap an attribute name to assign it to the respective information
bar value (A1-A10).

*  Repeat these steps for as many attributes as desired.

Attribute Info Configuration

Class IfcWindow b None
Infopanel Attributes ~  Pset_ManufacturerTypelnformation
"“’T\A ThermalTransmittance »

~  Pset_WindowCommon

Reference » \sExternal

None
Reference

None ) "
ThermalTransmittance

None »

& 4

I ¢ Tap [ to reset all attribute settings of the selected object class
to the default values (None).

Tap ® o discard all changes and return to the map view.

4. Tap « to accept the changes and return to the map view.
== To display the attributes of an object, select the object and
scroll through the pages of the information bar.

= To display the desired information bar values (A1-A10),
configure the information bar. Refer to Information bar.
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Example for displaying attributes in the information

bar:
5.561700
- €2 910x1210mm§
f A3 .T.
& i
C i

1.4.8 Foreman Settings
= Unavailable for iCON iCG30.
Viewing options for = In 7" display mode, settings for foreman view are available.

foreman

To use these advanced Foreman Settings, the Surface Pilot licence
is needed. Ask your agency or your Leica Geosystems representative
for information about licensing.

Access View in the Map handler and tap Foreman B
Settings.

Following screen is displayed:

Foreman Settings

Vertical Light Bar f Icon Type Pole »
— Height 2.000|
e
Generate Cut/Fill Grid Benchmark Height
Quick Snap m
Sloping Pole m

-

»  Set Vertical Light Bar to On: a vertical light bar shows the
height deviation in an optical form.

» Set Horizontal Light Bar to On as a guidance along a reference
line.

» Set Vertical Light Bar and Horizontal Light Bar to On to have
a combination of both displayed.

+ Set Generate Cut/Fill Grid to On to allow grid logging in Cut &
Fill. Refer to 12.2 Cut & Fill Grid Logging.

Tap v to accept the settings and return to the map.

Operating Principles
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Measure  Point ID

mE Qe

= Dynamic labels show the Cut & Fill value and the horizontal
offset to the reference line. The vertical light bar behaves
in accordance with the Cut & Fill colour scheme. When
your current position is in tolerance, the label turns green.

= The arrows indicate the direction of movement necessary
in order to reach a position that is within tolerance.

5 The light bars can be relocated. Tap and hold the lightbar
and drag it to desired position on the screen.

= The settings for these viewing options are used, independent from
the User, Project, Job or application used.
The information is shown according to the current settings, in the
chosen distance unit and the number of decimals set.

Pole mode 1. Access View in the Map handler and tap Foreman o
Settings. &
2. Tap the arrow button beside Icon Type.

Select Pole to enable pole mode and to display the pole icon. Pole is
the default setting.

Foreman Settings
Vertical Light Bar m f Icon Type Pole »
— Height 2.000|
|
Generate Cut/Fill Grid Benchmark Height m
Quick Snap
Sloping Pole m
5 4 ~
&S b
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«  Enter the target Height or define the benchmark height for the
target height calculation.

« If using the QuickSnap adapter with iCON iCG60 or iCON iCG70,
set Quick Snap to On.

« Set Sloping Pole to On to have the entered target height
used perpendicular to a reference surface instead of the vertical
height projection. For detailed information, refer to Sloping Pole
and Vehicle Configuration.

= The Height value entered is the "real" target height,

whether a pole is used or an antenna on a vehicle roof.

== The antenna/prism height can be also defined from a

known point. Tap Define to select the benchmark point or
height. It is important that the antenna/prism is positioned
on the benchmark point.

== To use the Sloping Pole feature a design or reference sur-

face must be selected. Therefore this feature is available in
some applications only.

Tap « to accept the settings and return to the map.

The settings for these viewing options are used, independent from
the User, Project, Job or application used.

The information is shown according to the current settings, in the
chosen distance unit and the number of decimals set.

Vehicle/Machine
mode

Operating Principles

To use the iCON software with a vehicle or machine, the Surface
Pilot licence is needed.
For information on milling machines, refer to Milling machine mode.

Access View in the Map handler and tap WL
Foreman Settings. @

Tap the arrow button beside Icon Type.
Select the desired vehicle or machine type to enable vehicle/machine
mode and to display the respective vehicle icon.

« Vehicle
« Dozer
e Scraper
« Tractor
Foreman Settings
Vertical Light Bar &7 Icon Type Vehicle »
— Height z.uoo‘
Generate Cut/Fill Grid Benchmark Height
Quick Snap m
Sloping Pole

Vehicle Configuration
7
> y
1y
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«  Enter the target Height or define the benchmark height for the
target height calculation.

« If using the QuickSnap adapter with iCON iCG60 or iCON iCG70,
set Quick Snap to On.

« Set Sloping Pole to On to have the entered target height
used perpendicular to a reference surface instead of the ver-
tical height projection. For detailed information, refer to Sloping
Pole and Vehicle Configuration.

= The Height value entered is the "real" target height,
whether a pole is used or an antenna on a vehicle roof.

= The antenna/prism height can be also defined from a
known point. Tap Define to select the benchmark point
or height. It is important that the antenna/prism is posi-
tioned on the benchmark point.

== To use the Sloping Pole feature a design or reference
surface must be selected. Therefore this feature is avail-
able in some applications only.

Vehicle Configuration

« Define the position of the Blade Ref. Point in relation to the
vehicle icon.

«  Enter values for Line Offset, Offset left edge and Offset
right edge.

For detailed information, refer to Sloping Pole and Vehicle Configura-

tion.

Tap v 1o accept the settings and return to the map.

Measure Store Point ID

6.760]

Milling machine mode =

To use the iCON software with a milling machine, the Milling Pilot
licence is needed.

Access View in the Map handler and tap Foreman B
Settings.
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Tap the arrow button beside Icon Type.
Select the vehicle type Milling Machine to display the milling
machine icon.
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Foreman Settings

View Options Position Icon Settings

Horizontal Light Bar m <% Icon Type Milling Machine p

Maximum Cutting Depth

Cutting Depth ‘

Vehicle Configuration

Drum Ref. Point Middle »
Line Offset 0.000

Offset left edge 1.500 ‘

o

3. Enter the maximum cutting depth value of the milling machine.
Different milling machines have different maximum cutting depths.
During milling, the software checks the height deviation between
existing and design surface. If the height deviation is greater than the
defined cutting depth, a warning is displayed in milling view. Areas
where the cutting depth limit of the machine is exceeded need to be
milled again.

= The maximum cutting depth value is empty by default. If no
value is entered, there are no checks for cutting depth.

= If the drum width is shorter than the machine width, mount the GPS/
GNSS antenna within the drum width.

18396001

a Drum position
b GPS/GNSS antenna position

4. Vehicle Configuration
« Define the position of the Drum Ref. Point in relation to the
vehicle icon.

»  Enter values for Line Offset (value needs to be negative when
the prism/GNSS position is behind the drum), Offset left edge
and Offset right edge.

For detailed information, refer to Sloping Pole and Vehicle Configura-

tion.

Tap v to accept the settings and return to the map.
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Sloping Pole and
Vehicle Configuration

64

Sloping Pole explanation:

a Sloped design or ref-
erence surface

b Vertical projection of
target height

¢  Perpendicular projec-
tion of target height
= Sloping Pole set to
On

d Sloped surface, at
antenna position

e Theoretical horizontal

012245.001

Vehicle Configuration
The Vehicle Configuration settings influence how the vehicle icon is displayed
in map view.

Blade Ref. Point/Drum Ref. Point
By default, the "Blade Ref. Point" or zero point of the vehicle icon is located
in the middle of the vehicle and on ground level, where the tires touch the

ground.
«  For the dozer icon, the default zero point is located at the middle of the
blade.

«  For the scraper or tractor icon, the default zero point is located at the
middle of the trailer.

«  For the milling machine icon, the default zero point is located at the
middle of the milling drum.

Edit the Blade Ref. Point setting to define the position of the zero point in

relation to the vehicle icon.

(=S When the antenna/prism is mounted on a mast, select the option
Mast. The zero point is the actual position.
When the antenna/prism is mounted on the roof of the vehicle,
select Middle, Left or Right. The zero point is calculated based on
the current position and the entered offset values.

a b C d
& % &) 3 & " a Left
c Middle
ez o i d Mast

Offset values

To define the width of the displayed vehicle icon, enter the offset values
for left edge (d) and right edge (e). Offsets are measured from the actual
position of the antenna/prism on the vehicle (b) to the edges of the vehicle.
The vehicle width determines the lane width of the Cut/Fill Grid.

To define the Line Offset(c), measure the distance between the actual posi-
tion of the antenna/prism on the vehicle (b) and the desired position of the
zero point (a).

When the zero point is behind the antenna/prism, enter a positive value for
Line Offset; when the zero point is in front of the antenna/prism, enter a
negative value.
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a Default zero point

b  Example: Actual position of
the antenna/prism on the
vehicle

Line Offset

Offset left edge

e Offset right edge

a N

16622001

Examples

ead Xb

16624001

a Default zero point
b Example: Actual position of the antenna/prism on the vehicle
c Line Offset

1 2 3 4
Default zero Left Middle Middle Mast2)
point
Line Offset 0 Negative Negative 0
value value
Offset left edge / Equal Equal Not equal Equal
Offset right edge
1.5 Setting up Communications and Connecting Instruments
1.5.1 Create an Instrument Profile

Create an instrument In order to connect the controller to an instrument, an instrument profile must
profile step-by-step be created.

1. Select Devices from the Home Menu. g T
2. Tap @ to create a new profile.

2) 7ero point = actual position
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The "New Profile"
screen is displayed.

New Profile

Model: iCON gps 60 b
Profile Name: ‘iCG
&

Select the desired Model:.
If applicable, enter a Profile Name:.

Tap ‘/.

To set up a GPS profile for the iCON iCG30/iCON iCG70, proceed
to 1.5.2 Setting up a GPS Profile for iCON iCG30/iCON iCG70.

To set up a GPS profile for the iCON iCG60 and other antenna
models, proceed to 1.5.5 GPS Profile Setup for iCON iCG60 and
Other Antenna Models .

For a Total Station profile proceed to 1.5.7 Total Station Profile

Setup .
1.5.2 Setting up a GPS Profile for iCON iCG30/iCON iCG70 [{€H
= Some settings are only accessible when using an iCON iCG70.

Connection and basic

configuration

66

To define the Communication method between instrument and con-
troller tap Mode, within the Communication Mode container.

=

Ensure that the iCON iCG70 antenna is set up accordingly
and ready for connection.

«  For Cable connection, ensure that the cable is connected. Once
the instrument is connected, it changes from white to yellow in
the search list.

«  For Bluetooth, press the Start Search key. Select the relevant
instrument profile from Search Results.

Mode

Communication Mode
Cable »
________

iCON gps 70

Communication Settings

Tap the next Wizard step m to proceed.
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Option "Go to Work"

Operating Principles

The current configuration of the antenna is dis-

played.
g g
- N

GPS Mode Radio Base U v
Radio Channel 30 I I
XY, Z

Radio Frequency 430.000000 MHz Go to Work Base Setup Methods
Correction Format RTCM3
ID 0
\ 1 \
E/Lat 47°24'33.99355"N I I
N/Long 09°37'11.76623"E Load C: { New Cor {
X

Choose one of the three options:

« Go to Work
Allows you to use the current configuration of the antenna and
to start working directly.
Refer to Option "Go to Work".

+ Load Configuration
Allows you to load an antenna profile either from the internal
memory, from a connected storage device or from Leica ConX.
Refer to Option "Load Configuration".

+ New Configuration
Allows you to create an antenna profile.
Refer to Option "New Configuration".

+ Base Setup Methods is available.
Available, if the antenna is set up as base. Allows you to change
the base point for the existing profile.
Refer to Defining a base point.

If the antenna is set up as Base, the following wiz-
ard step is displayed additionally:

@ /& ) & Antenna Settings
/

Pole Height 2.000

Measurement Method Vertical »

Enter the pole height of the antenna.
Tap the next Wizard step D to proceed.

If the antenna is set up as Rover, the following wizard step is dis-
played directly.
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4 / & Status Page

Profile Name 70-Rover-Radio-Ch2

GPS Mode Radio Rover
Corrections, last minute 100 %
Position Quality Fixed
Detected reference antenna CGAB0

Detected reference sensor iCG60

If desired, edit the name of the profile.

2 ) Tap ¥ to save the profile.

Upon saving the profile, the "Profiles” screen is displayed.

Tap 4 to cancel.

¥ To edit the profile settings, tap the arrow button ) tothe right of
the profile name.

3. Tap the profile name to start working.
A progress bar is displayed during initialisation. Once the device is
ready, the main screen is displayed.

Option "Load Config- === When selecting the option Load Configuration,
uration” the following wizard step is displayed:

Internal Memory »

GNSSProfiles

iCG70-Base-Radio-Ch15.xml >

iCG70-Base-Radio-Ch24.xml »

iCG70-Rover-...VO5LHN9S xml  »

iCG70-Rover-... AX-RTCM3.xml  »

i A profile can be loaded either from the internal memory, from a con-
nected storage device or from Leica ConX. Ensure that the profile is
stored within the folder GNSS Profiles, otherwise it is not available
for import.

To define the source of the profile, tap Source.

2. Select a profile from the list "GNSS Profiles".
The configuration of the profile is displayed.

Tap the next Wizard step m to proceed.

Tap 2 4 to cancel.
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4. If desired, edit the name of the profile.

Status Page

Profile Name 70-Rover-Radio-Ch2

GPS Mode Radio Rover
Corrections, last minute 16 %
Position Quality Fixed

Detected reference antenna CGAB0

Detected reference sensor iCG60

Tap ¥ toload the profile.

Tap 2 4 to cancel.

= Once the profile is loaded, the "Profiles” screen is displayed.

To edit the profile settings, tap the arrow button ) tothe right of
the profile name.

5. Tap the profile name to start working.
A progress bar is displayed during initialisation. Once the device is
ready, the main screen is displayed.

Option "New Config- == When selecting the option New Configuration, the
uration” following wizard step is displayed:

Basic Settings

/
Sensor Mode Rover » Rover
Use Internal Radio » Base

1. Basic Settings
To define the setup type, choose base or rover for Sensor Mode.

Operating Principles 69



70

2. For Use, define the communication method.

Basic Settings

) y
/& / y
/ L

Sensor Mode Rover » Internal Radio

Use Internal Radio » Network

Smartlink

None

= SmartLink can only be used with an iCON iCG70 and the appropriate
license.
SmartLink is a service that increases the position accuracy without
the need of having a base. The convergence time after activating
SmartLink can be up to 30 minutes.
For Radio Rover and Network Rover profiles, SmartLink is enabled by
default. To disable SmartLink, edit the profile. Refer to 1.5.3 Editing
a GPS Profile (Editing the profile configuration).

i If you set up the antenna as Network Rover, you
also need to define a connection method.

Basic Settings

Sensor Mode Rover » Server & Port
Use Network » NTRIP
Connect Via NTRIP »

3. Tap the next Wizard step 3 to proceed.
== Depending on the defined setup type, number and content
of the following wizard steps vary. Refer to the respective
paragraph in step 4.:

4, Radio Rover using internal radio
« Define the settings for the internal radio. Tap the next Wizard
step to proceed.
« Define the antenna settings. Tap the next Wizard step to
proceed.
« If desired, edit the name of the profile. Tap ¢ to save the pro-
file.
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Network Rover using NTRIP connection

» Define the settings for NTRIP connection. Tap the next Wizard
step ) to proceed.

»  Define the Mountpoint settings. Mountpoints are downloaded
automatically. Tap the next Wizard step )} to proceed.

« Define the antenna settings. Tap the next Wizard step )} to
proceed.

« If desired, edit the name of the profile. Tap ¢ to save the pro-
file.

Network Rover using Server connection

» Define the settings for server connection. Tap the next Wizard
step ) to proceed.

« Define the antenna settings. Tap the next Wizard step )} to
proceed.

e If desired, edit the name of the profile. Tap ¢ to save the pro-
file.

Rover using SmartLink

« Define the antenna settings. Select the reference frame of the
coordinate system in use.
A SmartLink solution is independent from a reference station or
network. Therefore the link to the reference frame of the used
coordinate system is not given anymore. The coordinates need
to be transformed into the reference frame of the coordinate
system.

= The usage of an incorrect reference frame can create a

position error bigger than the accuracy of a SmartLink
solution (> 6 cm).
- Tap the next Wizard step Jf3 to proceed.
e If desired, edit the name of the profile. Tap ¢ to save the pro-
file.

Base Setup

»  Define the settings for the internal radio. Tap the next Wizard
step ) to proceed.

« Define the antenna settings. Tap the next Wizard step JE to
proceed.

« Define a base point. Refer to Defining a base point.
Tap the next Wizard step 3 to proceed.

« If desired, edit the name of the profile. Tap ¢ to save the pro-
file.

Options in the Antenna Settings screen :

«  Enter the pole height.

«  Activate or deactivate Tilt option.

e If Tilt is deactivated, define the measurement method.

Upon saving the profile, the "Profiles”" screen is displayed.

To edit the profile settings, tap the arrow button ) tothe right of
the profile name.

Tap the profile name to start working.
A progress bar is displayed during initialisation. Once the device is
ready, the main screen is displayed.

Operating Principles
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Defining a base point When setting up the antenna as base, you need to define a base point. The
base point should be within a distance of maximum 20 m.

During profile setup, the following wizard step is displayed:

@ > @ > @ > ’ < GNSS Base Setup Methods

Select point from the map Measure Anywhere »
Select point list or Enter coordinates » Smart Get Here »
Coordinate System Not available

There are five options for defining a base point. Refer to the corresponding
section:

Select a base point from the map

Select a base point from the list

Enter a base point

Measure a base point: Measure Anywhere
Measure a base point: Smart Get Here

Select a base point from the map

i If no coordinate system is loaded to the project, it is not possible to

select a base point from the map.

1.

Tap Select point from the map.

ceﬂ> ceﬂ> ’§4> @) ——

3 >
o

R

Tap a point to select it.

The coordinate fields are updated with the coordinates of the selec-
ted point.

You can also edit the coordinate fields.

Tap the next wizard step ¥ to proceed with the profile setup.

i The status page is displayed. The defined base point is stored in the

point list, with the code "Base Point" assigned to it.

Tap ¢ to save the profile.

Select a base point from the list
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If no coordinate system is loaded to the project, it is not possible

to select a base point from the list. You can only enter WGS coordin-
ates. If a coordinate system is loaded, you can also enter the local
coordinates.

Tap Select point list or Enter coordinates.

The available points are listed according to their
distance to the current position, with the nearest
point listed first.

/§9> @> @> @> A < Select Base Point from the List
Point List

®2 Base ID

_ Fesine e

Northing 1253245.356

& =
N
(=
o
N
o

Height

Tap a point to select it.
The coordinate fields are updated with the coordinates of the selec-
ted point.

Tap the next wizard step ¥ to proceed with the profile setup.

The status page is displayed. The defined base point is stored in the
point list, with the code "Base Point" assigned to it.

Tap ¢ to save the profile.

Enter a base point

S

If no coordinate system is loaded to the project, you can only enter
WGS coordinates. If a coordinate system is loaded, you can also
enter the local coordinates.

Tap Select point list or Enter coordinates.

By default, the coordinates are set to zero.

Select Base Point from the List

/ J
Point List Point List

@2 Base ID ﬁ
Northing [0000—]
Height [0.000—]

Enter the desired coordinate values.

Tap the next wizard step 3 to proceed with the profile setup.
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= The status page is displayed. The defined base point is stored in the
point list, with the code "Base Point" assigned to it.

Tap ¥ 1o save the profile.

Measure a base point: Measure Anywhere

1. Tap Measure Anywhere.
/§9> ~ > @> ’@> & > ”§9> 7 ‘,/ & Measure Base Point
r/ )
Measure Anywhere Start Base ID 0
Easting 2764615.201
Measurements count Northing 1253244.903
CQ Position 3D 4.430 Height 417.394

2. To start measuring, tap Start.
The number of measurements is displayed. The field "CQ Position 3D"
displays the current quality of the measurements.

3. If the quality of the measurement is sufficient, tap Stop to store the
measured base point.

4. Tap the next wizard step ) to proceed with the profile setup.

= The status page is displayed. The defined base point is stored in the
point list, with the code "Base Point" assigned to it.

Tap ¢ 1o save the profile.

Measure a base point: Smart Get Here

5= This function determines the current coordinates of the instrument
with high accuracy and uses the thus calculated position as the base
point.

Tap Smart Get Here.

2. Set up a new rover profile.

& > & > & > g > & K Correction Source Setup

v

Load Configuration New Configuration
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== You can also load an existing rover profile.

'@9> '@a'>' @9} @,9} @a'> @> &

Load Configuration

Internal Memory » GPS Mode NTRIP Rover

Mountpoint iIMAX-RTCM3

GNSSProfiles Network Type i-MAX

™ o

iCG70-Base-Radio-Ch-17.xml »

iCG70-Rover-...AX-RTCM3.xml »

iCG70-Rover-Radio-Ch2.xml »

1

3. For a radio rover profile, define the internal radio
settings. For a network rover profile, define the
network and mountpoint settings.

Basic Settings ) @ () ()

/- o o
t

/- /
Sensor Mode Rover » Internal Radio

Use Internal Radio » Network
Smartlink
None

4. Tap the next wizard step JE3.
To start measuring, tap Start.

@>@>@?>@>@>@9>@?>@9>@

Measure Base Point Base Setup Point

Latitude 00°0000.000

Measurement count Longitude 00°00'00.000
CQ Position 3D 0.011 Height 0.000

5. If the quality of the measurement is sufficient, tap Stop to store the
measured base point.

6. Tap the next wizard step ) to proceed with the profile setup.

= The status page is displayed. The defined base point is stored in the
point list, with the code "Base Point" assigned to it.

Tap ¥ 1o save the profile.
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1.5.3 Editing a GPS Profile [3

Editing the profile 1. Select Devices from the Home Menu. g
settings The "Profiles" screen is displayed.

To edit the profile settings, tap the arrow button ) tothe right of
the profile name.

The "Configuration" screen is displayed.

Configuration

Current Configuration

Communication »

GPS Mode Radio Rover

Edit Configuration »
Radio Channel 2

System Information »
Radio Frequency 433.575000 MHz

System Utilities »
Tilt On

Reset Options »

Rinex Logging »

3. « To edit the communication settings, tap Communication.

Refer to Editing the communication settings.

« To edit the profile configuration, tap Edit Configuration.
Refer to Editing the profile configuration.

« To display detailed information on sensor, measurement engine,
internal radio or on licences, tap System Information.
Refer to Displaying the system information.

« To upload a firmware update or a licence key, tap System Utilit-
ies.
Refer to Uploading firmware updates or licence keys.

« To reset the antenna, tap Reset Options.
Refer to Resetting the antenna.

« To record RINEX data, tap Rinex Logging.
Refer to Recording RINEX data.

Ef]itif_‘g the commu- In the "Configuration” screen, tap Communication.
nication settings The "Communication Settings" screen is displayed.
1. To define the Communication method between instrument and con-
troller tap Mode, within the Communication Mode container.
2. «  For Cable connection, ensure the cable is connected. Once the
instrument is connected, it changes from white to yellow in the
search list.

«  For Bluetooth, press the Start Search key. Select the relevant
instrument from Search Results.

3. Tap ¥ 1o save changes.
Editing the profile 1. In the "Configuration" screen, tap Edit Configuration.
configuration The wizard for profile configuration is displayed.
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= Some functionalities in the advanced settings are licenced. Ask your

agency or your Leica Geosystems representative for information
about licensing.

Depending on the already defined profile setup, number and con-
tent of the available wizard steps vary. Refer to the respective para-
graphs.

Wizard step "Radio Settings

Radio Settings

Internal radio settings

Model Satel M3-TR4
Channel 2
Frequency 433.57500 MHz
Bandwidth 25.0 KHz »
Radio Protocol Satelline 3AS »

FEC (Forward Error Correction)

~  Advanced Settings

Define the settings for the internal radio. Tap the
next Wizard step )D to proceed.

Wizard step "NTRIP Settings"

NTRIP Settings

Address
Port Number _
Username m
Password m

Define the settings for NTRIP connection. To check
if the connection works, tap m
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Wizard step "Server & Port Settings"

Server & Port Settings

Address 217.193.169.26

Port Number 7276

Network Type MAX »

~  Advanced Settings

Correction Format Leica 4G »
GGA Output m
Reference Sensor Auto-detect »

Define the settings for server connection. Tap the
next Wizard step m to proceed.

Wizard step "Mountpoint Settings" (only for
NTRIP)

Mountpoint Settings

Mountpoint VRS_GISGEO_LV95LHN95 »

Network Type VRS »

GGA Output m
~  Advanced Settings

Correction Format Auto-detect »

Reference Sensor Auto-detect »

Reference Antenna Auto-detect »

Mountpoints are downloaded automatically.

Tap the next Wizard step D to proceed.

Wizard step "Antenna, Satellites"

@ @ S Antenna Settings
Pole Height 2.000

Measurement Method Vertical

~  Advanced Settings
XRTK

[ on |
Smartlink Fill [ on |

Cutoff angle 10 °
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Tilt: Switch on or off as necessary.

Measurement Method:

- Vertical: The vertical height reading is the height difference
between the bottom end and the top end of the pole.

- Height Hook: If setting up using a tripod, the measurement
required is the vertical height from the height hook to the
ground.

XRTK:

xRTK is a slightly less accurate RTK position type, typically 5 to

10 cm, automatically providing more availability for phase fixed

positions with a reliability of 99%. Recommended when working

in heavy canopy environments.

Cut-off angle:

below this defined angle satellites will not be taken into account

for calculations.

Glonass, Galileo, Beidou:

Switch the satellite channels on or off.

SmartLink Fill/SmartLink:

SmartLink Fill is a correction service delivered via Satellite to

bridge RTK corrections outages for long periods of time, for

example 10 minutes. Use SmartLink Fill to work for longer
without the consistent usage of the RTK infrastructure.

When SmartLink service is available, the option SmartLink is dis-

played instead of SmartLink Fill.

Tap the next Wizard step m to proceed.

Wizard step "Status Page"

Overview of the current profile configuration is dis-
played.

Status Page

Profile Name [70-Rover-Radio-Ch2

GPS Mode Radio Rover

Corrections, last minute 21 %
Position Quality Fixed
Detected reference antenna CGA60

Detected reference sensor iCG60

If desired, edit the name of the profile. Tap v 1o
save changes.

Displaying the system
information

Operating Principles

In the "Configuration" screen, tap System Information.
The "System Information” screen is displayed.

To display detailed information, tap an item in the list:
«  Sensor Info

*  Measurement Engine

» Internal Radio

- Licences
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Tap ¥ 1o return to the "Configuration" screen.

Uploading firmware In the "Configuration" screen, tap System Utilities.
updates or licence The "System Utilities" screen is displayed.
keys 1. To choose an upload option, tap an item in the list:

« Upload Firmware
» Upload Licence key

2. Upload Firmware

The version number of the currently installed firmware is displayed.

- To upload a firmware update, insert an SD card with the firmware
file into the antenna. Ensure that the firmware file is within the
system folder.

For antennas without SD card slot:

Depending on the antenna type, the upload must be done
using the USB stick or the firmware file must be on the
controller in the folder C:\Users\Public\Documents\Leica Geosys-
tems\GS_Server_LMC\SD Card\System.

- As soon as an firmware file is available, it is displayed below the
section Available Version.

- To select a file for upload, tap the file name.

- Tap Start Update.

== If the maintenance date is not valid, an error message is
displayed.

Upload Licence key

- To upload a licence key, copy the licence file into the folder
"GNSSProfiles” on the controller.
Once the licence file is copied, the new licence key is available for
upload.

- To access the licence key, synchronise the controller with the
antenna, then edit the antenna profile settings.
Select System Utilities > Upload Licence key in the "Configur-
ation" screen.

- Select the new licence key file.

- Tap Start Upload.

= Restart or reconnect the antenna to ensure that all licence
changes are displayed correctly in the software.

Tap ¥ 1o save changes and to return to the "Configuration" screen.

Resetting the In the "Configuration" screen, tap Reset Options.
antenna The "Reset Options" screen is displayed.

1. To choose a reset option, tap an item in the list:
«  Reset an almanac
« Reset an antenna
« Reset an antenna list

2. Reset an almanac
To reset the almanac on the antenna, tap Start.
The current almanac is deleted and a new almanac is downloaded.

= Downloading a new almanac can take up to 15 minutes.
While resetting the almanac, the fixed position is lost.
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Reset an antenna
To reset the antenna to factory settings, tap Start.
= After reset, the antenna needs to be reconnected to the
controller.

Reset an antenna list
To reset the antenna list, tap Start.
The currently stored antenna list is reset to factory settings.
= Make sure that no list.ant file is in the System folder of the
SD card before starting the reset.

Tap ¥ 1o return to the "Configuration" screen.

Recording RINEX data = To record RINEX data you need to have a RINEX licence.

== Ensure that an SD card is inserted into the antenna.
For more information on the setup for data recording, refer to the
user manual of the antenna.

In the "Configuration" screen, tap Rinex Logging.
The "Rinex Logging" screen is displayed.

1. Tap Start/Stop.

To start recording data, tap Start.

To stop recording data, tap Stop.

Select the output type for storing the recorded data.

4 Tap ¥ 1o return to the "Configuration" screen.
1.5.4 Uploading the Antenna List [3
Upload the antenna 1. Put the LIST.ANT file in the system folder of the SD card delivered
list with the antenna.

For antennas without SD card slot:

Depending on the antenna type, the upload must be done
using the USB stick or the firmware file must be on the
controller in the folder C:\Users\Public\Documents\Leica Geosys-
tems\GS_Server_LMC\SD Card\System.

2. Insert the SD card into the respective slot within in the battery
compartment of the antenna.

3. Reboot the antenna.
During reboot the antenna list file is automatically imported.

I You can reset the antenna list using the iCON field software. Refer
to Resetting the antenna (1.5.3 Editing a GPS Profile ).

Operating Principles 81



1.5.5

GPS Profile Setup for iCON iCG60 and Other Antenna Models [€3

Define communica- 1.

tion method step-by-
step

To define the Communication method
between instrument and controller tap

Communication, within the Communica- :

tion Settings container.

Communication »

Sensor profile setup

Start profile wizard >

No GPS sensor connected

S Ensure the GPS instrument is set accordingly.
2. «  For Cable connection, ensure the cable is connected. The con-
nected instrument is displayed in Search Results.
«  For Bluetooth, press the Start Search key. Select the relevant
instrument profile from Search Results.
ﬁ Select communication channel Communication
& Cavle
Mode Bluetooth »
® i Search Devices
No sensor selected. Perform search.
= Once the instrument is connected, it changes from white to blue in

the search list. Tap v

Sensor profile setup

two Profile Setup modes:

Profile Wizard: Set up most of the com-
mon configurations for Base, Local Rover
and Network Rover. Includes optional access
to additional settings.

It is also possible to complete a Profile Wiz-
ard before connecting to the instrument.
Profile from Sensor: Automatically creates
a new profile with the settings that are cur-
rently set on the instrument. Work with the
instrument can begin immediately.

Profile Wizard

The Profile Wizard consists of three steps:
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To create a GPS Profile, additional settings must be defined. Select from these

Communication Settings

Communication »

Sensor profile setup

Start profile wizard »

No GPS sensor connected
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Basic Settings: Set Sensor Mode, and RTK Device Use.

Radio / Modem: Define Radio / Modem settings, and Correction
Format.

Antenna, Satellites: Define Antenna and Satellite settings.

=< To receive RTK corrections via tablet select Controller as the RTK

Device Use in the Basic Settings screen.

= For Satel radios frequency and bandwidth can be changed.

= The software supports GPS L2C, GPS L5, Glonass, Galileo, and
Beidou.

Radio / Modem ) ® SRS Antenna, Satellites
/

]
Sensor Mode Local Rover » Modem iCG60 Modem Antenna iCG60 »
Use Internal Radio » PIN Code Antenna Height 2.000
Corrected Height 2,000
APN X
Quick Snap Off
Auto-Connect \
Measurement Method Vertical »

Satellite Settings

~ Advanced Settings
~ Advanced Settings

Expand Advanced Settings to make additional selections where relevant.

Tap ' when step 3 is completed.

For a Network Rover with NTRIP connection some important Advanced
Settings can be carried out in Antenna, Satellites: Switch the satellite chan-
nels on or off, define a cut-off angle, and switch xRTK and SmartLink.

Following satellite channels are available: GPS L2C, GPS L5, Glonass,
Galileo, and Beidou.

Cut-off angle: below this defined angle satellites will not be taken into
account for calculations.

XRTK: xRTK is a slightly less accurate RTK position type, typically 5 to

10 cm, automatically providing more availability for phase fixed positions
with a reliability of 99%. Recommended when working in heavy canopy
environments.

SmartLink: SmartLink is a correction service delivered via Satellite to
bridge RTK corrections outages for long periods of time, for example 10
minutes. Use SmartLink to work for longer without the consistent usage
of the RTK infrastructure.

The SmartLink functionality is licenced. Ask your agency or your Leica
Geosystems representative for information about licensing.

The following table describes the two different antenna height measuring

methods:
Method Description
Vertical The vertical height reading is the height difference
between the bottom end and the top end of the pole.
Height Hook If setting up using a tripod, the measurement required is

the vertical height from the height hook to the ground.
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== If setting up a Network Rover with NTRIP connection to a ref-
erence network, a further three Wizard steps will be shown:

Ref. Network ) / ’:‘ Source Table / () ﬁ Select
/ l

_
Address Mode P> Status No sensor connected
i-MAX
IP address 217.193.169.30 Search
. MAX
Port Number (2103
Username ’ﬁ No mountpoint available VRS
Password [ FKP
Nearest
= After creating a Base profile, there is an option to navigate directly to

Base Station Setup. Refer to 5 How to Setup a GPS Base Station for
more information.

= Once a profile has been created, connection to the instrument is
automatically established each time the software is launched. This is
providing that the instrument is turned on with the correct commu-
nication method, and the relevant instrument profile is selected in
the Profiles screen.

= To edit profile settings later, tap the arrow to the right of the profile
name in the Profiles screen.

1.5.6 Setting up a GPS Profile for the Internal GPS of CC80
Using the internal You can set up a GPS profile to use the internal GPS of the CC80 controller for
GPS rough navigation.

Do not use the internal GPS for high accuracy layout or measure
tasks.

Necessary driver

For CC80 controllers delivered with v4.5 or higher, the necessary driver is
already installed.

For CC80 controllers upgraded to v4.5 or higher, download and install the

necessary driver from myWorld under the section CC8x Controller.

«  For CC80 running Windows 8:
CC80-MK1-Component_internalGPS.exe

«  For CC80 running Windows 10:
CC80-MK2-Component_internalGPS.exe

= Before installing the driver, make sure that iCON is not running.

Setup step-by-step 1. Select Devices from the Home Menu. 37

2. Tap @ to create a profile.

3. Select Internal GPS. Enter a Profile Name-:.
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Profiles m Select Unit

=~ iCON gps 60

3\ iCON robot 70
4, iCON robot 80
) icON robot 50
) icoN robot 60

£} TS16/60

&} mse0

4. Tap « to save the profile.
Once the internal GPS is ready, the main screen is displayed.

= When using the internal GPS, the status bar and map view icon in an
application are adapted accordingly. Refer to Status bar for internal

GPS .
To enter the controller height, tap the status bar 1 and select
Antenna:.
1.5.7 Total Station Profile Setup
Define communica- 1. To define the Communication method -
tion method step-by- between instrument and controller select
step For Pole, within the Communication Set-
tings Contalner For Machine Control »
= Ensure that the Total Station is set [ setngs |
accordingly. Compensator )
Sensor Utilities )
Sensor Info )
Sensor Calibration )
Atmospheric Corrections )
2. «  For Cable connection, ensure that the cable is connected. The

connected instrument is displayed in Search Results.
«  For Bluetooth, press the Start Search key. Select the relevant
instrument from Search Results.

ﬁ Select communication channel Communication
& Cole
Mode Bluetooth »
® Bluetooth —
Search Devices Start Search
No sensor selected. Perform search.

== Once the instrument is connected, it changes from white to yellow
in the search list. Tap «.
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Once a profile has been created, connection to the instrument is
automatically established each time the software is launched.
Precondition for this automatic connection: the instrument is turned
on with the correct communication method, and the relevant instru-
ment profile is selected in the Profiles screen.

e

To edit profile settings later, tap the arrow to the right of the profile
name in the Profiles screen.

Machine communication

Within the iCON iCR50 and the PowerTracker profiles it is also possible to
define communication settings between Instrument and Machine.

1.

Within the Communication Settings container, tap For Machine
Control.

From here, define the Communication Mode and the Prism used
on machine.

icR2 Machine control communication
For Pole 4 Device CCD2/6 »
For Machine Control »
Compensator >
P, Prism used on machine
Sensor Utlties ) [ Prsmusedonmachine ]
Prism Type Leica Round »
Sensor Info >
Sensor Calibration >
Atmospheric Corrections >

Tap « when finished.

To switch from Survey Mode to Machine Control Mode, tap the

Machine Control key on the profile name in the Profiles screen.
A Machine mode switch screen is displayed while the switch is

ongoing. Tap the key to switch back to Survey Mode.

Atmospheric correc-
tions

1.

Within a Total Station profile it is also possible to define atmospheric correc-
tion settings.

Within the Settings container, tap Atmospheric Corrections.

2.

Input the desired values for Temperature and Pressure.

iCR2 Atmospheric Corrections

For Pole » Temperature °C 12 ‘

For Machine Control » Pressure mbar 1013.3 ‘
T

Compensator >

Sensor Utilities )

Sensor Info ]

Sensor Calibration >

Atmospheric Corrections >
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Tap « when finished.
To reset to default settings tap ”@

I=>= The values for Temperature and Pressure are displayed and must
be entered according to the current unit settings.

Operating Principles 87



2 Projects, Jobs, Data, and Settings

2.1 Projects and Jobs

Projects and jobs iCON site allows the simple location and transfer of data between instru-
overview ment, controller and office.

Example of a basic
data flow/storage dir-
ectory structure

88

Imported reference and control data is stored in iCON site, within individual
Projects. Jobs can be created and carried out within these projects. Reports,
measured data and calculated results are stored to the active job, ready for
exporting.

This allows you to create a project with specific reference and control data,
and then carry out multiple jobs within this project.

Projects: Jobs:

« Imported data e Output:
«  Control data +  Reports
« Reference data +  Measured data
«  (Coordinate systems «  (Calculated results
«  Codelists
« Road data
»  Background images
«  GNSS Profile
e Point Cloud data

= Jobs are created within the active project. All imported data is avail-

able for all jobs within that project.

Projects

|

|-- Project 1

| |-- Imported data
| |--Jobs

| |-Jobl

| |-- Reports

| |-- Measured data

| |-- Calculated results
| |--Job2

| |-Job3

| |--Job4

|
|-- Project 2

|-- Project 3
|-- Project 4
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Projects ?

To create, edit, select or delete a project, tap L= ] in the Home Menu.

Projects page is displayed. The current active project is highlighted in yellow.

Projects Projects

BUILDING CONSTRUCTION ) - .
b Tl E
a PARKING -
L 4
nnnnnnnnn TRUCTION PARKING Import Data
Import Data >

f g c d e f g

Select or edit project (list view mode)

Select or edit project (thumbnail view mode)
Create project

Delete project

Import project

Toggle view mode

Define sorting

v MDD AN T

Function Process

Select or edit project - To select a project, tap on it.
Once a project is selected, it becomes
the active project. The software returns
to the Home Menu automatically.

« To edit a project in list view mode,

tap the arrow button to the right of
the project name. To edit a project in
thumbnail view mode, tap and hold the
project thumbnail.
If needed, edit project name and
description.
To load more data to the project, tap
Import & Delete in the Home Menu.

Create project To create a project, tap this button and
enter project name and description.

To load data to the project, tap Import
Data.

To define a geometric scale factor, input the

desired value at Geo Scale Factor.

Delete project To delete one or more projects, tap this but-
0 ton and select the projects to be deleted.

%
To select and delete all projects, tap [£=4.

Import project Complete projects can be imported to the

@4. current device.

Toggle view mode To activate list view mode, tap this button.
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Function Process

To activate thumbnail view mode, tap this
button.

=

Define sorting Tap to define a sorting method:
« As imported/created
«  Alphabetical

e Last used on top

= Data can also be loaded to the active project using Import & Delete,
refer to Importing data to the project step-by-step.

= Projects are not backwards compatible: it is not possible to use a
project with an older version of the Leica iCON site software.

Jobs = Creating, editing, selecting and deleting jobs follows the same pro-
cess as with projects.

Tap L1 in the Home Menu.

Jobs page is displayed. The current active job is highlighted in yellow.

Jobs Jobs
Default P Ee
b * e “

Job-B )

JoBA )

BUILDING )

Select or edit job (list view mode)

Select or edit job (thumbnail view mode)
Create job

Delete job

Toggle view mode

Define sorting

0o an Tw

Function Process

Select or edit job  To select ajob, tap onit.
Once a job is selected job, it becomes
the active job. The software returns to
the Home Menu automatically.

« To edit ajob in list view mode, tap the
arrow button to the right of the job
name. To edit a job in thumbnail view
mode, tap and hold the job thumbnail.
If needed, edit job name and descrip-
tion.

Select the active data for the job, such
as reference files, coordinate system,
codelists, etc.
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Function Process

Create job To create a job, tap this button and enter
job name and description.
To activate or deactivate data in the job, tap

View Data.

Delete job 0 To delete one or more jobs, tap this button

and select the jobs to be deleted.

To select and delete all jobs, tap ég

Toggle view mode Tap this button to activate list view mode.

To activate list view mode, tap this button.

Define sorting To activate thumbnail view mode, tap this

button.

= To activate coordinate systems and codelists, tap View Data in the
Edit Job/New Job screen.
Other imported data, such as reference files or control files, can also
be activated or deactivated using the Map view manager, refer to
2.4 Displaying Data.

2.2 Import, Export, or Delete Data
Importing data to the 1. Select Import & Delete from the Home
project step-by-step Menu. JI=|
S All data that is
already loaded to
the active project is
HBG Plane drawing.geo HBG Parking North.lok .
displayed.
HBG outside control.geo
DefaultCodelist.xml
3423-5301_201308.jpg
HBG.jpg
o
2.
Tap 0 to import more data.
3. To define the Source to import data, tap the respective button

for Internal Memory, User Defined, the connected storage device or
connected cloud service, such as Leica ConX (if configured).

i If you select User Defined, you can import data from any folder
that can be found under C:\Users on the controller. When selecting
User Defined for the first time, you will be forwarded to the User
Defined Path screen. Select the folder where your data is stored

and tap v 1o accept your selection. The selected folder will be

remembered. Tap and hold the User Defined button in order to
select a different folder.
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Select the type of data to import. Select from:
« Reference Data

« Road Data

« Control Data

« Coordinate System

«  GNSS Profile

« Background Image

+ Code List

« Point Cloud Data

All files that are

available for import
< LB, B, > < m | =« e > gredisplayed on the
right side.

Import Data

Reference Data Internal Memory

Road Data 1_HBG_P_East_Control.geo

2 HBG_P_North_Control.geo
Control

3_HBG_P_South_Control.geo
Point Cloud

HBG P North Control.geo

Coordinate System HBG P South Control.geo

Code lict HBG Plane drawing.dxf >

After selecting the type of data, you can further filter the displayed
files by file format, for example DXF, ASCIl or PDF.
Tap on the name of desired file format.

Use the tree view on the right side to select the files for import:
« Tap a file name to select a file for import.

« To expand or collapse a folder, tap the folder icon.

« To select or deselect all files within a folder, tap the folder

name.
o For each data type,

the software counts

B, b <l AL | oo wa > the number of selec-
ted files and displays

Reference Data @ Internal Memory It to the rl'g—ht Of the

contoats S —— data type name.

conto ©) — Collapsed folders

pointCloud e that contain selected

HBG P North Control.geo

files are marked with

Coordinate System @ HBG P South Control.geo

S—— HBG Plane drawing.dxf >

an orange dot. B

For certain file types (TXT, CSV, DXF, IFC and others) you can define
import settings.

To edit the import settings of a file, tap the arrow button » . Refer
to the following notes for each file type.

Once the required data is selected, tap v 1o import.
All selected data is imported, and available in the active project.

Speciality for importing layer-based formats like DXF, DWG,
IFC and others:

Before the import starts, a file is checked for its size. If a file is
too large, deselect layers to reduce the file size. Then import the
necessary data.
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= Specifically for importing Coordinate Systems:

« To import a coordinate system that is stored locally on the
controller, set the Source to Internal Memory, and select the
coordinate system from the list below. It is also possible to
select a coordinate system from a subfolder.

« To use a coordinate system ("“transformation set") that is
streamed from a reference network as part of an RTCM3 or
LEICA4G message, set the Source to Via Network (no further
selection needed). Then the controller is ready to receive the
coordinate system.

= Speaf'cally for importing ASCII files (txt, csv):
It is possible to import ASCII files with up to 10 attribute
columns.
« Itis possible to import ASCII files with different distance units.
» Itis possible to select the field separator.
« Itis possible to select between Latitude/Longitude units.
« Itis possible to skip header rows.

= Speaf'cally for importing JPG or TIFF files:
Only import georeferenced JPG or TIFF files. Georeferenced
images come together with a world file (*.jgw or *.tfw) that
ensures the correct placing of the background image on the
map. The image file and the world file must have the same file
name.

I Specifically for importing DXF files:
e Itis possible to import and stake out a Helix data set.
« Import settings for DXF files:
- To clean up DXF files during import, activate the check box
Clean up DXF file.
- Select layers to be imported. The checkbox All is activated
by default.

Tap v to accept.

- After a successful import, @ message is displayed informing
about the "cleaned-up" file size as well.

Import Settings View

]
\/}AII Distance Unit Meter )

Layer1 (77) Height Option Ignore Null Heights »

Layer2 (300) [ l Clean up DXF file

Projects, Jobs, Data, and Settings 93



= Speaf'cally for importing IFC files:
Importing IFC files requires either the Layout Objects or the
Verification licence.

« IFCfiles consist of a set of IFC entities (e.g. ifcBeam, ifcWall).
Tap the arrow button to choose which of these entities should
be imported. After a successful import, @ message is displayed
informing about the number of imported IFC entities.

« Importing GTP points:

GTP is an object type in Autodesk Revit, which represents a
point. iCON can automatically detect these objects in an IFC file
and import them as reference file points.

« Importing Points of Interest:

Points of Interest are points which exist in an IFC file. They are
automatically detected from mechanical, electrical and plumbing
objects. Upon import the IFC file is scanned. If certain objects
are detected, for example cable tray hangers or pipe clevis,
points are generated. The points can be used to stake out the
objects. The complex wireframe of these objects is reduced. For
example, in the case of air conditioning ducts, the complex mesh
is replaced by centrelines and points.

A *.GEO file is created during import. From this *.GEO file, you
can create a stakeout list for auto staking.

Import settings for IFC files:

+  Select the IFC entities to be imported. By default, all list items
are selected. To select or deselect all list items, tap All. To
select or deselect a single list item, tap the requested list item.

« To check the file for hangers during the import, activate the
check box Detect Hangers.

Tap v to accept the import settings.

Import Settings View

clsses [ e ]
v ] All +/ | Detect Hangers

IfcBuildingElementProxy ( 1680 )
IfcCovering ( 2285)
IfcFlowFitting ( 1346 )
IfcFlowSegment (1714 )

IfcFlowTerminal (315)

The imported GTP
points are shown in
3D in Map View.

Select objects, point, line or arc
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Available import formats

Import data Import formats

Reference Data *  Possible import formats are *.txt, *.csv, *.dxf,
*.geo, *.gsi, *.xml (LandXML, HeXML), *.ifc,
* kof, *.TRM, *.DWG, *.SHP and *.PDF (2D).

«  The DXF import offers a special feature
called Height Option: select from Ignore Null
Heights, Use All Heights, and Do Not Use
Heights.

+  The XML format can include up to 10 attributes,
which can be used in Point Search, in the map
Viewing Options, and in the Information bar
within Stakeout.

« Importing IFC files requires the licence for the
Layout Objects application.

«  SHP files which are defined in metres can be
imported. SHP files with link to a coordinate sys-
tem are not supported.

Road Data Possible import formats are *.L3D, *.lin, *.Imd, and
* xml (LandXML, HeXNL).
Control data Possible import formats are *.txt, *.csv, *.geo, *.gsi,

and *.xml (LandXML, HeXML).

Coordinate System Possible import formats are *.lok, TRFSET.dat, *.xml
(LandXML, HeXML), *.dc (Trimble format) and *.loc
(Carlson format).

GNSS Profiles It is possible to import iCON iCG30/iCON iCG70 pro-
files.

Background Image  Possible import format is *.dxf, *.jpg, and *.tiff.

Code List Possible import formats are *.cod, *.xml (LandXML,
HeXML) and *.csv.
Point Cloud data Possible import formats are *.sdb, *.pts, and *.E57.
Importing data using Point information can be imported reading a QR-code.
QR-Scan step-by-step , ,
= To be able to use the QR-Scan function your entitlement needs to

include the QR-Code Reader licence.

=< iCON supports the following QR-Scan structure:
1D XX E 00K 00K N 2006 XK H 200 XXK XK A L XXX
Up to 10 Attribues (Al,...,A10) can be defined.

QR-Scan functionality is available in the applications:
«  Stakeout (iCON site)/Layout Points (iCON build)
«  Verification

«  Draw (iCON site)/Sketching (Layout Points)

e  TPSSetup

QR-code function in New Point tool:

1. In the applications Stakeout/Layout Points,
Draw/Sketching or Verification open the W
Toolbox.

|
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2. Tap New Point. .ﬁi

AN R —— T fclcs t0 enter
T —

point details are dis-
N played.

Code

%

3. [EHg]
’uL
Tap E=] to start the QR-code scan.

Use CODE to define and apply a code for every point recorded.

Enable or disable draw line as required. Only available in the
Draw/Sketching app.

Tap 7= to store the scanned point as Control Point.

The QR-Scan page is
displayed.

QR-Scan

Scanning Target [ scameditems0) |
E:2696154.322
© 13 N:1238285.891 ®
H:485.400

i to switch from single scanning mode to multiple scanning

In single scanning mode only the code within the white frame will be
scanned.

In multiple scanning mode all codes within the camera view will be
scanned simultaneously.

For TPSSetup the QR-Scan functionality is available in the methods:

« Coordinates
« Heights
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QR-Scan function in TPS Setup applications:

1. In step 3 of the
setup procedure tap

I

E |'{ 1.500

Select Point

Meas+Rec QR-Scan
@ @) =

The QR-Scan page is

QR-Scan

displayed.
E:2696154.322
@ 13 N:1238285.891 ®

H:485.400

B
2.
Tap v to accept.
ST
Tap =] to switch from single scanning mode to multiple scanning
mode.
In single scanning mode only the code within the white frame will be
scanned.

In multiple scanning mode all codes within the camera view will be
scanned simultaneously.

= In TPSSetup applications a scanned point will be stored as Control
Point automatically.

Exporting data step-

It is possible to export content to the internal memory, to a connected stor-
by-step

age device or to a Cloud server (if configured).
1. Select Export from the Home Menu.
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The Export screen is

Export

displayed.
Type: Data b To Internal Memory/Data
DAII DCollapse all

Default

EMPTY

Reference Models ~

LINES ARCS.geo

To define the content type to be exported, tap the row below the
section Content. Select from:

 Data

+ Coordinate System

« Code Lists

« Reports

«  Projects

- Stakeout Lists

»  GNSS Profile

- Drill Patterns

+ Machine Calibration

- TPS Calibration

« Point Cloud

The relevant content available to be exported is displayed on the left
side of the Export screen.

When exporting Data, it is possible to select a job as well and export
a subset of job data this way.

3. Select the content to be exported.
It is possible to select multiple list items. Tap each individual list item
or activate the checkbox All to select all items at once.
4. To define the destination of the exported content, tap the row
below the section Destination.
. It is possible to
export data to a
I B subfolder.
Select the desired
i destination, then
tap v to accept
and return to the
Export screen.
5. Select the file format to which the selected data should be exported.
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For some file formats, additional options can be defined. Tap the
arrow button 3} beside the format name.

Specifically for exporting DXF files

It is possible to export codes jobwise. When this option is activ-
ated in the export definition page, then the jobname is added to
the new layer as prefix.

It is possible to export the data either in 2D or 3D. Make the
selection in the export definition page.

It is possible to export point attributes as block. When this
option is activated in the export definition page, then Point sym-
bol and attributes are are bundled in the CAD program display.
Specifically for exporting ASCII files (txt, csv)

It is possible to include up to 10 attribute columns when export-
ing to ASClI files.

It is possible to include WGS84 coordinates and select the unit
format for Latitude and Longitude. Available unit formats are
Deg Min Sec (DD.MMSSSSS) or Deg Dec.

To start the export, tap v

The content is exported as specified.

Available export formats

Export data Export formats

Data

Possible export formats are *.csv, *.dxf, *.geo, *.gsi,
*xml (LandXML, HeXML), *.kof, *.lic, *.plm, and
* xt.

Coordinate System Possible export formats are *.lok, *.dc (Trimble

format) and *.xml (LandXML, HeXML).

Code Lists Possible export format is *.xml (LandXML, HeXML)
and *.csv.

Reports Possible export formats are *.csv, *.html, *.pdf, and
*.txt, depending on the report to export.

Projects Projects are exported as a copy to the data storage
device selected, Removable Disk, Procore, ConX,
Bricsys 24/7 or Bluebeam Studio.

Stakeout Lists Possible export formats are *.txt, *.csv, *.gsi, *.geo,
* kof and *.dxf.

GNSS Profile Profiles are exported as a copy to the selected data
storage device.

Drill Patterns Possible export formats are *.xml (IREDES standard)
for MC1 and *.kof for VisualMachine (kof contains
the bottom points of the holes).

Machine Calibra- Machine Calibration files can be exported to remov-

tion able disk for file transfer to machine control sys-
tems.

TPS Calibration TPS sensor calibration reports can be exported to
USB stick for documentation purposes.

The report is exported with extension ".calibration".

Point Cloud Possible export format is *.pts.
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Deleting data step- 1. Select Import & Delete in the Home Menu.

by-step
5
All data that is already loaded to the active project is displayed.
2. Tap @ and select the data to be deleted:
« To select several list items, tap the requested list items.
« To select all list items at once, tap Select all.
3. Tap ¢ to delete the selected data.
Tap ¢ to cancel.
2.3 Backup and Restore Data and Settings
Backup and restore = The backup and restore functionality is only available on the CC80
controller.
1. Select System from the Home Menu and tap @
Backup and Restore.
2.
System Backup and Restore data
If Automatic Backup is turned On, then the back up will be taken
on every shutdown.
Automatic Backup
Sl D
User Permissions Manual Backup name ~|20201021_212325-UserData |
Touch Screen Mode Manual Backup to Internal Memory )
No backups available
&3
I To exit the screen, tap ¥&¢.
There are two options for creating backup files of all data and settings in the
iCON software.
Automatic backup
If automatic backup is enabled, the software generates a backup file each time
the iCON software is exited. By default, automatic backup is enabled.
Automatically generated backup files are always stored to the internal
memory. For automatic backup, maximum five backup files can be kept. Once a
newer backup file is generated on top of these existing five, the oldest backup
file is deleted automatically.
1. Select System from the Home Menu and tap @
Backup and Restore.
2. To change the setting for automatic backup, set Automatic Backup
to On or Off.
i= To reset to default settings, tap [5.
|
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2.4

Tap « to confirm the settings.

Manual backup
A backup file can be generated manually at any time.

Manually generated backup files can be stored either to the internal memory
or to a USB stick. For manual backup, the number of files that can be stored
depends on the available memory size of internal memory or USB stick.

I~ If necessary, insert a USB stick into the controller.

1. Select System from the Home Menu and tap @
Backup and Restore.

2. To select the file location for the manually generated backup file, tap

the arrow button .
Choose between internal memory or USB stick.

3. To start the manual backup process, select Manual Backup and tap
<.

== In order to store all data and settings to the backup file, the iCON
software must restart. Confirm the message.

Manage backup data

1. Select System from the Home Menu and tap @
Backup and Restore.

= All existing backup files are listed. An icon indicates the backup option
used and the file location of the backup file.

2. To delete a backup file, tap the 3 button to the right of the respect-
ive file.

Icon Backup option used File location
Automatic Internal memory

o

Manual Internal memory

Manual USB stick

£

Restore backup data

1. To restore backup data, tap the name of the desired backup file.
The file name is highlighted yellow.

2. To start the restore process, tap ¢ .

I In order to restore all data and settings of the backup file, the iCON
software must restart. Confirm the message.

Displaying Data

Display point inform-
ation

1. To view detailed information of a stored point, tap and hold the
desired point on the map screen.
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2. The toolbox in the Point Information screen allows you to edit or
delete the point, and to link or unlink the point to images taken
with the camera.

== For points with one or several linked images, the point symbol on
the map changes:

©
Toolbox functions
Function Description
Edit Point Tap to edit the point.
«  Edit the values of the point: Point ID, East-
ing, Northing, Height, and Code/Layer.

+  Code/Layer can be entered and the point
can be defined as Control Point by setting
the Create Control Point key to On.

 Tap v to accept, then confirm the following
warning message.

Link/Unlink Tap to link images to the point.

Delete Point 0 Tap to delete the point.
Map View manager 1. Select Map view manager from the Map 3
handler. \=:

The Map handler is displayed in all applica-
tions. All data loaded to the active project
can be activated and displayed using Map

View manager.

By default, Map View
manager is displayed
in split screen mode,
with a real-time map
preview on the right.

Turn all On / Off

~  sample building.dxf o
~  sample surface.dxf E’
i l Show Points @ | All

m noCodes @
‘j sample_surface @

< P ™ () (@) =
I e

== To disable the map preview in Map View manager, go to Sys-
tem>Display and set "Map Preview on Layer Manager" to Off.

To select which data you would like displayed, toggle between

and .
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The map preview is updated according to the selected data.
«  When layers with many data are switched on or off, the real-
time update of the map preview may cause long loading times.

To pause the real-time update of map preview, tap . The
icon changes to ['\l!! .

e If not paused, the map preview can be zoomed, panned and
rotated.

« If the viewing options Isolate or Limit Box are active before
opening Map View manager, the corresponding icons are dis-
played greyed out in the map preview.

I To "freeze" specific data items so that they are visible but not
selectable in the Map View, go to System>User Permissions>Data

Handling>Layer Manager and select Freeze. Tap ¢ +to confirm
your selection.

System User Permissions

Password Protection

B3 import & Delete

Backup and Restore Bt

Reports
User Permissions

B3 stake List Management

Touch Screen Mode
[ Layer Manager

Hard Button Freeze

[ orr |
™
™
2
~
]
V]
~

ey

The Map View manager will offer the additional option to freeze

ﬂ specific layers for selection.

When the button is

"on" IE’ elements
from the file/layer
are selectable. When
the button if "off",
elements are not
selectable.

DXF/DWG/DGN ~

Turn all On / Off
~  sample surface.dxf (]

U Show Points Al

[ lCODE_attributes 6 |

[ [enatributes @]

B HEIGHT_attributes a

[ Inocodes [@][=]

s v e el

= Map View manager only contains data loaded to the current active
project. If further data is required, it must first be loaded to the
active project.
If codes or layers are included in the imported data file, they can be
accessed using a drop-down arrow, and individually turned On/Off.

To accept the selected data and return to Map View, tap v

To cancel, tap 2 .
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2.5 Point List, Searching for a Point

File List and Point List
Select Point List from the Map handler.

This function is available in every application that
requires the user to select a point from the map.

With this helpful tool it is possible to:

e edit, create or delete points in every application,

- edit point ID, code, prism type and prism height of
measured data,

- apply the same value to multiple points,

- define how and based on which attribute the Point
List is sorted.

= The column order (E, N, H or N, E, H) corresponds to the setting in
Coordinate Order (System > Display > Coordinate Order).

= Attribute values are displayed in the Units and the display mode set
(two, three, or four decimals, found in System > Display > Display

Accuracy).
How to use Point List 1. Select Point List from the Map handler.
step-by-step
2. - Alist of available files is opened.

Select the files you want the Point List to be created for. Mul-
tiple file selection is possible.

Tap v to accept the selection and proceed to the Point List.

Proj: PointAccess Proj: PointAccess
Job: Default Job: Default

D Al D All

Reference Models Reference Models
HBG_outside_control.geo HBG_outside_control.geo

Job Job

Default Default

5% % % @ %
3. The Point List for the current selection is shown.

+  The relevant point status is shown in the left hand column.

Use n or n to display further data of the shown points.
5 Point status and Point ID are always displayed.

Use u or n to change between increasing/decreasing sort

order.

« To sort the list according to another value, tap the relevant
header, for example Height.

- Tap File List to return to the selection of files.
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[ rorincusing g J < Trori v o I ori e e ]
@ |..int3_1  -0.880 ...00.160 | o [0] 1 2.000 -l e 0] 1| -2.100 g
@ 12| -0.600 ...00.000 | ¢ [0] 2 2.000 - e 0] 6| -0.900 g
@ 11, -0.800 | ...99.600 | ¢ E 3 2.000 g 0] 5| -0.300 g
@ 10| -0.800 ...99.200 | ¢ [0] 4 2.000 o @ 10| -0.200 g
@ 9 0.600 | ...99.200 | ¢ [0] 5 2.000 - e 5 3 0.000 g
@ 8 0.000 | ...99.200 | ¢ [0] 6 2.000 o @ | ..int.3_1 0.000  StakeOut | o
@ 7 0.400  ...99.600 | ¢ 0] 7 2.000 o @ 4 0.100 g
@ 6 0.400 | ...00.000 | ¢ 0] 8 2.000 -l e 0] 8 0.500 g
o 3 n nnn nn onn - ~ o a nnn - =Y 4 4 nnn -
!ﬁ/« @

« To change the order of the columns, tap and hold one of the
column headers, for example Northing.

« In the Point List Configuration screen select the Block you
want to change the order for, for example Block 2.

+ In the Columns Configuration screen select the value you want
to replace (for example Code) and tap the new value to use (for

example Cut/Fill). Tap ¥ to confirm the settings.

< File List Point List m Point List Configuration Columns Configuration

© .m3i 0880 00160 o " ,
@ 12| 0600 ...00.000 | ¢ [ Bock2 | Possible Configuration
@ 11, -0.800 | ...99.600 | ¢ H Code ’ ﬁ
] 10| -0.800 ..99.200| ¢ [ o]
® 9 0.600 99.200 | ¢ Pole Height Prism Type »
® 8 0000 99200
® 7 0.400 99.600 | ¢ CQ Position Cut/Fill »
® 6 0400 00000 ¢
Attribute 3 Attribute 4 Attribute 5

If more than one page is available tap . In the pop-up menu
use Previous or Next to display the corresponding page or
enter page number directly.

To get one certain point selected in the map, tap ¢ atthe

right side of the point row.
« The map is displayed and the selected point is highlighted.

- PointID | Height v ..delLayer | > n PointID | Northing m I T
@ -2.100 o 0] 11 ..99.600| -0.800 ¢ f+100.000

o
[} 6‘ -0.900 ‘u @ 6 ..00.000 0400 ¢

A @
@ 5‘ -0.300 ‘4 0] 5 ..99.800  0.000 ¢
@ 10‘ -0.200 ‘4 [©) 10 ...99.200| -0.800 ¢ SOpoint_3.1 %1
E : » - 101
4 3‘ 0.000 ‘ ¢ ...00.000|  -1.000 !%3
@ |..int_3_1 g @ |..int_3_1 ..00.160 -0.880 ¢
Page: 111

@ Apage [©] 4]..99.800| -0.200 ¢
0] 3 @ 8 ...99.200 0.000 ¢ Point ID
P -~ | anoanl noeal

= A point selection from Point List is available in applications or func-

tions where point selection is allowed.
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Toolbox functions The Toolbox contains some additional

Point List Tools

functions.
B -
¢ ®
Function Description
New Point » Create a new point by:
- Entering the required values: Point
ID, Easting, and Northing. Height is

optional but needed for all 3D applica-
tions.
- Scanning a QR-code.

To start the QR-code scan tap
See also: Importing data using QR- Scan
step-by-step
« A new point can also be created with Point
ID and Height, to be used for Transfer
Height during Total Station setup.
+ Code/Layer can be entered and the point
can be defined as Control Point by setting
the Create Control Point key to On.

== If you select a point before selecting
this tool all relevant attributes are
derived for the new point.

Edit Point «  Multiple point selection is possible.

« Select a point, then use this tool to edit val-
ues of the point: Point ID, Easting, North-
ing, Height, and Code/Layer.

Prism Type and Pole Height are available
for measured points.

« To change the point into a Control Point
activate the Create Control Point check-
box.

Tap v to accept, then confirm the follow-
ing warning message.

Select all/ wwy  Select all points for editing or deleting, or quickly
Deselect all %i deselect all points when already being selected.
Search Start a Point Search. Refer to Start a Point

Search step-by-step for more information.

Clears the results of the last Point Search and

displays the full content of the selected files
again.

Clear Search

Delete Point Either first select the point to delete and then
the delete function or reversed. Multiple file
selection is possible. Tap ¥ to accept, then con-

firm the following warning message.
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Function Description

Stakeout List — To use the Auto Point Selection function to

stake points automatically, it's necessary to
@ define the list of points using Stakeout List
first.

=5 In 5" or 7" display mode, with Mul-
tiview active, use Stakeout Point List
to get the points to be staked dis-
played. It is possible to select the
points for staking out from the list.

Export - +  Export the selected data. Select the data

i“a format for exporting and select the target,
for example Internal Memory.

«  When Removable Disk (= name of the
external data storage device) is selected
as target, the exported data can be used
on another controller after importing them
from the external data storage device.

«  Select iCON3D Removable Disk as target
to export the data for machine use. It is
possible to create a New Project for export
or use an existing project on the external
data storage device.

Start a Point Search 1.

step-by-step

== Using the Export feature, it is possible
to select and export a subset of job
data.
Select Point List from the Map handler.

2.

Select the file you want to search for points. Mul-
tiple file selection is possible.

Proj: PointAccess
Job: Default

QAH

Reference Models

HBG_outside_control.geo

Default

3.

Tap to display the "Search Criteria" screen.
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Define search criteria
(Simple)

108

By default, the "Simple Search Criteria" screen is

displayed.
Simple Search Criteria
e

Wildcard

Point ID

Point ID Range

Wildcard No Codes

Wildcard

Code

\
\
Height Range ‘
\
Code Description ‘

Attrihnte Nam |

Wildeard

4, Define the search criteria. Refer to Define search criteria (Simple).

= To define advanced search criteria, tap Advanced. Refer to Define
search criteria (Advanced).
To erase all entered search criteria, tap 5.
To cancel point search, tap ¥.

5. To start the point search according to the defined criteria, tap .
The search results are displayed in Point List. Refer to Search Results
List.
If no matching point data is found, an error message is displayed.

Simple Search Criteria

Map Selection Complete Map

Point ID || | wildcard

Point ID Range ‘ ‘

Height Range ‘ ‘

Code ‘ Wildcard No Codes

Code Description

AttributeName Wildeard

=< In simple search mode, you can only enter a single value for each

search criterion. It is not possible to enter multiple values for the
same type of search criterion. To define multiple search criteria, use
the advanced search mode.

Different search criteria can be entered together for a combined
search, for example Point ID Range and Code. The result of such a
search is a list of points that fit all search criteria.
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Search by Map Selection

1. Tap Define.
Map view is displayed.

2. Tap on the map to create the first corner of
the search area.

3. Tap again to create as many corner points as
needed for the search area.
Tap « to accept.

&3 2 g

I The result of this search is a list of points within the defined area.

Search by Point ID
Following search options are available:

Input Search result
Exact search A point of which the Point ID matches
Enter the desired value for exactly the input value.
Point ID.
001 ] D
Wildcard search A list of points of which the Point IDs include
Enter the desired value for the input value.
Point ID and activate the For example, if you make wildcard search for
Wildcard checkbox. point ID "1", the result may be: "1, Al, 10,
212, 301" and so on.
i [
Search by range A list of points of which the Point IDs are
Enter a start and end value within the defined range.
to define a search range. = Point ID Range search is avail-
able for numeric and alphanumeric
‘1 ‘ ‘8 ‘ input values. For alphanumeric

input values, the entered letters
for start and end value have to be
identical, for example, Al to A5 or
Tree01-TreelOO.

Search by Height Range (Elevation search)

Input Search result
Enter a start and end value A list of points of which the heights are
to define a search range. within the defined range.
= Wildcard search is not an option
168.000 | |450.000 for the Elevation search.
= Only numeric values can be the

input for the Elevation search.
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Search by Code
Following search options are available:

Input Search result

Exact search A list of points of which the Code matches
Enter the desired text for exactly the input text.

Code.

[TREE } \j

Wildcard search A list of points of which the Code includes

Enter the desired text for the the input text.
Code and activate the Wild-
card checkbox.

{Tre l

Search for points without A list of points which have no code applied.
codes
Activate the checkbox No

Codes.
No Codes

Search by Code Description

Following search options are available:

Input Search result
Exact search A list of points of which Code Description
Enter the desired text for matches exactly the input text.

Code Description.

[Tree species } l:]

Wildcard search A list of points of which the Code Descrip-
Enter the desired text for tion includes the input text.

Code Description and activ-

ate the Wildcard checkbox.

{Tree spec }

Search by Attribute Name and Attribute Value
Following search options are available:

Input Search result

Exact search A list of points of which the attribute values
Enter the desired text for match exactly the input text.

Attribute Name or Attrib-

ute Value.

{Species } D
{Chestnut } D
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Input Search result

Wildcard search A list of points of which the attribute values
Enter the desired text for include the input text.

Attribute Name or Attrib-

ute Value and activate the

Wildcard checkbox.

[Spec ]

Define search criteria
(Advanced ) m Advanced Search Criteria

Map Selection Complete Map m
Point ID Define multiple Point ID m
Height Range Define multiple Height m
Code and Description Define multiple Code/Description m
Attribute Name Define multiple Attribute Name m

==

Attribute Value Define multiple Attribute Value

o

= In advanced search mode, you can enter multiple values for one type
of search criteria.

Different search criteria can be entered together for a combined
search, for example Point ID Range and Code. The result of such a
search is a list of points that fulfil all search criteria.

In advanced search mode, the available search criteria and search
options are basically the same as described for simple mode.

For a description of the basic search options, such as "exact search,
wildcard search, search by range or search by map selection", refer to
Define search criteria (Simple).

= The search criteria Point ID and Point ID Range as well as Code and
Code Description are combined.

Available search criteria

« Map Selection:

Easily define a search area by selecting Define and tapping on the map.
 Point ID:

Define multiple Point IDs to be searched for.
+ Height Range:

Define multiple height ranges to be searched for.
+ Code and Description:

Define multiple codes and code descriptions to be searched for.
e Attribute Name

Define multiple attribute names to be searched for.
e Attribute Value:

Define multiple attribute values to be searched for.
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Defining multiple search criteria in advanced mode

1.

Tap the Define button beside the search criterion that you want to
edit.

The input screen for this search criteria is displayed.

Exception: For Map Selection, the map screen is displayed.

Single editable field:
« Enter avalue and tap ¢ at the right of the editable field.
The value is added as a new line.
« To define multiple values repeat as often as necessary.
Two editable fields (range):
Enter two values. The accept button at the right of the editable fields
only gets active when values for both fields are entered.

| = IJLJ
v

3.000 — 2.000

To delete an already defined value, tap ¥ at the right of the line.
The line with this value is deleted from the list.

Point ID
Enter Point IDs always as numeric values with an optional alphanu-
meric prefix. Input values without numbers are not allowed.

Height Range:
If the value entered first is greater than the second value, the values
are automatically switched.

[8.000 | - [1.000 L« |

1.000 — 8.000 b4

Code and Description

The editable field for Code Description works also with wildcard
option enabled. If you enter and accept a value for code description,
the code that has the defined code description, is displayed.

To accept all entered values and return to the overview of advanced
search criteria, tap «.

The defined values are displayed in the second
column of the screen. Example:

m Advanced Search Criteria

- sawr |
Map Selection Complete Map

Point ID PO1PO7 — P10
Height Range 1.000 - 8.000
Code and Description Define multiple Code/Description Define

Attribute Name Define multiple Attribute Name

Attribute Value Define multiple Attribute Value
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Search Results List The result of any Point Search is a list

of points that fit the search criteria. An G v |
example of such a search results list is -MMM‘
o]

shown. 1 0.000|  0.000
Refer to How to use Point List step-by-step
. . . 0] 2 0.840 -0.929
for more information about changing the
sort order, viewing different values and fur- © 3] %3134 -2.869
ther functions. o 4| 105.428| -4.808
= By selecting a point from the res- o) 5 157.723| -6.748
ults list and tapping Map, the map ® 6| 210017| -8887
screen appears and the selected
point is active, ready to be used @ 7| 26231 0827
within the application. © 8 314605 -12.566
= In case the search output is - -
more than 500 points, an inform- = )
ation screen appears. Confirm that
screen to display the first 500
points on the list.
2.6 Managing Stakeout Lists
Stake List Manage- The Stake List Management function offers the following options:
ment function - Getting an overview of available stakeout lists within the active project.

e Checking the work progress of a stakeout list.
e  Editing the name of a stakeout list.

« Selecting a stakeout list for staking out.

«  Creating or deleting a stakeout list.

The Stakeout Lists screen
To display the Stakeout Lists screen, select Stake

List Management from the Home Menu. @

The section Stakeout Lists displays the available
stakeout lists. The currently active list is highlighted
in yellow.

Stakeout Lists Edit Stakeout List

Stakeout Lists

Name list1

Created 11.12.2017 - 09:51:52
R foundations ‘ b4
HP) foundations ‘ ®
i3 foundations ‘ b4
© 4 foundations ‘ x

To select a different stakeout list for staking out, tap the name of the list. The
selected list is highlighted in blue.
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To display the content of a stakeout list or to edit its name, tap the

arrow button. ) Already staked-out points are displayed greyed out and are
marked with a stakeout icon.

Work progress

A status icon displays the work progress as percentage of the total number
of points to be staked out. Additionally, the icon contains a progress bar with
changing colours.

Creating a stakeout Stakeout list based on reference data
list based on refer-

ence data or the
point list

= Before creating a stakeout list, ensure that the necessary reference
data is imported to the project.

1. To add a stakeout list, tap .
A wizard leads you through the necessary steps.

== To cancel the process and close the wizard, tap $ within any of the
wizard steps.

2. Wizard step "New Stakeout List"
Enter a name for the new stakeout list. Tap the next Wizard step

m to proceed.

3. Wizard step "Data"
Select the reference data from which you want to import points into

the stakeout list. Tap the next Wizard step m to proceed.

The wizard step "Filter" is displayed.

Point ID Range ‘ 100 ‘200 ‘

Code ‘ [ } Wildcard [ ] No Codes
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4. = Stakeout lists support a maximum of 1000 points, but a
reference file may contain much more points. Apply this
point filter to reduce the number of points.

Enter the necessary filter criteria:

- Point ID Range: To define a range of points enter two-point IDs
as start and end of the range.

« Code: To filter out points with a specific code, enter a code.

«  Wildcard: To search for points with the code attribute contain-
ing at least the entered criteria, activate the checkbox.

* No Codes: To include points without a code attribute, activate
the checkbox.

To reset the filter to default values, tap 5.

To start point search, tap the next Wizard step.m

Wizard step "Preview"

The resulting point list is displayed.

» To edit the filter criteria and start a new point search, tap the

previous Wizard step. m

+ To delete a single point from the list, tap 3. To restore all
deleted points, tap [15.

» To close the wizard and create the stakeout list, tap «.

Stakeout list based on point list
== You can use the point list to add points to a new or existing stakeout
list.

For detailed information on using the Point list, refer to 2.5 Point
List, Searching for a Point.

In the current application, select Point List from
the Map handler.

The Point List screen is displayed.

= Regardless of having points selected, the Stakeout List function
always adds all points in the point list to the stakeout list. To reduce
the number of points to be added, use the Point search function.

1. To add the points to a new or existing stakeout list, select Stakeout
List from the toolbox.

Following screen is displayed:

m Create new or add to existing stakeout point list
‘ New List 1 ‘

&4
Existing stakeout lists

) list 1 11.12.2017 - 09:51:52
B list 2 11.12.2017 - 09:52:27
[ list 3 11.12.2017 - 09:52:52
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= To return to map view without creating a stakeout list for
the created points, tap Back.

+ To add the points to a new stakeout list, enter a name and
tap ¢.
« To add the points to an existing stakeout list, tap the respective
row in the list.
A message is displayed, informing about the number of points added
to a new or existing stakeout list.
Tap OK to return to map view.

Exporting a stakeout it jagired, you can export an individual stakeout list or all stakeout lists within

list a project.
Points in the stakeout list that already have been staked out, are not
included in the exported file.
For detailed information about possible export formats and how to export
files, refer to Exporting data step-by-step.
2.7 Settings
Language settings i Numerous languages are available to run the software with.
- @
To set a specific language select System from the Home
Menu.
2. Select Language.
System Select Language
About = E H 1
Online Map e A il S —
Backup and Restore E I] flll: : :
User Permissions E lIl : E
Touch Screen Mode e - .
Display L!E} \E %
B =
3. Tap on the flag for the desired language.
Tap « to accept.
Display settings 1. To configure the date and time settings and basic display settings

select System @ from the Home Menu.
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Units settings

2. Select Display.

System

Time

Current Time

Display

24 Hours »

21:23:52

Backup and Restore Date DD.MM.YYYY )
Touch Screen Mode Coordinate Order E,N,H )
Display Accuracy Standard »
Info Flash
o
Element Options Description
Time format 24 Hours, 12 Selected format is adopted
Hours throughout the application.
Date format DD.MM.YYYY, Selected format is adopted
MM.DD.YYYY, throughout the application.
YYYY.MM.DD
Coordinate E,N,H Selected format is adopted
Order N,E, H throughout the application.
Display Accur- Simple, Stand-  Defines the decimal place:

acy

ard, Precise

Simple: 0.12

Standard: 0.123

Precise: 0.1234

Selected format is adopted
throughout the application.

Map Back-
ground Colour

White, Default,
Grey, Dark Grey

Allows for adapting the background
colour of the map view.

Info Flash

On, Off

When set to On, a confirmation
flashes over the Information bar for
certain processes, for example when
storing a point.

Map Preview on On, Off When set to On, the map preview is

Layer Manager enabled in Map View manager. Refer
to Map View manager.

Information On, Off When set to On, a preview window

preview for pops up showing the values to be

points stored for the currently measured
point, for example Point ID, coordin-
ates, assigned code and attributes.
Refer to Information preview for
points.

1. To configure the units settings for Distance and Angle select

m/ft

Units ok from the Home Menu.
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Tolerance settings

118

Units & Tolerances

Distance

Angle

Tolerances

Atmosphere

Currency

Distance is selected
by default.

Distance Settings

Distance Meter »
Area m2 b
Volume m®
Chainage 12345.678 »

Scale factor GNSS Factor p

R ey

- For Distance select from Meter, US Survey Feet Fractional,

US Survey Feet Decimal, Feet Fractional, or Feet Decimals.
For Area select from m?, Hectare, US ft2, US Acres, Int ft?, or
Int Acres.

«  For Volume select from m3, Int ft3, US ft3, or yd3.
- For Chainage select one of the predefined settings.
«  For Scale factor GNSS select between Factor and ppm or

mm/km.

Tap ¥ 1o save changes.

Select Angle.

Units & Tolerances

Distance

Angle

Tolerances

Atmosphere

Currency

Angle Settings

Angle Gon b
Vertical Angle Zenith

Slope Display Elev. Angle »

Latitude, Longitude Deg Min Sec »

S ey

«  For Angle select from Gon, Deg Min Sec, or Deg Dec.

«  For Vertical Angle the sole setting is Zenith.

« For Slope Display select from H:V, V:H, %, or Elev. Angle.

« For Latitude, Longitude select between Deg Min Sec or Deg

Dec.

Tap ¥ 1o save changes.

m/ft

Tolerance settings can be altered in Units
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2. Select Tolerances. The screen contains
tolerance settings for

Units & Tolerances Tolerance Settings .
Total Station and
Distance Tolerance Medium ) GPS.
TPS Setup 2D 0.0120
Tolerances
TPS Setup Height 0.0160
Atmosphere
TPS StakeOut 2D 0.0120
Currency
TPS StakeOut Height 0.0160
GPS Quality 2D 0.0300
% e

The tolerance setting
for Verification report

Units & Tolerances Tolerance Settings

Distance GPS Quality 2D 0.0300 IS On/y aval/ab/e )
Angle with the respective
GPS Quality Height 0.0400 .
Tolerances /I cence.
GDOP 4.000 |
Atmosphere
GPS StakeOut 2D 0.0300
Currency
GPS StakeOut Height 0.0400
Tolerance 0.0160
Y &y
3. In the Tolerance Settings screen, define the Tolerance level.

Select from three predefined tolerance sets:
« Tolerant

«  Medium

Precise

Or select a user-defined tolerance set.

Tap v to save changes.

I To define a user-specific tolerance set:
« Tap one of the relevant icons.
e Give the tolerance set the desired name.
«  Enter the desired tolerance values for Total Station and GPS.
Both values must be set! By default the Medium values are set.

When finished tap ¥ to confirm.
« Up to ten user-defined tolerances can be stored.

Units & Tolerances Tolerance Settings

Distance Tolerance User-Defined 1 »
Name ‘
Tolerances
Atmosphere TPS Setup 2D 0.012 |
Currency TPS Setup Height 0.016
TPS StakeOut 2D 0.012 |
TPS StakeOut Height 0.016 ‘

I
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Atmospheric unit set-
tings

120

Adopted tolerance values differ according to the connected instrument, and

the active application:

Tolerance level

Tolerant Medium Precise
Total Station
TPS Setup 2D 0.0300 m 0.0120 m 0.0030 m
TPS Setup 0.0400 m 0.0160 m 0.0040 m
Height
TPS StakeOut 0.0600 m 0.0120 m 0.0060 m
2D
TPS StakeOut 0.0800 m 0.0160 m 0.0080 m
Height
GPS
GPS Quality 2D  0.0600 m 0.0300 m 0.0150 m
GPS Quality 0.0800 m 0.0400 m 0.0200 m
Height
GDOP 5.0 4.0 3.0
GPS StakeOut 0.0600 m 0.0300 m 0.0150 m
2D
GPS StakeOut 0.0800 m 0.0400 m 0.0200 m
Height
Verification 0.0800 m 0.0160 m 0.0080 m
1. m/ft
Atmospheric unit settings can be altered in Units
2. Select Atmosphere.
Distance Temperature Celsius (°C) »
Atmosphere
R G
3. In the Atmosphere Settings screen, set the units for Temperature

and Pressure.

+  For Temperature select between Celsius (2C) and Fahrenheit

(2F).

e For Pressure select from mbar, mmHg and inHg.

4, Tap « to save changes.
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Sound notification

User Permissions

To configure the sound notification settings, select System @
from the Home menu.

Select Sound.

System Sound

Sound

Volume Mid »

Backup and Restore Sound Notifications

On Storing Beep >

User Permissions

TPS prism lost LostPrism b
Touch Screen Mode

GPS fix lost LostFix »

T

In the Sound Settings screen:

«  Switch sound on and off.

«  Select Sound Volume level from Low, Mid, or High.

«  For On Storing, TPS prism lost, and GPS fix lost select sound

file for notification. Tap | © |tolisten to the relevant demo
sound.

Tap ¢ to save changes.

The software allows for a user-configurable content of the Home
Menu. Therefore it is possible to configure the Home Menu to show
selected features only. These settings can be password protected.

- @
To configure the User Permissions settings select System from
the Home Menu.
Select User Permissions.
System User Permissions The ”User Permls-
sions" screen is dis-
Password Protection m p I a ye d
B3 Applications
Backup and Restore B3 pata Handling
User Permissions Sl
Touch Screen Mode
Hard Button
Display
R
4. Switch Password Protection on and off. When switching the pro-

tection on, enter a password and confirm that password.
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Touch Screen Mode

122

To change user per-
missions or rather

System User Permissions

About Password Protection the Content -to be
Online Map Password displayed and fea-
Backup and Restore Confirmation tures to be avall_
User Permissions | Applications able , tap E to
Touch Screen Mode £ pata Handling expa nd to the fu”
Hard Button B [ I extend for Applica-
_— I ~/ ' tions or Data Hand-
= ling or Settings .
3 ey

A

> Now simply tap the checkbox for each application or feature to
be displayed on or off.
Selection is possible for:
« All Applications installed and activated by license.
+ The Data Handling features:
«  Projects
« Jobs
« Import & Delete
- Export
 Reports
«  Stake List Management
e lLayer Manager
«  Edit Control Point
«  The Settings for:
e Units
«  (ouds
e Laser Settings
e Prism Type
+  Localization from File
To save changes, tap v
1. Select System from the Home Menu. Tap Touch
Screen Mode. @
2. Tap the row Touch Screen Mode to define the operation mode. Tap

an item in the list to select it.

e Touch or pen operation.

«  Touch operation in wet conditions. Pen is disabled.

«  Touch or pen operation or touch operation with gloves.

Tap ¢ to save changes.

If the Hard Button setting is configured accordingly, you can also
toggle the touch screen mode with the Rotation button on the con-
troller. Refer to Button configuration.
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Button configuration Hard Button configuration on CC80 controller

I When using the iCON software on the CC80 con-
troller, it is possible to configure the functions of
the Rotation button.

1. Select System from the Home Menu. Tap Hard
Button.

Following screen is displayed:

System Hard Button

About ) Button A Measure button

Hard Button ) Rotation button Switch Touch Mode p

iCON Analytics Note: The "A"-button is fixed configured to Measure. The "Rotate"
button outside of iCON can only be used to toggle between the
three Screen Touch Modes.

Touch Screen Mode

Sound

Backup and Restore

Display

o3 o) A

== The Measure function is always assigned to the Button A.

2. Tap the row Rotation button to assign one of the following func-

tions to the button:

»  Switch Touch Screen Mode

»  Snipping tool

+ Camera

»  Store on demand

«  Start/Stop Line

»  Screen Recording
To start recording, tap the Rotation button. To stop recording,
exit ICON. The recording file is saved on the desktop.

»  Windows button

 None

3. Tap ¢ to save changes.

Necessary driver for

. For CC80 controllers delivered with v5.0 or higher, the necessary driver is
screen recording

already installed.

For CC80 controllers upgraded to v5.0 or higher, download and install the
necessary driver (CC80-MKx-Component screenRecording.exe) from myWorld
under the section CC8x Controller.

= Before installing the driver, make sure that iCON is not running.
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3

Applications

Available applications

124

The following applications are available within iCON site:

Setup

Determine Total Station instrument orientation and station coordinates
using Total Station measurements.

Refer to 4 How to Setup a Total Station for more information.

Base Setup

Establish a Base station to transmit position corrections to a rover.

Refer to 5 How to Setup a GPS Base Station for more information.
Coordinate System

Create a coordinate system for GPS measurements.

Refer to 6 How to Create a New Coordinate System for more information.
Measure

Collect and display point and line information using the connected instru-
ment.

Refer to 7 How to Measure and Record Data for more information.
Checks

Select or measure points or lines to check geometries.

Refer to 9 How to Do Checks for more information.

Draw

Draw and display points, lines and arcs without a connected instrument.
Refer to 10 How to Sketch a Plan for more information.

Stakeout

Place marks in the field at predetermined points.

Refer to 11 How to Stake Out for more information.

Cut & Fill

The heights of measured points are compared against the heights of a
Terrain Model.

Refer to 12 How to Stake Out Surfaces for more information.
Verification

Use surfaces, objects, point clouds or patterns as a reference and com-
pare them to measured (as-built) surfaces, objects, point clouds or pat-
terns.

Refer to 13 How to Use Verification for more information.

Roading

Place marks in the field along predetermined road lines and cross sections.
Refer to 14 How to Stake Out Roads for more information.

Roading is an optional application. Ask your agency or your Leica Geosys-
tems representative for information about licensing.

Volumes

Allows surfaces to be measured and volumes to be calculated from these
surfaces.

Refer to 16 How to Handle Volumes for more information.

Slopes

Allows you to do checks on a defined slope, to find the Daylight line or the
Daylight point, and to stake and mount the batter board.

Refer to 17 How to Handle Slopes for more information.

Slopes is an optional application. Ask your agency or your Leica Geosys-
tems representative for information about licensing.

Applications



Applications

MC Calibration

Perform a simple and quick workflow for a Machine calibration.

Refer to 18 How to Use Machine Calibration for more information.

Leica ConX

With a connection between the controller and the Leica ConX web page,
this tool offers:

- aremote user to access the controller to view or control iCON site.

- to exchange data between the controller and a remote web page.

- aremote user to track the current position of the sensor.

Refer to 20.1 How to Use Leica ConX for more information.

To use this functionality an account is needed for the Leica ConX web
page. The license is handled on the controller. Ask your agency or your
Leica Geosystems representative for information about licensing and how
to get an account.

Autodesk BIM 360 Docs

An online file storage and sharing platform which allows to download or
upload standard files, such as PDF, DXF, DWG or IFC.

Refer to 20.2 How to Use AutodeskBIM 360 Docs for more information.
Procore

A construction project management software which allows to collaborate
on projects and share access to documents, planning systems and data.
Refer to 20.3 How to Use Procore for more information.

Bluebeam Studio

A construction project management software which allows to collaborate
on projects and share access to documents, planning systems and data.
Refer to 20.5 How to Use Bluebeam Studio for more information.
Bricsys 24/7

A construction project management software which allows to collaborate
on projects and share access to documents, planning systems and data.
Refer to 20.4 How to Use Bricsys 24/7 for more information.

The following chapters explain how to use the different applications.
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4 How to Setup a Total Station

4.1 Control Points
Adding control points  For some setup procedures, control points need to be available in the current
toajob job. There are different ways to add control points to a job.
Importing control You can import a list of control points. Refer to
points Importing data to the project step-by-step.
= When importing TPS control points,
information on prism type and height is
only imported for file types *.geo and
* xml. After importing the control points,
add missing information using the toolbox
function Edit in the point list. Refer to
2.5 Point List, Searching for a Point.
Defining new When creating new points in the point list, you can
points as control define them as control points. Refer to 2.5 Point
points List, Searching for a Point (Toolbox function New).
= After creating a TPS control point, add the
information about prism type and height
using the toolbox function Edit.
Turning existing «  Open the point list and select an existing meas-
measured points ured point.

into control points « Use the toolbox function Edit to turn the point
into a control point.
«  For TPS points define prism type and height and
the coordinates of the new control point.
Refer to 2.5 Point List, Searching for a Point
(Toolbox function Edit).

Defining measured In the Measure application, activate the toolbox
points as control function Control Point to define measured points
points as control points.
« To measure and store a control point, press
Start. All measured points are stored as control
points.
«  For TPS points select the correct prism type and
height (refer to 1.3.1 Prism Types and Prism
Heights ).
= The information about the currently selec-
ted prism type and height is stored
together with the measured control point.
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Creating control
points in the Draw/
Sketching applica-
tion

Create a single control point

Select the toolbox function New Point.
Enter the coordinates for the new point.

Tap V-3 to activate the Control Point function
or select Control Point in the toolbox.

Tap ¥ to create the control point.

Create several control points along a line

Select the toolbox function Start Point.

Define direction of the line, distance from the
start point and height.

Select Control Point in the toolbox.

Tap m and enter the desired number to cre-
ate several control points along a line.

Tap ¥ to create the control points.

Information about prism type and prism height for TPS points

The information about prism type and height of a control point only needs to
be defined once. There are two possibilities to define this information:

«  Define this information directly after adding control points to a job by

using one of the previously described methods.
«  Define this information when using a setup procedure with coordinates

for the first time:

Before measuring an existing control point, select the correct prism type
and height. The information about the currently selected prism type and
height is stored together with the measured control point.

The next time you start a setup procedure, this information is auto-
matically set for each control point. You can directly select and meas-
ure the control points for setup.

4.2 Setup Methods
Setup Methods Method Availablilty
iCON iCON iCON iCON
site site Plus build build
Plus
‘ Coordinates
= | Anywhere v v v v
Coordinates
Over known v v v v
point
Coordinates
Set Orienta- v v v v
tion
|
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Method Availablilty
iCON iCON iCON iCON
site site Plus build build
Plus
Coordinates
Setup Pilot v v v v
Control Line
Anywhere - v v/ v
Control Line
Over 1st - v v v
point
Control
LineAs Built - v v v
Walls
Tilted plane == License of its own
Set Refer- If licensed then available in:
ence Plane
v v v/ v
Tilted plane == License of its own
Restore Ref- |t jicansed then available in:
erence Plane
v v v v
Heights
Transfer - v/ v/ v
height any-
where
Heights
Over refer- v v v/ v

ence point
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4.3

Setup Anywhere with Given Coordinates

General description

Setup anywhere with
given coordinates
step-by-step

Station
(sought)

Y ! ... Known

006769 001

Given:

points

- Control points are active within the current job. Refer to Control Points.
e Instrument positioned anywhere on site.

1. Select Setup from the Home Menu.
Ik

2. Select Anywhere.

For an overview of available setup methods refer to Setup Methods.
S ©

then tap the next

Wizard step m to Y

proceed.

4
Compensator
b4

4. Enter a Station Name (iCON site/iCON build Plus only).

Enter Instrument Height and Reflector Height, if needed.

The Create Ctrl. Station Point tick box allows to define the station
as control station point. In that case it's also possible to assign a
code to that station point.

= If you want to check the Total Station setup periodically

activate the option using the Prompt for Setup Checks
tick box and set the Check time (Hours): as required.
According to the time set you will be reminded repeatedly
to check the setup.
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Setup Instrument n

Instrument Height: ‘1,550

Create Ctrl. Station Point

Code

Reflector Height: ‘1.500

With Height: v

3
S

5. Proceed to the next step, where the Map screen is displayed. Tap a
point to select it as the first point to measure.
Aim telescope to target point, then press Measure, then Store, or
press Meas+Rec, if configured. Repeat for a second point.
I Alternatively, tap QR-Scan to scan point information.
To be able to use the QR-Scan function your entitlement needs to
include the QR-Code Reader QR Code Reader licence.
For further information refer to: Importing data using QR-Scan step-
by-step
‘ A
A
6' ”: the station is = ) RRE Calculated station within tolerance.
Wlthln tOlerance, 2 - selmpoim‘ 2 Selectadditional:jl:!‘oraccepllseL
tap v to accept.
== To measure further points, tap the relevant point, then Measure

and Store.

How to Setup a Total Station



= When at least Desslect acksight o
tWO pOIntS have exclude from calculation

been measured' ‘the - Point ID Plane Residuals Height Residuals

Residuals screen — = g J
can be accessed prisminfo 1500
by tapping o | v om
where inaccurate Frem e [rse0
measurements can v
be removed. prismnfo 1500

Tap v to accept
station position.

4.4 Setup over One Known Point with Second Known Point

General description

PO Station
(sought)
P1 Known
006770.001 point

Given:
- Control points are active within the current job. Refer to Control Points.
« Instrument positioned over a known point.

known point with
second known point

Setup over one 1. Select Setup from the Home Menu. I&
u

step-by-step 2. Select Over known point.
For an overview of available setup methods refer to Setup Methods.

B el nethmen s
then tap the next
Wizard step m to 2

proceed.

4

Compensator
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Enter Instrument Height and Reflector Height. Use the With
Height: tick box to save the station with the height value.

= If you want to check the Total Station setup periodically
activate the option using the Prompt for Setup Checks
tick box and set the Check time (Hours): as required.
According to the time set you will be reminded repeatedly
to check the setup.

E T — n

Instrument Settings

Instrument Height: 1700

Reflector Settings

Reflector Height: 1700

Height check for station

With Height: v

Setup checks

Prompt for Setup Checks

Check time (Hours): [o

o
<

Proceed to the next step, where the Map screen is displayed. Select
the Station Point, and select a Target Point.

Aim telescope to target point, then press Measure, then Store, or
press Meas+Rec, if configured.

Select target point and measure )

Meas+Rec QR-Scan

Alternatively, tap QR-Scan to scan point information.

To be able to use the QR-Scan function your entitlement needs to
include the QR-Code Reader QR Code Reader licence.

For further information refer to: Importing data using QR-Scan step-
by-step

If the station is ‘ _—
L SR mo &) Calculated station within tolerance.
within to|erance’ Select other point or accept/set.

)

tap 4 to accept. If
out of tolerance, re- ‘a

measure to the tar-
get point, or to a
new target point. Ko N
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4.5 Set Station Orientation I8

General description

PO Station
P1 Direction
006771 001 p0| nt

Given:

- Control points are active within the current job. Refer to Control Points.
e Instrument set up over a known point.

Set station orienta- 1. Select Setup from the Home Menu.
tion step-by-step I%

2. Select Set Orientation.
For an overview of available setup methods refer to Setup Methods.

B el meiment. :
then tap the next
Wizard step m to M

proceed.

v %
Compensator

Y hegntmenpro. IR
Height, then pro- .

ceed to the next
leard Step Instrument Height: ‘1.700 ‘
|
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5. Select Station
Point, and tap the
next Wizard step.

+ 0.000
v -1.200

=

I Alternatively, tap QR-Scan to scan point information.
To be able to use the QR-Scan function your entitlement needs to
include the QR-Code Reader QR Code Reader licence.
For further information refer to: Importing data using QR-Scan step-

by-step
6. Aim telescope in the '
required direction, DRI
and enter a Bearing. Stonisy
Selected Station: 1
Tap v to accept. Bearing

Aim at point and enter new bearing:

Bearing 144.000 ‘

4.6

General description

PO Station
(sought)
\ P1... Known
Y points,
with prism
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Given:

«  Control points are active within the current job. Refer to Control Points.

«  For the automated robotic version, at least three control points with prism
available on site. Prism type and prism height set for each of these control
points using Point List functionality.

« Instrument positioned anywhere on site.

e For the manual approach with iCB and iCR instruments, control points with
prism type have to be in the point list. These points can have all prism
type, including tape or reflectroless.

Setup using Setup i When using Setup Pilot it is not necessary to select points on
Pilot step-by-step the screen but simply measure at least three control points (fixed
prisms) in the field. The position of the station is automatically cal-
culated.
1. Select Setup from the Home Menu.

Ik
2. Select Setup Pilot.
For an overview of available setup methods refer to Setup Methods.

i :
then tap the next
Wizard step m to M

proceed.

4

Compensator

o0

(>

4. Enter a Station Name (iCON site/iCON build Plus only).
Enter Instrument Height.
The Create Ctrl. Station Point tick box allows to define the station
as control station point. In that case it's also possible to assign a
code to that station point.

= If you want to check the Total Station setup periodically
activate the option using the Prompt for Setup Checks
tick box and set the Check time (Hours): as required.
According to the time set you will be reminded repeatedly
to check the setup.

n Setupnsrament n

Instrument Settings

Instrument Height: 1550

Create Ctrl. Station Point

Code

Reflector Settings

Reflector Height: 1500

Height check for station

With Height: v

<
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5. Proceed to the next
Wizard step.

Tap Start Pilot or aim to a control point
and tap on Meas+Rec. You need at least 3
points.

e For the automated Setup Pilot with a robotic total station, tap
Start Pilot. The instrument starts a PowerSearch. It is possible
to Pause the search at any stage.

e For the manual use with manual or robotic total stations, press
Meas+Rec after aiming the first point.

6. When the calculated
station is within
tolerance a corres-
ponding information A <=

Calculated station within tolerance.
Measure additional points or accept the )
station.

Measure Control

is displayed. Tap v G
to accept station = "ata
position. ®

P
= When at least three Deselect backsigh o
pom‘ts have been exclude from calculation
measured and Cal— Point ID Plane Residuals Height Residuals
- v =
culated, the Resid- — —
uals screen can Prism info Le\caRound ‘m
be accessed by v =
tapp“']g Prism info ‘m
L= r -
where inaccurate v @
measurements can Prism info ‘m
be removed. Tap v
to accept.
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4.7 Transfer Elevation to Instrument Placed over Height

Benchmark
General description
hi Instrument
height
006735 001 PO Benchmark
Given:

« Instrument placed over benchmark with given elevation.

Transfer elevation 1. Select Setup from the Home Menu.

to instrument placed I%
over height bench- I

mark step-by-step 2. Select Heights - Over reference point.

For an overview of available setup methods refer to Setup Methods.

e e
then tap the next
Wizard step D to Z

proceed.

%

Compensator

4. Enter Instrument >
Height. DU

Ta p J tO CO nﬁ Fm . Instrument Height: ‘14700 ‘
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5. In the next Wizard
step, either select
the relevant point
from the map, or

New station height is 44.930 )

directly enter the - . &
height of the bench- & o
mark. "4

a a Meas+Rec QR-Scan

43230 |

e
OEIESEET

I Alternatively, tap QR-Scan to scan point information.
To be able to use the QR-Scan function your entitlement needs to
include the QR-Code Reader licence.
For further information refer to: Importing data using QR-Scan step-
by-step

Tap ¢ 1o confirm. The new station height is set.
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5

How to Setup a GPS Base Station @3

5.1

Control Points

Adding control points
to a job

For some setup procedures, control points need to be available in the current
job. There are different ways to add control points to a job.

Importing control You can import a list of control points. Refer to
points Importing data to the project step-by-step.

= When importing TPS control points,
information on prism type and height is
only imported for file types *.geo and
* xml. After importing the control points,
add missing information using the toolbox
function Edit in the point list. Refer to
2.5 Point List, Searching for a Point.

Defining new When creating new points in the point list, you can
points as control define them as control points. Refer to 2.5 Point
points List, Searching for a Point (Toolbox function New).

= After creating a TPS control point, add the
information about prism type and height
using the toolbox function Edit.

Turning existing «  Open the point list and select an existing meas-
measured points ured point.
into control points « Use the toolbox function Edit to turn the point
into a control point.
«  For TPS points define prism type and height and
the coordinates of the new control point.
Refer to 2.5 Point List, Searching for a Point
(Toolbox function Edit).

Defining measured In the Measure application, activate the toolbox
points as control function Control Point to define measured points
points as control points.
+ To measure and store a control point, press
Start. All measured points are stored as control
points.
«  For TPS points select the correct prism type and
height (refer to 1.3.1 Prism Types and Prism
Heights ).
= The information about the currently selec-
ted prism type and height is stored
together with the measured control point.
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Creating control Create a single control point

points in the Draw/ -+ Select the toolbox function New Point.
Sketching applica- + Enter the coordinates for the new point.
tion .

Tap =Y to activate the Control Point function
or select Control Point in the toolbox.

Tap ¥ to create the control point.

Create several control points along a line

«  Select the toolbox function Start Point.

«  Define direction of the line, distance from the
start point and height.

«  Select Control Point in the toolbox.

Tap m and enter the desired number to cre-
ate several control points along a line.

Tap ¥ to create the control points.

Information about prism type and prism height for TPS points

The information about prism type and height of a control point only needs to

be defined once. There are two possibilities to define this information:

«  Define this information directly after adding control points to a job by
using one of the previously described methods.

«  Define this information when using a setup procedure with coordinates
for the first time:
Before measuring an existing control point, select the correct prism type
and height. The information about the currently selected prism type and
height is stored together with the measured control point.

The next time you start a setup procedure, this information is auto-
matically set for each control point. You can directly select and meas-
ure the control points for setup.

5.2 GPS Base Station Setup over Known Point [3

General description = iCON iCG60 and iCON iCG70 require a licence to use this application.

PO Known
006772.001 point
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GPS Base Station
setup over known
point step-by-step

Given:
Control points in the chosen coordinate system are active within the cur-

rent job. Refer to 5.1 Control Points.

Instrument is set up with a Base profile. Refer to 1.5.2 Setting up a
GPS Profile for iCON iCG30/iCON iCG70 or 1.5.5 GPS Profile Setup for

iCON iCG60 and Other Antenna Models .

A coordinate system is loaded to the project. Refer to Importing data to

the project step-by-step.
Coordinates must be available in WGS84.

ively, tap Get Nearest to display the closest
points to the current antenna position. If
there is only one point available, it is auto-
matically selected.

1. Select Base Setup from the Home Menu. T
XYZ
2. Select Known Point - Choose from map. e T——
O 1510 —
Py
X
Choose from map
~ NewPoint
PN | PN
A3
Input Coordinates Measure Anywhere
3. Tap a point in the Map screen. Alternat- 89152000 |

Choose base setup point

A
O 27 2
A A

How to Setup a GPS Base Station [3

4. . o
When the required point is selected, tap & e st et
to accept_ or choose another point
A
o 32A 17A19A
Hniﬁﬂ
&S Get Nearest ’T
|
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5. The Station Details can then be reviewed

and edited. Once ¥ is pressed, the GPS
Base Station starts transmitting corrections.

Station Details

Antenna Height 2.000
Off

Vertical »

Quick Snap:

Measurement Method
Point Details

Point No. 26

E |3890.210
N |60260.140
H 44,650

&3 Map g

53 GPS Base Station Setup over New Point [@3

General description = iCON iCG60 and iCON iCG70 require a licence to use this application.

PO Station
(sought)

006772.001

Given:

« Instrument is set up with a Base profile. Refer to 1.5.2 Setting up a
GPS Profile for iCON iCG30/iCON iCG70 or 1.5.5 GPS Profile Setup for
iCON iCG60 and Other Antenna Models .

« A coordinate system is loaded to the project. Refer to Importing data to
the project step-by-step.

= Two possibilities available: Input Coordinates or Measure Any-
where.

GPS Base Station

) Input Coordinates:
setup over new point

1. Select Base Setup from the Home Menu. T
XYZ
2. Select New Point - Input Coordinates.
P [« vone T
—— T —

3

Choose from map

I

3

Input Coordinates Measure Anywhere
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3. Enter the antenna and point information

Station Details
in the Station Details screen, tap v to [ aema ]
accept. Antenna Height @
Quick Snap: | off |
Measurement Method Vertical »
Pontho. |
N oo a0 |
H —
(X wap |

= once ¥ is pressed, the GPS Base starts transmitting corrections.

Or alternatively, Measure Anywhere:
1. Select Base Setup from the Home Menu. T
XYZ

GPS Base Setup

2. From the GPS Base Setup Menu, select e ]
New Point - Measure Anywhere. —

~ Known Point

O
X

Choose from map
S Y
| W
x

Input Coordinates Measure Anywhere

3. Centre the antenna over the base point, and L] SPT200 | g
tap Measure. At e s

4, The Station Details screen is displayed.
Station Details
Check the information, and tap 4 to
accept Antenna Height 2.000
Quick Snap: off
Measurement Method Vertical »
N [T
3 Map 4
|
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= once ¥ is pressed, the GPS Base starts transmitting corrections.
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6

How to Create a New Coordinate System @3

6.1

Coordinate Systems [@3

General description

6.1.1

Measure points with known coordinates to create a coordinate system for use
in either a Small Area (< 10 km?2) or a Large Area.

Measure Anywhere

Small Area

From file

Measure Anywhere

Coordinate System

i =4 --'

From file

Measure Anywhere

Control Line

=

Measure Anywhere

[ Heohs ]
—'71
I

Transfer Height

Preconditions:

Control coordinates are
available within the cur-
rent job. Refer to
Importing data to the
project step-by-step.
Instrument is set up with
a Rover profile and has a
GNSS-fixed position.
Refer to 1.5.2 Setting
up a GPS Profile for

iCON iCG30/iCON iCG70
or 1.5.5 GPS Profile
Setup for iCON iCG60
and Other Antenna Mod-
els .

For iCON site, iCON site Plus, iCON build Plus you can, instead of measur-
ing points, import control points From file.

GNSS coordinates will be imported together with control coordinates for a

given set of points.

Precondition is that Localization from File is set to be active in the User
Permissions. See also: User Permissions

Create Coordinate System by measuring points

Create a new
Coordinate System
step-by-step

1. Select Coordinate System from the Home
Menu. @
2. From the Coordin-

ate System Menu,
go to Small Area
and tap on Measure

Coordinate System

Anywhere.
Measure Anywhere From file Measure Anywhere From file
T TE—
i | P g
@ I
Measure Anywhere Transfer Height
—

How to Create a New Coordinate System [@3



I For Large Area
the workflow is the

Pre-defined coordinate system

same, except that EE—
for Large Area a Irish TM N. Ireland.lok
predeﬁned Coordln_ Irish TM N. Ireland_15.lok

ate S\/Stem must be Irish TM Rep. Ireland.lok
Selected B Irish TM Rep. Ireland_15.lok

Northern Ireland 1975.lok

OSTN_OSGM_02_GB.lok

0STN NSGM 15 GR Ink

3. Select the first point,
then press Meas-
ure. Repeat for fur-
ther points.

I Define Measure Mode in the Status 1 menu. According to the
setting selected, the measure key may differ from the description
within this guide.

4. Tap in the Map screen to view residuals for each measured
point.
Select/deselect point to be used in calculation
v
IR
‘
s
Scale factor @ 1.0000000
Use Heights
i Tap to deselect a point.
- Heights can be turned On and Off altogether.
- Tap on individual Plane Residuals or Height Residuals to deselect
single values.
- For a Small Area the scale can be set/locked to 1.000.
5. Tap Map at the bottom of the screen to return to the Map screen.

In the Map screen tap ¥ 1o save changes and create the Coordin-
ate System.

= Itis possible to cancel and store an unfinished localisation. In this
case the unfinished localisation can be resumed the next time the
Coordinate System application is started.
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Confirm or enter a
new name for the

Save

e
*.lok file and tap v CiBuidAg 1212..A50I/C
to save the file. [ e ]
‘CO,SVSJ\SCILZUZ’I 1107_202025 ‘ ok

6.1.2 Create Coordinate System from imported Control File

General description

=

¥

The Control file needs to be of format *.txt or *.csv.

Precondition is that the file contains coordinate information for each
point on Easting, Northing, Height (Control Coordinates in local sys-
tem) as well as Latitude, Longitude, Ellipsoidal Height (WGS84). Points

without WGS84 information are imported but cannot be used for

* lok file creation.

Example of *.csv file:

A

E C D E F G

[ Point ID

Easting Northing Height Latitude Longitude Ell.H
2764562.866 1253174.252 404.405 47.24316926 9.370915731 451.129
2764593.575 1253155.138 404.464 47.24310464 9.371059658 451.188
2764611.953 1253154.016  404.394 47.24309935 9.371147132 451.118
2764640.082 1253168.945 404.581 47.24314514 9.37128323 451.306
2764641.509 1253161.247 404.59 47.24312009 95.371285009 451.314

Select Import & Delete from the Home

IE'H
Menu. ‘]
All data that is
Imported Data
already loaded to
the active project is
HBG Plane drawing.geo HBG Parking North.lok .
displayed.
HBG outside control.geo

DefaultCodelist.xml

Background Image ~

3423-5301_201308.jpg

HBG.jpg

Tap 0 to import more data.

For general information on how to import data step-by-step see:

Importing data to the project step-by-step

1
2 1
3 2
4 3
5 4
6 5
7
Import Control file 1.
step-by-step
2.
=
3.

Select the type of data to import. Tap Control.
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Reference Data

Road Data

Control

Coordinate System

Code List

All files that are
available for import
are displayed on the
right side.

Import Data

E - "

[ internal Memory
LINES ARCS.geo
control points.csv >

B3 Projects Internal Memory

Tap .

next to the file to be imported.

The Import Settings View is displayed.

Define the content
of each column

by tapping the but-
tons. Ensure that

Import Settings View

1 2764539.284 | 1253218.791 420

Easting, Northing Elc=Es
and Height as well [ e [ e [ e ]
as Latitude, Longit-
ude and Ellipsoidal Field Separator ;(Semicolon) »
Height are assigned Distance Unit Veter »

CorreCtI\/ to the rel_ Latitude, Longitude Units
evant columns.

Deg Min Sec (DD.MMSSSSS) »

i The display jumps from one column to the next. The buttons turn
grey and cannot be used a second time.

= Tap to erase your selection.

Tap to undo your last action.

6. Adapt the unit setting for latitude and longitude to the unit used in
the file.

= Only 'Degrees Minutes Seconds' (DD.MMSSSSSS) or
Decimal Degrees are supported.
/- When all columns are defined tap v
8.

Back in the Import Data page tap v again to complete the data
import.

Inspect imported file 1 imported file can be inspected before using it for coordinate system cre-

ation.

1. Select Point List from the Map handler.
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Prof O Y8 ASCH A list of available
Job: Defaul .
i files is opened.

All

control points.csv

Default

@ @)
N N

Tap the imported file in order to select it. The tap 4 .

The Point List is dis-

played for the selec-

< Point ID v/ Easting Northing |  Height | ) |
N ted file.

2764539.284 1253218.791 420000 ¢
A 2 2764658.471 ‘ 1253228.835 420.000 ¢
A 3 2764723.756 ‘ 1253144132 420.000 ¢
A 4 2764509.822 ‘ 1253091.904 420.000 ¢
A 5 2764649.197 ‘ 1253139.495 420150 &
VAN 6 2764477.012 ‘ 1253163.550 420.000 ¢

3. Tap and hold one of the column headers, for example Northing.

The Point List Config-

Point List Configuration Columns Configuration 3 ) 3

uration page is dis-

Block 1 TR
[—— played.
B [ o | o [ e |
Code Pole Height  Prism Type
S S S
=R
T T
&3 ) &
4. Define one block to show Latitude and Longitude. Select None for

the third column.
Define the Ellipsoidal Height in an extra block to prevent the Latit-
ude/Longitude values from being cut off.

When all blocks are defined tap v

i For further information on how to use and configure point lists see:
How to use Point List step-by-step

Create Coordinate 1. Select Coordinate System from the Home
System from File Menu. @
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2. From the Coordin-
ate System Menu, =
go to Small Area
and tap on From

Coordinate System

Measure Anywhere From file Measure Anywhere From file
i =
@ E -
Measure Anywhere Transfer Height

T ey T T
file and tap the yel- gpoints
low button in the [ cowa ]
top right corner. O Catees

)
<

T e N )
same, except that ErCethed Coaria st
fo r La rge Area a control points.geo Irish TM N. Ireland.lok
predefined coordin- Iish TM N. Ireland_15.Jok
ate system must be Iish TM Rep. Irland.Jok
SeleCted - Irish TM Rep. Ireland_15.lok
Northern Ireland 1975.lok
OSTN_OSGM_02_GB.lok
&8

The Map screen

is then displayed
showing the points
that shall be used
for the transforma-
tion.

Inspect the transformation or tap accept
to finialise

4. Tap to view residuals for each measured point.
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point to be used in
Point ID Plane

Height
Residuals

Residuals
l\/l 1 @ 0.022 @ 0.01

;
:
v
Scale factor 1.0 @ 1.0000000

Use Heights

) Tap to deselect a point.

- Heights can be turned On and Off altogether.

- Tap on individual Plane Residuals or Height Residuals to deselect
single values.

- For a Small Area the scale can be set/locked to 1.000.

5. Tap Map at the bottom of the screen to return to the Map screen.

In the Map screen tap ¥ 1o save changes and create the Coordin-
ate System.

i Itis possible to cancel and store an unfinished localisation. In this
case the unfinished localisation can be resumed the next time the
Coordinate System application is started.

7. Confirm or enter a o
new name for the
[ e ]
*.|Ok ﬂle and tap J C:/BuildAg 1212..ASCII/C
to save the file. [ saweas ]

‘CO_SYS,ASCII_ZON 1107202025 ‘ ok

6.2

General description

P1 Start point

P2 Direction
point

a Control
line

\‘ (sought)
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Given:

« Instrument is set up with a Rover profile and has a Fixed position.
Refer to 1.5.2 Setting up a GPS Profile for iCON iCG30/iCON iCG70 or
1.5.5 GPS Profile Setup for iCON iCG60 and Other Antenna Models .

How to define a con- 1. Select Coordinate System from the Home
trol line using GPS Menu. @
step-by-step

2. - From the Coordinate System Menu, select Control Line.
Position the antenna, and press Average to record the first

point.

(] comtrae

E T Eag

Transfer Height

i Define Measure Mode in the Status 1 menu. According to the
setting selected, the measure key may differ from the description

within this guide.
3. - Move antenna to second point of the control line. Press Aver-
age.

Measure Anywhere

The control line is now defined. Tap ¢ +to confirm.

ontrol line defined.
Origin and orientation will be set. Accept or

R 3 shift &
4. - To Shift the origin of the control line, press Shift.
- Enter shift values in the Toolbar. To measure a Shift, press

Measure.
- Position the antenna, and press Average. The origin of the con-

trol line is shifted to the new point. Tap ¥ to confirm the shift.

152 How to Create a New Coordinate System [@3



Control line defined.
Origin and orientation will be set. Accept or

Control line defined.
Origin and orientation will be set. Accept or

Shift.

shift ) P ncosurc [ % s | )

6.3 How To use GPS Height Transfer @3

General description Given:
e Instrument is set up with a Rover profile and has a Fixed position.
Refer to 1.5.2 Setting up a GPS Profile for iCON iCG30/iCON iCG70 or
1.5.5 GPS Profile Setup for iCON iCG60 and Other Antenna Models .

Height Transfer enables to simply define a local height system

=
and consider the local height to all points measured afterwards.
GPS height transfer 1. Select Coordinate System from the Home
step-by-step Menu. @
2. - From the Coordinate System Menu, select Height Transfer.
- Select a coordinate system, either from the project or a pre-
defined one. Tap v 1o accept.
= If @ coordinate system is already present in the current
project, that step is skipped.
m Coordinate System Pre-defined coordinate system
i argeArea — Pre-defined coordinate systems
: ] Test.lok
[ e ]
i U
L
3. - Select an existing point, either from the map or the Point List, to

get the height from or input height value directly.

Tap v to accept the local reference height or measure further
points.

How to Create a New Coordinate System [@3 153



Calculated height is 401.200 Meter
Select and measure next
point or press accept

Calculated height is 401.200 Meter
Select and measure next
point or press accept

Average Average
a ] [z ] B |

[ ] & K3 o) &)

i Define Measure Mode in the Status 1 menu. According to the
setting selected, the measure key may differ from the description
within this guide.

4. - When at least two points have been measured, the Residuals

screen can be accessed by tapping , where inaccurate
measurements can be removed.

- To finish the localisation tap OK in the Confirmation screen.
Then save the new Coordinate System, either with the proposed

name or a user defined one, by tapping v
- Confirm the next information screen. From now on all points
measured will have the reference height applied.

Select/deselect point to be used in calculation Save

Calculated height is 401.200 Meter

Height ) N point or press accept
Point ID C:/BuildAgent/wo...oordinateSystems

1
v
o2 = [ owol

Point ID 2 [Test-new—heighl ‘,Iok
@401.200 I~ @ 0,000
~—— Point ID 3
M gow =g o
Point ID 4
@401.200 2z M\

&

% Map

== When more than one point has been measured to define the local
reference height, a best fit solution will be applied and used as the
height difference. This means that the local reference height is bal-
anced from the measured heights and the height difference equals
the height of the newly measured point minus the local balanced
reference height.
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7 How to Measure and Record Data g@ +E3

7.1 General Information + [
General description Measure is an application that records and displays point and line information

obtained using the connected Total Station or GPS instrument.

Points, lines and arcs can be measured, recorded and displayed within the
Map screen. Descriptions, codes, and IDs can be assigned to each element. All
element information can later be exported to office software.

All measurements are performed using the Measure
bar, which can be configured to display the com-
mands you require. Refer to Measure bar for more
information.

(&5 0.000

Measure Store Code

R~ N—r—
Commands can also be placed in the Favourites key. Refer to Measure bar
(Information about Favourites menu configuration) for more information.

Information preview

. When you measure single points, a preview window pops up showing the
for points

values to be stored for the measured point, for example Point ID, coordinates,
assigned code and attributes.

= By default, the preview window for measured points is disabled.
To enable the preview, tap System in the Home screen, select Dis-
play and set the option Information preview for points to On.

Depending on the connected device and the currently used application, more
values are given on the right side of the preview window.

= The preview window is not available in Sketch (Draw) application.

Example for a point measured with TPS

Point to be stored

Point ID 1 Pole Height |2.000 |
Easting 50.000 Prism Type Leica Round )
Northing 38.000
Height 4,000
Create Control Point [:
Code/Layer
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e If necessary, you can edit the point values in the preview window before
storing the point.
For example, change the point ID or assign a code.

e To store the point and return to map view, tap «.

« To return to map view without storing the point, tap .

7.2 Measuring and Recording Points, Lines and Curves + @3

General description

PO Known

station
Pl... Target
Given:
e Instrument is connected and set up.
= Note that main workflow refers to Total Station. For GPS press

Measure to record a point.

Measu.ring ar_ld Measuring and recording points
recording points,
lines and curves step- 1. Select Measure from the Home Menu. o
by-step I
@ #5000 Map screen is dis-
played.
Measure m PointID !
|
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2. Sight target and press Measure.

[&)%5,0.000

2.000

3. After measuring, press Store to store the 600 || @ oo
point. Measure and store as many points as o 9/n 2.000
required. e| -12.071|~] 2.071

A G
6“1
@, @

= To store points immediately after measuring, configure the Measure
bar to contain the Meas+Rec key.

i Define Measure Mode in the Measure bar configuration.

I Itis also possible to use existing points to create lines and arcs.

Measuring and recording lines
1. To create lines between points, tap and hold the Measure bar.

Configure to display the Start Line function. Tap v to accept.

i
S (&) %4 0.000 Measure bar configuration

ol « 2000} NN
B TR
. Store
Ao

Measure Store Point ID

2. Press Start Line. Measure and store points. A line is drawn between
the points.
To disable the line function, tap Stop Line in the Measure bar.
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=0 (®) %5 0.000
9+ 2000
e -12.071 v 2.071

O+
o

@ @9 o g @
(OO

Measure Store Start Line Measure Store Stop Line

&

E

i Itis also possible to use existing points to create lines and arcs.

Measuring and recording arcs

1. To create arcs from three points, select
Measure Arc from the Toolbox.

[£)%40.000

Measure and store three points.
When the third point is stored, the arc is created.

Meas+Rec| PointID | Stop Arc Measure m Start Line

I Itis also possible to use existing points to create lines and arcs.

7.3 Measuring Sets of Angles
General description The Sets of Angles tool allows you to measure up to ten sets of points; within

each set, you can measure several foresight points using one of the following
measurement methods.

Measurement Measuring sequence
method
B1-F1-F2-B2 All points are measured in face |, then measured in

face Il in reverse sequential order.
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Measurement Measuring sequence

method

B1-F1-B2-F2 All points are measured in face |, then measured in
face Il.

B1-B2-F2-F1 Backsight point is measured in face | immediately
followed by face Il. Other points are measured in
alternating face order.

B1-B2-F1-F2 Backsight point is measured in face | immediately

followed by face Il. Other points are measured in
face |, face Il order.

16238 001

PO Known station P3 Foresight point
P1 Foresight point P4 Foresight point
P2 Foresight point BS Backsight point
Given:
« Instrument is connected and set up.
= iCON site requires an additional license to use this application.
Measuring sets of 1. Select Measure from the Home Menu. _—
angles step-by-step Map screen is displayed. .
2. Select Sets of Angles from the toolbox.
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The Sets of angles settings screen is displayed.

Sets of angles settings

Method B1-F1-F2-B2 )

Sets 2)

3. +  To define another method, tap Method.
« To define the number of sets, tap Sets.

Tap v to accept.

4. Map screen is displayed.
Select a backsight point and measure it. Follow the instructions on

this screen.
Measure the backsight point or select a
different one

[\@

=
EICIENET

Measure new foresight point in face 1.

e

Measure  Point ID

6. An information message is displayed, allowing you to add more
foresight points to the set.
« To add another foresight point, tap OK.
« To start the measurement process, tap Define Set.
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7. Working with a manual total station:
Turn the instrument to sight the defined points in the desired face
and trigger the measurement manually. Follow the instructions on
this screen.
Working with a robotic total station:
The instrument automatically turns to the defined points and meas-
ures them. A progress bar is displayed during the measurement pro-
cess.

= If Prism Type is set to "reflectorless” or "tape”, or if
Measure Mode is set to "Single Manual”, you must fine
aim and trigger the measurement manually.

Set 1: measurement of backsight point 1
in face 2 in progress...

IEIENENET

&
8. As soon as the measurement process is finished, the residuals for
each measured point are displayed.
T Inaccurate measurements cannot be stored. Remove
points with inaccurate measurements.
= If necessary, you can change the prism type and height for
each point.
«  Deactivate a checkbox to remove a point with inaccurate meas-
urements.
e To return to map screen without saving any measurements,
tap 4 .
Tap ¢ to store the measurements and return to the map
screen.
Point ID Plane Residuals Height Residuals
v o
Prismnto o000
;
oo
.
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7.4

How to Store Points Automatically +[T3

=
How to store points

automatically step-
by-step

162

This feature is available when using a Robotic Total Station or GPS instrument.

1. - In Measure, select Automatic Logging from the Toolbox.
- In the Automatic Logging screen, set Autologging to On.
Select the Logging Mode from 3D Distance, Distance and/or
Height, Time, or Time over a point and define the Interval.
Store on demand allows to record measurements anywhere in

between, if enabled. Tap v to accept.
- Press Start in the Measure bar.

=
Automatic Logging - [&)%40.000

Autologging m
Store on demand Off

Logging Mode 3D Distance »

3D Distance 1.000

fomati i Close Lir \\\
A 9 ﬁ‘ﬁ
Delete Start Start Line | Point ID

2. - As the target position moves, points are automatically stored at
the defined time/distance interval. Press Pause to temporarily
stop storing points.

- To turn off automatic logging, set the mode to Off in the Auto-
matic Logging screen.

Automatic Logging

Autologging Off
Store on demand Off

Logging Mode 3D Distance »

3D Distance 1.000

3
&
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7.5 Point IDs and Codes +[@3

7.5.1 Applying Point IDs to Measurements +[@3

General description

PO Known

station
006774001 P 1 e Ta rget
Given:
e Instrument is connected and set up.
Apply point IDs to 1. - To activate the Point ID function, tap and hold the Measure
measurements step- bar.
by-step - Configure to display Point ID. Tap ¢ to accept.

Measure bar configuration

[ [ e o]
e [
ES T
ey
N | 7
Measure m Start Line Measure Store Point ID
L

i Itis possible to add Point ID and other commands to the Favourites
menu in the function bar. Tap and hold the specific key while in the
Measure bar configuration screen.

2. - Tap Point ID to edit ID for the next point.
- Enter the desired Point ID. When finished, tap « to accept.
The next stored point takes the defined Point ID. Further
Point IDs will follow-on numerically.

Point ID
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= To recall this function automatically for every measured/stored
point, tap the Always Prompt checkbox.

7.5.2 Defining Code for Each Stored Point + €3

Defining a C°d€‘_ for 1. To define a code for specific points, configure the Measure bar to
each stored point display Code. Tap and hold the Measure bar.

using the code list Select Code from the Measure bar configuration screen, and

tap v to accept.

Measure bar configuration

-
I e

Code Code
Start Line Start Line Start Line
Attributes

Measure Store Code

3 e v

2. Tap Code in the Measure bar.
Use Compact view from the Toolbox to toggle between the full and
the compact code list view.

[&)%50.000

Select c...finition

Code

© No Codes

© Gate )
@ Path )

© Corner )

Code Definition Tools

3. Select a predefined code from the list. OR:

Define a new code. Select New from the Toolbox. Define a new

code in the text entry field. Tap ' when
finished. New codes are stored in the code
list. Now select the code.

Edit an existing Select Edit from the Toolbox. Select the
code. code to edit and tap v 1o accept. Edit the

code as desired and tap v 1o accept. Now
select the code.

Search for an exist- Select Search from the Toolbox. Enter the
ing code. code to search for or a part of it in the text

entry field and tap v 1o accept. Now select
the code.
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Defining a code for
each stored point
using Free Codes

Search for an exist- Select Search from the Toolbox and tap

ing code description.  on the Description button in the top left
corner. In the text entry field, enter the code
description or a part of the code description

and tap v 1o accept. Now select the code.

(®) %5 0.000 The code key in

the Measure bar dis-
plays the selected
code. The selected
code is assigned to
any points that are
stored.

Measure m FENCE

To change the active code, tap the Code key, and select another
code.

To automatically recall this function for every measured/stored
point, select Always Prompt from the Toolbox.

To delete an existing code select Delete from the Toolbox. Select

the code to delete and tap v 1o accept.

The code assigned to points stored allows layer management. For
example it's possible to turn a code layer on or off in the Map View
manager for the active job, so that only points with a specific code
applied are displayed.

Refer to Importing data to the project step-by-step for information
about loading pre-defined Code Lists.

1.

Tap Start in the

Measure bar. Then,
before storing the -
point, tap Code.

1 -1.700

N 5301102.582

-19844.887

i
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2. Select Free Code. s

Select Code

Codes of Group All

© No Codes

© Free Code

3. Back in the Map View tap Store.

Free Code Name
page is displayed
and a keyboard is
shown.

Free Code Name

EBC) o 2+ 3.400 The pomt_ will be
A = E -19807.786] N 5301083.943 Stored Wlth the
€ = Free Code entered code.
L oo
C

When you tap Store to measure the next point you can again enter
a code name, confirm, and the point will be stored with the given
code name.

= Free Codes will also be added to the code list.

Adding codes to the

: If imported files contain points with codes that differ from the codes in the
code list

currently used code list, it is possible to add these codes to the code list.

1. To display the code list view, tap Code in the Measure bar. If neces-
sary, configure the Measure bar to display Code. Refer to Defining
a code for each stored point using the code list.

i Use Compact view from the Toolbox to toggle between the full and
the compact code list view.
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2. Select Read from files from the toolbox.

By

\&/

The codes from all imported files are added to the code list.

Sort order in the code . To display the code list view, tap Code in the Measure bar. If neces-
list view sary, configure the Measure bar to display Code. Refer to Defining
a code for each stored point using the code list.

I Use Compact view from the Toolbox to toggle between the full and
the compact code list view.

2. Select Sorting order from the toolbox.

3. Define the sort order of the existing codes:

« As imported/created:
Codes are sorted according to the order they were imported or
created.

+ Last used on top:
Codes are sorted according to their frequency of use. The code
used last is displayed first.

- Alphabetical:
Codes are sorted alphabetically.

Tap v to accept.
The codes are displayed according to the selected sort order.

Define point symbols
for codes step-by-
step

When assigning codes to stored points, it is possible to change the point
symbols in the map view depending on the assigned code. In addition to the
default point symbol, you can choose between nine different shapes, each
available in ten colours.

Using different symbols for different codes helps you to distinguish easily
between different point groups in the map view.

1. To display the codelist view, tap Code in the Measure bar. If neces-
sary, configure the Measure bar to display Code. Refer to 7.5.2
Defining Code for Each Stored Point .

m Select Code
© No Codes
SR Tree )
< Gas )
[l Road )
V Cable )
4F Parking )
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= Defining or changing a code symbol is only possible in the full codel-
ist view. If necessary, deactivate Compact view in the Toolbox.

2. To change the point symbol, define a new code or edit an existing
code:
« To define a new code with a new point symbol, select New from
the Toolbox.

To change the point symbol of an existing code, tap » .

3. Tap the desired point symbol. Tap ¢ to accept.

Edit code

Name l Parking ‘

Description

Attribute Names >

© Default symbol

In the codelist view, the point symbol of the code is
updated according to the selected symbol.

4. Select a code from the list.
The map view is displayed. The code key in the Measure bar displays
the selected code. The selected code and its symbol are assigned to
any points that are stored.
51] « I
N )

[ \ Start Code
AT N
Gas || | \
cable | | -
ronkameranil KK

I To change the active code, tap the Code key, and select another
code.

I The code assigned to points stored allows layer management. For
example, it is possible to turn a code layer on or off in the Map View
manager for the active job, so that only points with a specific code
applied are displayed.

= Refer to Importing data to the project step-by-step for information
about loading pre-defined codelists.
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= The point symbols are also displayed in the Point List and the
Stakeout Point List.

7.5.3 Defining Attributes for a Code + €3
User-defined code For each code, you can add up to ten user-defined attributes in one of the
attributes following formats:
« Text
Input is treated as plain text.
e Value
Input is restricted to numerical values.
- List

Allows you to define a pick list with as many list items as necessary.

Example

To enhance the code "Tree" in a feature survey, you could define the attribute
"Species" as pick list, the attributes "Height", "Spread" and "Trunk diameter" in
numerical format and the attribute "Tree tags" in text format.

How to edit code = You can edit the code attributes by editing an existing code or when
attributes step-by- defining a new code.
step Configure the Measure bar to display Code or Attributes. Refer to
Measure bar.
1. To display the codelist view, tap Code in the Meas-
ure bar.

= Alternatively, tap Attributes in the
Measure bar and tap the code name to
display the following screen:

m Select Code
© No Codes
88 Tree )
< Gas )
[ Road )
V Cable )
4 Parking )

- W

= Defining or changing the code attributes is only possible in the full
codelist view. If necessary, deactivate Compact view in the Toolbox.

2. To change the code attributes, define a new code or edit an existing
code:
« To define a new code, select New from the Toolbox.
« To edit an existing code, tap ) .
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The "Edit code" screen is displayed.

Edit code

Name ‘ Parking ‘

Description [ ‘

Attribute Names 4

® Default symbol

X & 8 & 8 & 8 &8 8 &
+ + + | P + %+ + |
| N BN BN REERE N RE BN R

3. To edit the code attributes, tap Attribute Names.
The "Create Attributes"” screen is displayed.

Create Attributes

Code Attributes

Attribute 1 ‘Species ‘ ‘/

Attribute 3 ‘Trunkdiameter ‘
" ~

Attribute 5 ‘ ‘ &

Attribute 6 \ |

Enter the name of an attribute and tap v 1o accept.

« By default, the attribute is in text format. Tap Text to change
the attribute format.

To clear the content of an attribute, tap .
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= If you tap List, the "Define List Entries" screen is
displayed.

Define List Entries

List Entries

Enter New ‘

|
Cherry ;\/;
@

To add a list entry, enter a name and tap v

To delete a list entry, tap x
« To sort list entries select an entry and tap the

P
arrows or to shift the list entry further

up or further down.
To save the list entries and return to the "Create

Attributes" screen, tap v

To save the code attributes, tap v

To save the code, tap v

= For information on how to assign attributes to measured points,
refer to How to assign code attributes step-by-step.

How to assign

code attributes step- . .
by-step = Configure the Measure bar to display Attributes. Refer to Measure

bar.

Assigning code attributes to points while measuring

1. Measure a point.
Before you store the point, tap Attributes in the Measure bar to
display the "Code Attributes" screen.

Code Attributes

Point ID ‘ 1 ‘ Tree tag ‘
Code

Always Prompt

2

Species 4

Height ‘ ‘

Trunk diameter ‘ ‘
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=

The attributes of the currently selected code are displayed within
the Attributes container. If no code is selected, the Attributes con-
tainer is not displayed.

Tap Code to select a code with different attributes or to define a
new code.

» To change an attribute in list format, tap the attribute name and
select an item from the list.

«  For attributes in text or numerical format, enter the desired
value.

If you activate the checkbox Always Prompt, the "Code Attributes"
screen is displayed each time a point is stored. Activate the checkbox
if you need to measure many detail points with attributes.

To save the code attributes, tap v

Assigning code attributes to points using the point list

1.
Select Point List from the Map handler.
2. A list of available files is opened.
Select the files you want the Point List to be created for. Multiple file
selection is possible.
3. Tap v 1o accept the selection and proceed to the Point List.
To select a point for editing, tap the respective row in the point list.
Tap W and select Edit .
The Edit Point screen is displayed.
= The attributes of the currently selected code are displayed. If no
code is selected, no attributes are displayed.
Tap Code to select a code with different attributes or to define a
new code.
6. « To change an attribute in list format, tap the attribute name and
select an item from the list.
«  For attributes in text or numerical format, enter the desired
value.
7. .
To save the code attributes, tap v
7.5.4 Quick Access to Codes + [
Turning on quick 1.
access to codes Tap to access View in the Map handler.
2.

-~
Tap to turn on quick access to codes.
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View Codes

Turn On/Off List

3.

© No Codes

© Free Code

8 Tree

O Gas

I Road » .

V' Cable iﬂs A
7.5.5 Codes and Lines I3 + €3
Line colouring In map view, lines or arcs can be displayed in different colours corresponding
depending on code to the colours of the used code symbols. Line colouring helps you to distin-
symbols guish between different lines in the map view.

) o "o
Fig. 1: Colouring of straight lines Fig. 2: Colouring of arcs

Application Draw

In following cases a line gets coloured:

°  Several points are created while the draw line function is enabled
and a code is applied. The colour of the created line corresponds to the
colour of the applied code symbol.

«  Two or more points are being connected by a line. Each line segment is
coloured according to the colour of the first segment point.

For polylines, the colour of the start point symbol is kept throughout the
whole line, even if the code symbol changes in between.

«  Two or three points are selected to create an arc. The arc line is coloured
according to the colour of the first selected point.

How to Measure and Record Data + @3 173



Application Measure

In following cases a line gets coloured:

e Several points are measured while the function Start Line is enabled and
a code is applied. The colour of the measured line corresponds to the
colour of the applied code symbol.

If the applied code is changed in between, the line colour changes accord-

ingly.
= For ponIine_s, the coIQur of the start point symbo_l is kept throughout
the whole line, even if the code symbol changes in between.

7.6 How to Shift Points

7.6.1 Shift Point

Description It is possible to shift the position of a measured point in all three dimen-
sions.

- Select Shift from the Toolbox.

Enter the Shift values in the displayed Toolbar. Tap v 1o accept.
- The next measured point has the defined shift applied to it.

876/ 1 0.000
2.800 v -4.400

= These shift values will not be applied to further measured points.
= Shift applies offsets in relation to the current Total Station orienta-
tion.
7.6.2 Measuring the Centre of Trees or Columns

General description

PO Known

station
P1 Target
P2 Centre
point
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Given:

e Instrument is connected and set up.
«  Map handler displays separate Measure and Store keys. Tap and hold
Measure bar to configure accordingly.

Measuring the centre 1. - Place prism next to tree or column, at the same distance as the
of trees or columns centre, as shown in the illustration before.
step-by-step - Sight prism and press Measure.

[&)10.000 =10 B 12151, -50.000
-0.009
-3.201

2. - Turn instrument and sight the centre of the tree or column.
- Press Store to store the point with the new angle.

(&7 5 -50.000 =2 i [&)%4)-50.000
0.114
-2.807

Measure Store Code Measure Store Code

7.7 How to Capture Images and Link Them to Points 3 + @3
General description The Camera function allows you to capture images using the integrated cam-

era of the controller. For documentation and reporting purposes, you can link
captured images to points.

How to access the Camera screen

i The Camera function is accessible from any measuring application
using the Measure bar. It is not available in TPS Setup, GNSS Base
Setup or when creating a Coordinate System.

1= You need to configure the Measure bar to display the Camera but-
ton.

i When using iCON site, the Camera button is available in the Favour-
ites menu by default.

1. To enable the Camera function, tap and hold the Measure bar.
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The Camera screen

176

2. Configure the Measure bar to display Camera. For a detailed instruc-
tion, refer to Measure bar.

Tap v 1o accept the settings and return to the map.

3. Tap Camera to access the Camera screen.

i>= For a detailed description of the Camera screen, refer to The Cam-
era screen.

Camera

Captured 1.20171203_120116891.jpg

- % [

+/ Link to point 7

D Always Prompt

Screen element Description
Back button Tap to return to the Map view.
Live container Live image of the camera.

Image container at the right  Preview of the last captured image.

= If there are no captured images
the preview is empty.

= To get an enlarged preview image,
tap the preview image.
The live image of the camera is
replaced by the enlarged preview
image.
To return to the live image, tap
either the enlarged or the small
preview image.

Options container with Link to point %1
checkboxes (Point number of last stored point is dis-
played.)

Activate the checkbox to link the captured

image to the last stored point. You can link
several images to the same point.

If there are no measurements in the active
job, the checkbox is not available.

Always Prompt

Activate the checkbox to display the Camera
screen automatically each time a point is
stored.

- Tap to adjust the camera settings. Refer to
Adjusting the camera settings.
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Adjusting the camera
settings

The Gallery screen

Screen element Description

Tap to view and manage all captured images.
Refer to The Gallery screen.

Tap to delete the last captured image.

Tap to capture an image.

B QEE

1. :

To display the Camera Settings screen, tap in the Camera

screen.

2. + Tap Device Name to toggle between front and back camera.

« Tap Resolution to set the image resolution.

- To activate geotagging, set Geotagging to On.

Geotagging requires a connection to a GPS sensor or the
internal GPS of the controller. When geotagging is enabled, the
GPS coordinates are stored to the captured image.

» To add drawings or text to an image directly after capturing,
activate the option Always edit the image after capture. By
default, this option is disabled.

3. Tap v 1o accept the settings and return to the Camera screen.
\ ® 2

1.201712..8831.jpg 1.201712..2078.jpg

1.201712..6891.jpg

E

1.2.2017..6791.jpg 1.201712..5879.jpg 1.201712..7430.jpg

1.201712..6981.jpg 1.201712..5065.jpg 1.201712..3128.jpg

J l

A *® L3 7]
Screen element Description
Camera button Tap to return to the Camera screen.

Captured Images container  List of captured images, displayed as thumb-
nails.
e Tap a thumbnail to select it and to dis-
play the points linked to it.
- Tap a second time to enlarge the image
preview.

Linked Points container List of points which are linked to the selec-
ted image.
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Filtering the list of

images/points

Linking images to

points

178

Screen element Description

Tap to define and apply a filter to the list
of images or linked points. Refer to Filtering
the list of images/points.

%
)4

Tap to delete the selected image.

Tap to link one or several points to the
selected image. Refer to Linking images to
points.

|

Tap to edit the selected image. Refer to Edit
images.

The Gallery Filter tool helps you to quickly find relevant images or points by
using different filter options. For example, you can sort or reduce the list of
images displayed in the Gallery.

1.

To display the Gallery Filter screen, tap ﬁ in the Gallery screen.

Define the necessary filter options:

«  Select the job that contains the relevant points for linking.

«  Define the sort order of the images based on the creation date:
ascending or descending.

«  Define the sort order of points available for linking: ascending or
descending.

«  To show a maximum of 50 images, activate the checkbox.

«  To show only images which are not linked to any points, activ-
ate the checkbox.

Tap v 1o accept the settings and return to the Gallery screen.

When you exit the Camera application, the filter options are reset
back to default values.

The images displayed in the Gallery screen can be linked to points of
the currently selected job. If necessary, change the filter options.
Refer to Filtering the list of images/points.

In the Gallery screen, tap the image.

The selected image is highlighted in yellow. If the image is already
linked to points, these points are listed in the Linked Points container.

Tap P to edit the links.
In the Linked Points container, all available points for linking are dis-
played. For already linked points, the respective checkbox is activated.
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Edit images

Link Image to Point(s)

1.20171203_115616783.jpg Linked Job Points

| I{ES

o

ESHIEN

w

|l

Link to control points

Activate the checkbox of a point to link it to the image.
Deactivate the checkbox of a point to unlink it from the image.

Linking an image to points from reference files is not possible.

Tap « to save the changes for the image.
Tap $ to discard any changes.

Images linked to points can be included in a report.

To include images, set Captured Images to On when configuring the
template of the respective report type. Refer to How to configure
the template of a report type.

You can add text and free-hand drawings to a captured image.
To edit images directly after capturing, activate the respective option
in the camera settings. Refer to Adjusting the camera settings.

In the Gallery screen, tap the image you want to edit.
The selected image is highlighted in yellow.

Tap @ to edit the selected image.

Following screen is displayed:

1.20171203_115512940.jpg

EEN
Edit Image

To add free-hand drawing to the image, select Pen
from the toolbox.

To add text to the image, select Text from the
toolbox.
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Example of edited image:

000001_20181023_143811656.jpg

il :

AT N
CONTROLP1 ™

3
S

To discard all changes, tap 5.
To discard all changes and return to the Gallery screen, tap ¥.
To save the changes for the image, tap «.

"8 height information at the current position.

7.8 Information Bar Values +[@3
Description Type/lcon Description
Id Point ID of the current point to record.
E H East value at the current target position.
N “ North value at the current target position.
H n Height at the current target position.
Hz only: Horizontal angle to the current target
E’ position.
v W only: Vertical/zenith angle to the current
1[:.»—- target position.
Code p— Code/layer for the next point to record.
sD , only: Slope distance to the last point meas-
A
& ured.
hD only: Horizontal distance to the last point
measured.
cQ1D . GPS] only: Coordinate quality value for the

180
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Type/lcon

Description

cQ 2D

GPS| only: Coordinate quality values for the plain
information at the current position.

cQ 3D i

GPS) only: Coordinate quality values for a com-

bination of the height and the plain information
at the current position.

cborp €3 only: Geometric dilution of precision quality
value at the current position.

Chainage Chainage at the measured point along the selec-
ted reference line.

Proj.Lin Line value at measured point along the selected
reference line.

Proj.Off Offset value at measured point to the selected
reference line.

Proj. H. Diff Height difference at measured point to the

selected reference line.
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8

How to Collect Data Using Scanning

8.1

General information

Scanning functional-
ity

Availability of scan-
ning methods

Definition of scan
area depending on
scan method

182

The Grid & Scan tool is available in the following applications:
«  As-Built/Measure
«  Layout Points/Layout Lines/Stakeout

e Slopes

«  Checks

« Volumes

«  Cut/Fill Grid
«  Verification
+ Roading

The Grid & Scan tool offers two scanning methods for creating point clouds.

Scan

This scanning method allows you to create large point clouds that can be used
for verification and inspection of as-built objects (refer to 13 How to Use
Verification ). Connect the iCON software to the MS60 to use it as a scanner.

Precise Grid Scan/Quick Grid Scan

These scanning methods allow you to create small point clouds that can be
used especially for verification and inspection of surfaces, such as floors or
walls (refer to 13 How to Use Verification ).

Connect the iCON software to an iCR or iCT. Define an area and a scan grid.
The software calculates the points to be measured.

When connected to an iCR or iCT, the software automatically lays out
the grid points, and measures and stores them after reaching the
tolerances.

Requirements

e« The Grid & Scan licence must be active.
e An MS60 scanner or an iCR/iCT device is connected to iCON.

Depending on which device is connected to the software, the availability of
scanning methods differs.

Scanning method iCR/ICT  MS60 MS60+
Rectangular Precise Grid ° ° °
Polygonal Precise Grid ° ° °
Polygonal Quick Grid ° ° °
Rectangular area ° °
Polygonal area ° °

Rectangular scan area

When using a scanning method based on a rectangular area, it is necessary to
define two points. The first point defines the start point of the baseline and
the second point defines the width of the scan area.
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4

P2 a Baseline

Polygonal scan area

When using a scanning method based on a polygonal area, it is necessary to
define at least three points. The first and second points define the baseline of
the polygonal scan area. The polygon is closed from the third point on, and
every new point creates another corner of the polygon.

P1

1-0 ®
A
N
(-]
()
©)
2 ®
¢ ®
LA S ®
PZ\ ()
© S o/
® a Baseline
8.2 How to Use the Grid Scan Functionality
Using Rectangular Preparation
Precise Grid an_d 1. Connect the instrument to the iCON field software.
Polygonal Precise _
Gridstep-by-step 2. Set up the instrument.
3. Go to the desired application in iCON.

Scanning process

1. In the current application, select Grid &
Scan from the toolbox.
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S, The screen "Scan/
= : Grid Definition" is
displayed.

Precise Grid Scan Definition Quick Grid Scan definition

Rectangular Precise Grid ~ Polygonal Precise Grid Polygonal Quick Grid

Tap the desired method to start the wizard for this method.

Level the instrument.

Tap next wizard step ¥ to proceed.
Map view is displayed.

4, Define the scan area depending on the selected method. Follow the
instructions on this screen.
« Rectangular Precise Grid
Select or measure two points to define the upper left and lower
right corner of the rectangular area.

To swap the orientation of the rectangular area, tap
+  Polygonal Precise Grid

Select or measure at least three points to define a polygonal

area.

To clear the defined scan area, tap .

Tap next wizard step Jf to proceed.

F@® =T The toolbar for grid

= Fgﬂ 1} -‘=J Ul[ . iti } '

definition is displayed
A=

in Map View.

9 @
Q 0]
@ O
Q (O g8 ] e 14.208
@ @ .
G Q N
o 0 = 3.000

3.000

O
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5. Use the toolbar to define the scan grid and the spacing of scan
points on this grid.
«  To define the distance between scan points on the grid lines,

v

tap and enter the desired value.

To define the distance between grid rows, tap | and enter
the desired value.

To define the distance between grid columns, tap and
enter the desired value.
The grid preview is updated according to the entered values. The
software calculates the number of points to be scanned and the
estimated scanning time and displays them in the info panel.

To cancel the process, tap 2
To accept the defined grid and continue with the next wizard step,

tap B

m rd Scan Name n

Name Grid-Scan_20201021211809 ‘
Description ‘
Symbol © ‘ >

Created 21.10.2020 - 21:18:09

oD
>

If desired, you can edit the file name of the scan data, enter a
description and define the symbol for the scan points.
Tap next wizard step )} to proceed.

Map view is dis-
played. The info
panel displays the
estimated scanning
time.

Grid Scan progress: 0%
Aprox. 07:30 min

Start  PointID

I= To assign a code to the scan points, tap Code. If necessary, adapt
the Measure bar to display Code.

7. To start the scanning process, tap Start.
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The info panel dis-

no | @) Grid Scan progress: 16%
e S plays the progress
and the estimated
- remaining time for
v} scanning.

I To pause the scanning process, tap Pause.

To cancel the scanning process, tap Pause, then tap 2 4 .

i If the connected instrument becomes unlevelled during scanning, an
error message is displayed.

Level the instrument and tap ¥ +to restart the scanning process,
beginning at the first defined scan point.

When the scanning
process is finished,
the info panel dis-
plays the scan result.
All measured points
are displayed on the
map.

Grid Scan progress : 100%
Measured points : 22
Not Measured points : 8

Tap ¥ to finish the scanning process.

I The generated point grid can be used to verify data in the Verifica-
tion application. Refer to 13 How to Use Verification .

Using Polygonal Quick

! Preparation
Gridstep-by-step

1. Connect the instrument to the iCON field software.
2. Set up the instrument.
3. Go to the desired application in iCON.

Scanning process

1. In the current application, select Grid &
Scan from the toolbox.
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o= P The screen "Scan/
Grid Definition" is

Precise Grid Scan Definition Quick Grid Scan definition

displayed.
2. Tap the desired method to start the wizard for this method.
3. Level the instrument.
Tap next wizard step ¥ to proceed.
Map view is displayed.
4, Follow the instructions on this screen to define the polygonal scan

area. Measure at least three points to define a polygonal area.
Only the angles are measured and stored.

o %
“ i@ 1 e T A e e,
when area defined, move to next step
Define Scan Area
A s

= --

Tap next wizard step ¥ to proceed.

5. Measure the centre of the scan area.
=
n D)

A a=

<7
‘s

= Q & =
EE— Y
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6. Use the toolbar to define the scan grid.

' e

To define the distance between grid rows, tap | and enter
the desired value.
To define the distance between grid columns, tap and
enter the desired value.
@@ ES oo
DRSS T
A e
C
foa 1.650
H 1.300
To cancel the process, tap X
Tap next wizard step JEJ to proceed.
7. If desired, you can edit the file name of the scan data, enter a

description and define the symbol for the scan points.

m Grid Scan Name n

Name Grid-Scan_20201021211809 ‘
Description ‘
Symbol © ‘ >

Created 21.10.2020 - 21:18:09

Tap next wizard step ) to proceed.

Map view is dis-
played. The info
panel displays the

Grid Scan progress: 0%
Aprox. 02:30 min

estimated scanning
time.

Start Point ID

II= To assign a code to the scan points, tap Code. If necessary, adapt
the Measure bar to display Code.
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8. To start the scanning process, tap Start.
The info panel displays the progress and the estimated remaining
time for scanning.

1= To pause the scanning process, tap Pause.

To cancel the scanning process, tap Pause, then tap 2 4 .

I If the connected instrument becomes unlevelled during scanning, an
error message is displayed.

Level the instrument and tap ¥ 1o restart the scanning process,
beginning at the first defined scan point.

When the scanning
process is finished,

Grid Scan progress : 100%
Measured points : 22
Not Measured points : 8

”» the info panel dis-
A oo ©
= o & plays the scan result.
4 All measured points
do2 are displayed on the
“S’ map.

e T
N N

Tap ¥ to finish the scanning process.

II= The generated point grid can be used to verify data in the Verifica-
tion application. Refer to 13 How to Use Verification .

8.3 How to Use the Scan Data Functionality
Using Rectangular Preparation
area and Polygonal 1. Create a new project and import the necessary control points.

area step-by-ste
P=bY P Connect the MS60 to the iCON field software.

2
3. Set up the instrument.
4 Go to the desired application in iCON.

Scanning process

1. In the current application, select Grid &
Scan from the toolbox.

e The screen "Scan/
m Scan/Grid Definition . . "o
Grid Definition" is
Sean dfinion displaved
PR TR prayed.
- e H
=S\
Rectangular Precise Grid  Polygonal Precise Grid Rectangular area Polygonal area
Polygonal Quick Grid
|
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Tap the desired method to start the wizard for this method.

3. Level the instrument.

Tap next wizard step JE¥ to proceed.

4. Define the scan area depending on the selected method. Follow the

instructions on this screen.

« Rectangular area
Measure two points to define the upper left and lower right
corner of the rectangular area.

+ Polygonal area
Measure at least three points to define a polygonal area.

Tap next wizard step ) to proceed.

P Map view is dis-
| ) Aim for the first point (of scan area) and

oIS

5. Measure the centre point of the object to be scanned.
Tap next wizard step Jf to proceed.

, The point spacing
O O
defines the resolu-

. Preefinedresoluﬁons ' ' tl'on Of the scan data.
Low - Earthworks Dictnos 41676 mmeameosnozs * | Depending on the
o St Do e, selected point spa-
T [T g cing, the software
User defined resolution calculates the estim-
User Defined Distance: 4.1976 E::::::: 5::?3;000;12 e atE’d number of SC‘?n
Horizontal spacing (0500 | Vertical spacing [0.500 pomn ts and th S E"Stl m-
o et ated scanning time.
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6. By default, the recommended point spacing is active. If desired,
choose another resolution:
+ Low - Earthworks
+ Mid - Floor Flatness, Walls
+ High - Tubes, Stairs, MEP, GHV[High]
« User defined resolution:
Enter the desired values for the horizontal and vertical point
spacing.
«  Only for MS60+:
By default, the recommended scan speed is selected. If desired,
choose another scan speed to reduce the scanning time.
- 1000 points per second
- 2000 points per second
- 4000 points per second
- 8000 points per second
Changing the scan speed manually might influence the quality of
the scan result.
Tap next wizard step ) to proceed.

Save

C:/BuildAgent/work/7b12...cts/SCA

‘ Scan__20201021211927_sdb ‘ .SDB

EEEEOE NN

7. « If desired, edit the name of the scan data, enter a description
and define a colour for the scan points.
»  Select the storing location.
If the estimated scan data is bigger than the available storage
place, an error message is displayed. To continue, select a dif-
ferent storage location with enough space.

Tap ¥ +to continue.
Map view is displayed.

8. To start the scanning process, tap Start.

The info panel dis-
plays the scanning
progress.

(®%0.000

Scan progress: 25 %

Scan progress

T m|m|a|a]¥]

II>= To pause the scanning process, tap Pause.

To cancel the scanning process, tap X

How to Collect Data Using Scanning 191



I  If the connected instrument becomes unlevelled during scanning, an
error message is displayed.

Level the instrument and tap ¥ 1o restart the scanning process,
beginning at the first defined scan point.

®% 50000 e o o rem e When the scanning
Scan progress e process is finished,
the info panel dis-
plays the scan result.
All measured points
@; are displayed on the

$ map.

RN

Tap ¢ 1o finish the scanning process.

I The generated point grid can be used to verify data in the Verifica-
tion application. Refer to 13 How to Use Verification .
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9 How to Do Checks

General description Checks is an application that can be used to check geometries by selecting or
measuring points and lines.

You can make use of reference data and/or measured and sketched data as
well as the geometry from IFC objects.

In order to make use of IFC geometry a license for Layout Objects
or Verification is required.

Results are shown in the Information bar within the application.

= If necessary, you can save the results to include them in a Checks
report later. For information on how to create a report, refer to 19
How to Create a Report .

Calculated values are tie distance results, angles, areas and block volumes:
- Horizontal distance, sloped distance, height difference, slope

« Sum horizontal, sum sloped, azimuth, last included angle

« Area and perimeter in plane and tilted

«  Block volume, plane and tilted

= Tilted area and perimeter allow also to calculate vertical geometries,
for example the size of a window.

How to do checks = Available as a separate licence or included in iCON site Plus.
step-by-step
1. Select Checks from the Home Menu. G,?P
2. Select or measure points and lines to check geometries.
= The points and lines have to be selected or measured

ordered, either in clockwise or anticlockwise direction.

Current results are updated and shown in the Information bar
according to the points and lines selected or measured.

& mo [£1%50.000
o 63->64
<998.999 ~ 998.999

Select or measure points and lines to check
geometries

(£
998999 ~ 998959 © 998999

&
@
&
=) (i
0

A iz,
(=
*998.999
><
5321”64
63

993.913
&
&
@
% 62 61
& A

Meas+Rec| Point ID Clear

@

i All values are shown according to the current settings, in the chosen
unit and the number of decimals set.
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To save a result, select Save for Report from the toolbox.
» If necessary, change the default file name.

To save the results, tap v

Results are stored separately depending on the applied method
(Radial, Polygonal, Point to line).

3. - To display further results tap the arrow in the Information bar.
- Tap and hold the Information bar to see which results are

displayed or to configure the Information bar. Tap ' when
finished.

- Tap Clear in the Measure bar to deselect the measured or selec-
ted points and lines.

R
1#)% 0.000 Info bar configuration

6486993.913 <= 6486993.913 Select or measure points and lines to check
geometries
| 11402.788 < 11402.788

-~ 398.999 - SoB.599

. "S98.999

Start Point ID Clear Meas+Rec| PointID Clear

4. - To switch to a radial calculation method select Radial from the
Toolbox.

= Radial method means, the first point selected or measured
is always kept and is always the first point for the next tie
distance.
- To switch back to the polygonal calculation method select Poly-
gonal from the Toolbox.
= When switching between radial and polygonal method, the
current result is adapted immediately.

[®)% 5 0.000 A [£)%4,0.000
57->60 ) 57->64
< 2233.830 A 2233.830 < 2233.830 | A 2233.830

Q2

\‘Bb ok
0 l‘b >

Block
Volume

|2

Delete

Radial | Pointto line
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Toolbox functions

How to Do Checks

5. - For calculating block volumes select Block Volume from the
Toolbox.

Enter the needed height value, then tap v

- Now select or measure points and lines. As soon as an area can
be calculated, the block volume is also calculated and the result
displayed in the Information bar, if configured accordingly.

= It is also possible to select or measure points and lines
first and then select Block Volume from the Toolbox.

Select or measure points and lines to check

geometries

I The Point to line function allows to define a reference line by
selecting a line or two points. Then measure or select one or more
points. This results in a line and an offset value from the reference
line to each measured or selected point.

== The Delete and Undo functions are also available in the Toolbox.

Function Description

Radial Tap to check geometries using the radial
method.

Polygonal M Tap to check geometries using the polygonal

method.

Point to line

==
P

Allows you to check points with reference to a
line or a polyline.

Block Volume

Tap to calculate block volumes.

Save for Report

il | I

Tap to save the currently displayed result.

Manage Calcu-
lations

Allows you to view and delete already created

Checks calculations.

« To view details of a calculated result, tap the
arrow button to the right.

« To delete a calculated result, tap its name to

select it and tap ¥ +to confirm deletion.
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Information bar val- Type/lcon Description
ues

Id v Point ID of the last point measured or selected.
D)
E H East value of the last point measured or selected.
N n North value of the last point measured or selected.
H n Height of the last point measured or selected.
Ref_Id ’ Reference ID of the last two points measured or
selected, in the corresponding order.
Az v Horizontal angle to the last point measured or selec-
ted.
sD v Slope distance between the last two points meas-
ured or selected.
hD Horizontal distance between the last two points
E measured or selected.
Thd Sum of horizontal distances between the points
E measured or selected.
Tsd Sum of sloped distances between the points meas-
% ured or selected.
Inc Angle Included horizontal angle between the last two lines
measured or selected.
= When selecting points, the last line always
ends with the last point measured or
selected.
A_2D Horizontal area, covered by all points measured or
selected.
A_sl Sloped area, covered by all points measured or
selected.
Slope v Slope angle, between a virtual horizontal line
ﬁ.\ through the second to last point and the current line
mmd {0 last point measured or selected.
HeightD Height difference between the last two points meas-

ured or selected.
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How to Do Checks

Type/lcon

Description

Code

Code/layer for the next point to record.

Pr

Horizontal perimeter, available with at least three
points measured or selected.

The value is always calculated from the closed figure
of the measured/selected points.

Pr_3D

Sloped perimeter, available with at least three points
measured or selected.

The value is always calculated from the closed figure
of the measured/selected points.

BlkVol_H

Calculated horizontal block volume. Available as soon
as the needed height value is entered and an area
can be calculated.

BlkVol_SL

Calculated sloped block volume. Available as soon as
the needed height value is entered and an area can
be calculated.

dN

Difference in the north value between the last two
points measured or selected.

dE

Difference in the east value between the last two
points measured or selected.

CQ 1D

GPS| only: Coordinate quality value for the height
information at the current position.

CcQ 2D

GPS| only: Coordinate quality values for the plain
information at the current position.

cQ 3D

(GPS| only: Coordinate quality values for a combina-
tion of the height and the plain information at the
current position.

GDOP

€3 only: Geometric dilution of precision quality
value at the current position.
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10

How to Sketch a Plan

10.1

Points, Lines and Arcs

General description

How to sketch a plan
step-by-step

198

Draw is an application that can be used without
a connected instrument. Layout plans consisting of
points, lines and arcs can be created, and these

plans can then be used in another application to be A=
directly staked out. 0,0 §° ilfia, §,° ©
The following is a step-by-step guide to using some T e e ]

of the key functions in Draw to create a layout plan. | ¢

IS

Example of a layout
plan

No instrument connection is required.

Access application

Select Draw from the Home Menu.

Draw points and lines

e

If point data is present, tap a point to begin.

1.

Use the Toolbar to enter information for the position of the next
point.

- Toolbar contains options to edit angle, distance, height, and

to draw a line between points.

« To create several points easily in one step, use multiple points

and enter the desired number of points.

L o

Enter direction and distance

Select start point

reference to the
north direction.

[ 100.000
2] 1.000

Tap v to confirm point position. The process can then repeat.

Use CODE to define and apply a code for every point recorded.

Tap to enable rotation.

The Delete function is available in the Toolbox.

Select the elements for deleting, then press <

How to Sketch a Plan

The entred angle is
always drawn with



Delete

= In the Viewing Options you can toggle between 2D and 3D line
values to be shown in the map view. Line Dimension needs to be
switched On.

Viewing Options

Point Information

| Identification

Point/Line Information

Point Information

2D shows the hori-
zontal line length as
entered for distance.
3D shows the slope
distance.

Line Information = =
Possible Information

Line 20 o 3D .
Atibtes

Line Dimension

Surface Triangles

Surface Shading

Draw an arc
1. To draw an arc, select Arcs from the Sketching Functions menu.

2. Tap the points for the arc.

I Arcs can be drawn by tapping two points and inputting radius
information into the Toolbar, or tapping three points. When tapping
three points, the radius of the arc is calculated automatically and the
field for entering the radius is read-only.

3. Potential arcs are displayed, the light blue part is the selected one.
To select the other possible arc simply tap on it.

Tap ¢ +to store the arc.

Sketching Functions

11259 |%

Poinis & Point
Lines G Ofisets | Creation

=

Data Merger

How to Sketch a Plan 199



Draw a circle
= Only available for iCON site Plus.

1. To draw a circle, select Arcs from the Sketching Functions menu.
2. Select Circle from the Toolbox.
3. To create a circle, use one of the following options:

«  Select a centre point and enter a radius.
« Select a centre point and a start point.
The radius is calculated automatically.
«  Select 3 points which should be on the circle line.
The radius is calculated automatically and the centre point is

stored.

o

I Potential circles are displayed in light blue colour.
When selecting two or three points, the field for entering the radius
is read-only.
The height of the circle is defined by the start point. If no height is
defined for the start point, the height of the circle is set to zero.

Tap ¥ 1o store the circle.

Divide a line or arc into equal segments

1. To distribute a number of points evenly along an arc/line, select
Point Creation from the Sketching Functions menu.

2. Select Divide Line from the Toolbox.

3. Select the line you need to divide, then input the Number of Seg-

ments or alternatively the Interval length .

Tap ¥ +to confirm.
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Create offset points

1. To create offset points for the sketch, select Offsets from the
Sketching Functions menu.

2. Select the points required for offset, then enter an Offset value

S Additionally enter a Height Offset value at , if needed.

IS°  Enable or disable draw line as required. Use flip Bl to switch
the offset value from positive to negative.

Sketching Functions

1% 59| &

Points & . S Point
Lines 3 Offsets | Creation

i Store Projection, which displays two points at each corner at per-
pendicular offsets, can be toggled ON/OFF by accessing the Tool-
box.

Offsets Tools

e A

PointID | Control Point

ol
(o}

Store
Projection

)

Delete

Tap v to accept.

Create points or lines by defining direction and slope
1. Select Points & Lines from the Sketching Functions menu.
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2. Select Create Point / Line from the Toolbox.

__

o1

Q ‘:“I‘

A 0.250

V>

00 >
-

8

0.
-——--

3. Select a point.

Make the necessary settings in the toolbar:
«  Enter or change the horizontal angle.
«  Enter or change the distance value.
Tap the respective button to switch between sloped distance

and horizontal distance Q

«  Enter or change the slope value.

Tap the respective button to switch between positive slope [

and negative slope |
* Enable or disable draw line &%

as required.

= To set the values for horizontal angle, distance and slope automat-
ically, select a second point. It is possible to modify the values as

desired.
__
T Bm >
01
o A

-——---

I Use CODE to define and apply a code to the created point.

Tap ¢ 1o store the projected point or line.

How to create points = Available for iCON build and iCON site Plus.
with Snap Points tool
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Creating points with the Snap Points tool

1. Select Draw/Sketching from the Home Menu. Vi
o
Select Point Creation from the Sketching Functions menu.
Select Snap Points from the toolbox.
Toolbar for Snap Points is displayed. Refer to the following table for a
description of the toolbar buttons.
4. Select all lines, arcs or circles for which you want to create points.
For quick selection or deselection, use the Window Selection mode.
5. Activate the corresponding toolbar button to create mid-points,
centre points or intersection points for the selected elements.
L I
(2sm >
';:/sv
& &
When you activate a button, a preview of the res-
ulting points is displayed in map view. An active
button is highlighted in green.
6.

Tap ¥ +to confirm the preview and create the points.

Toolbar for Snap Points

Toolbar but- Description

ton

Tap this button to start the Window Selection mode. This

mode allows you to select or deselect several elements

at once instead of tapping each of them separately. All

elements located within the defined selection area can be

selected or deselected.

«  Define a rectangular selection area by tapping two
points for the area corners.

Tap ¢ 1o add the elements within the selection area
to the selection.

Activate LEEEER and tap ¥ 1o deselect the elements
within the selection area.

How to Sketch a Plan
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Toolbar but- Description
ton

Activate this button to create centre points for the selected
elements.

= This button is activated by default.

Activate this button to create mid-points for the selected
elements.

Activate this button to create intersection points for the
selected elements.

Tap this button to deselect all selected elements.

Tap this button to create the corresponding points.

10.2 How to Merge Models (Drawings, PDF Files)

Import models It is possible to import several models to a job, such as floor plans or installa-
tion plans. After import, you can scale, rotate and align these models to each
other using the Data Merger tool.

Allowed file formats:
- 2D PDF: Vector type of PDF, typically created from a CAD program.

- DXF
- DWG
= For information on how to import reference data, refer to Importing
data to the project step-by-step (within 2.2 Import, Export, or Delete
Data).
Merge models step- = Ensure that the necessary models are loaded to the active project.
by-step
1. Select Sketching from the Home Menu. Vi
o
Map view is displayed.
E
A
Pisin *
|

204 How to Sketch a Plan



i Each model must include two points which can serve as reference
points for scaling, rotating and aligning the vector data.
If necessary, create these points for each model before merging the

models.
2. To merge the models, select Data Merger from =
the Sketching Functions menu. fh °°|

Select the file to be transformed n O

D Disable Scaling
DXF/DWG/DGN models

Sample_FloorPlan_grids.dxf

PDF models

Floor_Plan_No_grids.pdf

Select the model to be scaled, rotated and aligned.

Tap m to proceed to the next Wizard step.

All available points of the selected model are dis-
played in map view.

Origin points defined, proceed to the next
wizard step to pick target points.

&

A IENENE

P

4. Select two points to be used as source points.
To cancel point selection, tap BJ.

Tap D to proceed to the next Wizard step.
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10.3

5. The model serving as target for the alignment is
displayed in map view.

Select two points to define the
transformation or manually enter
transformation values.

1.812

Pl | 361.111

39.353

-14.697

X
HEEE

=
0.000 &

=

Select two points to be used as target points.
To cancel point selection, tap BJ.

= If necessary, enable the option Show Points in the Layer Manager.

To merge the models, tap .

7. If necessary, edit the file name of the merged models.
Tap « to save.

Map view is displayed. The models are now aligned
to each other.

_ Select start point

Ao \

o
C

How to Create Drill Patterns

General description

How to create drill
patterns step-by-step

206

The Drill Patterns creation functionality allows to define drilling or piling pat-
terns for drill rigs.

Once the pattern is created, transfer it to iCON Rig machines running MC1 or
VisualMachine.

= The software requires an additional license to use this application.
1. Import the data you want to apply. For example: Points, lines, poly-
lines, road lines, and so on. Refer to 2.2 Import, Export, or Delete
Data.
2. Select Draw from the Home Menu. Y
o
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3. Select Patterns from the Sketching Func-
tions menu.

4. Select Drill Patterns to start the Wizard.

Define the direction of the pattern.

Ln® p~
A

Proceed to next step to define the pattern

0.000

=
S}
& 293.530
N

0.000

Select two points, a line or a polyline to define the forward direction
of the pattern.

Tap % to flip the start and end point of the line.

To offset the line, enter a value at T .

« If necessary, define the start and end chainage of the line in the
toolbar.

Tap the next Wizard step m to proceed.

6. Define and dimension the pattern. The pattern points are the bot-
tom points of the drill holes.

For a description of
the icons, refer to
Toolbar buttons
and editable fields
for defining the
pattern (step 6.).

Define pattern

Tap the next Wizard step m to proceed.

i If any combination of the forward holes spacing with the number of
forward holes exceeds the end point of the line, a message appears
with options to retract or overshoot the pattern.

« Retract: The pattern stops before the endpoint of the line.
« Overshoot: The pattern extends by one set of forward points.
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7. Define the height of the pattern points.

By default, all pattern points have the height of the start point.

There are several options to change the height of the pattern

points:

«  Manually enter the desired height into the editable field.

«  Select a surface to transfer the heights of the surface to the
pattern points. Pattern points outside the surface are not cre-
ated.

«  Select the line of a road model to transfer the heights of the

model to the pattern points. Pattern points outside the road
model are not created.

Select a line and tap
line.

to transfer the height of the selected

Tap the next Wizard step m to proceed.

8. When you apply a pattern to a curved line, o
the forward hole spacing is influenced by the o ©
distance of the points to the selected line. o
Depending on which side the pattern is cre- °
ated, the forward hole spacing is increasing » o
or decreasing. /

This step is optional and available when a line has been selected in
the wizard step 1.

For a description of the icons, refer to Editable fields for defining
the minimum/maximum hole spacing (step 8.).

Define the minimum hole spacing to remove holes.

Define the maximum hole spacing to add extra holes. The added
holes are shown in purple colour.

To reset the values, ensure that the editable fields are empty.

Tap the next Wizard step m to proceed.

208 How to Sketch a Plan



9. Define the heading and the inclination of the
holes. The top points are the grey points on
the map.

Example: The heading of the holes is set to be perpendicular to the
line at the right side.

For a description of
the icons, refer to
Toolbar buttons
and editable fields
for defining the
heading and the
inclination of the
holes (step 9.).

Change the vertical angle/slope definition (zero vertical angle) from
bottom to top. This setting avoids drilling at a wrong position, for
example too close to a free face.

By default, the vertical angle is applied at the daylight point/top
point (kick angle from bottom).

When is enabled, the vertical angle is applied from the top
points to the bottom points (kick angle from top).

Example: Pattern when the vertical angle is applied to top points
(left) and bottom point (right)

o® N o®
o o
e® o?®
o o

Tap the next Wizard step m to proceed.

10. If necessary, select one or more holes and change the heading
and/or the vertical angle/slope. This step is optional.

6

< c
© ©
° °
© ©

30.000

Tap « to accept the changes or tap B8] to cancel any changes made
in this step.

11. Tap « to finish the wizard.
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12.

Enter the name for the pattern.

Tap « to accept.

The pattern is stored as a *.geo file. It is visible on the map for
further checking. Turn off the file from the layer manager or delete
if not longer needed.

Select Export from the Home Menu.

Select Drill Patterns option for exporting.

Export in XML format (IREDES standard) for MC1 or Kof for VisualMa-
chine (kof contains the bottom points of the holes).

The file is exported to the Data folder of the internal memory or USB
stick.

It is also possible to export the drill pattern to ConX.

Toolbar buttons and editable fields for defining the pattern (step 6.)

Toolbar Description
button
® Tap this button to rearrange the pattern into a diamond

formation.

Tap this button to create the pattern on the left side of the
line.

Tap this button to create the pattern on the right side of the
line.

Tap this button to create the pattern at forward direction.

<=
=>
i
4

Tap this button to create the pattern as backward direction.

= This button is only active, if two points have been
selected in the previous step.

Enter forward holes spacing.

E@@

®®

@® Enter number of forward holes.
oF -

@®

®® Enter side holes spacing.

®®

#

®e0@

Enter number of side holes.

Editable fields for defining the minimum/maximum hole spacing (step

8.)
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Toolbar Description

button
® Enter the minimum hole spacing to remove holes.
'@
® Enter the maximum hole spacing to add extra holes.
le

Toolbar buttons and editable fields for defining the heading and the
inclination of the holes (step 9.)

Toolbar Description
button
I Tap this button to set the hole heading perpendicular to the
©--9 line on the left direction.
o--$

Tap this button to set the hole heading perpendicular to the

|
¢--@ line on the right direction.
©--0
Tap this button to kick the vertical angle/slope from top. By
ﬁ\*,- default the vertical angle/slope is applied from the bottom.

Enter the holes heading.

Enter the distance to the top points.

Enter the vertical angle/slope of the holes.

2
10.4 Sketching Toolbox Functions
Toolbox functions Depending on the Sketching Functions selected, the toolbox contains some

additional functions.

Points & Lines Tools Point Creation Tools
Q —

Arcs Tools

¢

Function Description
Start Point

Allows the selection of a point as the new start
point.

Connect Points Tap points to create a line between these

points.
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Function

Description

Close Figure

(Ipa=)
(==

Tap to complete the shape.

Rotate Point
Pilot

P
N

Rotate the point pilot relevant to presettings,
for example a reference line or a constructional
drawing, to use this helpful tool in a rotated
position.
== Only available for iCON build and iCON
site Plus.

New Point

Insert a point into the map by entering the

required coordinates or by scanning a QR-code,

or select a point and adapt the coordinates

for the new point. The new point can also be

defined as Control Point.
= B
To start the QR-code scan tap IEZ .
See also: Importing data using QR-
Scan step-by-step

Edit Point

After selecting a point from the map, permitted
values can be edited.

Create Point /
Line

Allows you to create a point or line by defining
direction and slope.

Point ID

Tap Point ID to edit ID for the next point.

Control Point

Tap to activate the Control Point function.
When active, new points are stored as control
points.

Store Radius
Point

Allows you to store the radius point along with
the arc.

Long / Short

Allows you to toggle between the short and the
long segment of a circle, when creating an arc.
By default, short is selected.

Circle mg Allows you to create circles.
‘ = Only available for iCON build and iCON
site Plus.
Dist-Dist Select two points and the required distances for
intersection. When the theoretical circles inter-
sect select the intersection point to store.
Dist-Angle Select a point and the required distance. Then

select a second point and the angle for theoret-
ical line through that point. When the theoretical
circle intersects the line select the intersection
point to store.
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Function

Description

Angle-Angle

Select two points and the angles for the the-
oretical lines through these points. When the
theoretical lines intersect, select the intersection
point to store.

Intersection

Select a first line or two points for it. Select a
second line or two points for it. When the theor-
etical lines intersect store the intersection point.

Line-Offset A Select a line to offset or two points for it. Then
J‘ enter the line and offset information and store
the new point.
Divide Line Select a line, or two points for it, or an arc, to
divide into segments.
Snap Points Select lines, arcs or circles and create their mid-

points, intersection points or centre points.

= Only available for iCON build and iCON
site Plus.

How to Sketch a Plan
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11 How to Stake Out g3 +@E3

11.1 Staking Out 3 + @3

General description = The Stakeout application is used to place marks in the field at pre-
determined points. These predetermined points are the points to be
staked.

PO Known
station

P1... Point to be

staked

The points to be staked can:

+ Be uploaded as a file to a project. Refer to Importing data to the project
step-by-step for more information.

«  Be created within the Draw application, and accessed directly. Refer to
10 How to Sketch a Plan.

This chapter explains how to stake out points, lines, and arcs, using GPS and
Total Station.

For information about staking out Surfaces refer to 12 How to Stake
Out Surfaces .

Stake Out elements,
TPS

PO Station
P1 Current
Pl position
P2 Point to be
dl ~ staked
dl Stake out
element
PO 'dZ d2 Stake out
element
d3 Stake out
006776001 element
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Stake Out elements,

PO Current
position

P1 Point to be
staked

dl Stake out
distance

d2 Height dif-
ference
between
current
position
and point
to be
staked

o Stake out

006777_001 direction

Associate Point ID to

8 iCON site allows to associate a Point ID to a Stakeout point:
Stakeout point

1 ' Se l ect Turn Telescope.

,g;“’ A

Stakeout from = -E

the Home Menu. c &

Map screen is dis-
played. Select an
element to stake.

2. Configure the Meas-
ure bar to display
Point ID, then tap
Point ID. Tap on
the Point ID tick

box and tap v to
accept.

Point ID

ISOpoint_42_1

Always Prompt [\/ Point ID

3. Measure and store a
new point. This point
will be recorded with
the associated Point
ID.
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11.2

When a line is selected as stakeout element the associated name will
follow this convention: start point ID minus end point ID underscore
additional number. For example for a line from point ID 10 to point ID
17 it will be 10-17_1, 10-17_2 and so on.

Stake Out Points +[@3

General description

Stake out points
step-by-step

216

006778 001

Given:

PO Known

station
P1 ... Layout

points
a Radius
b Offset

e Instrument is connected and set up with known station and height.
e Points are active within the current job. Refer to Importing data to the
project step-by-step.

Note that main workflow refers to Total Station. For GPS press

e :
Measure to record a point.
1. Select Stakeout from the Home Menu. ol
1
2. Select the point to

stake, then follow
the guidance to nav-
igate the target to
the point.

Turn Telescope.

Measure Store Point ID
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3. Once telescope is
aimed to target
point, press Meas- A
ure. The difference
between the meas-
ured point and the
point to be staked
is displayed. The col-
our of the meas-
ured point indicates
whether it is within

Point in sight

t+ 0.000 ﬁ >
— 43[ e

Measure Store Point ID

tolerance.

4. Record the pointby  p=rm @@ —
tapping Store, or I s+ 0.000 ﬁ )
measure again, using 43|+~ 0.000
Measure. P .

5. Once the location

Select an element to stakeout

is marked, the next
point can then be
selected, and the
process can repeat.

i In 5" or 7" display mode, with Multiview active, use Stakeout Point
List to get the points to be staked displayed. It is possible to select
the points for staking out in the list.

5= Define Measure Mode in the Status 1 menu.

= m/ft
Tolerances can be set in Units o , which is found in the Home

Menu.

== GPS and Robotic Total Station approach:
As the target moves around, real-time measurement data and guid-
ance information is constantly displayed in the Information bar.
Once the point in the screen turns green, the point is staked within
tolerance. To record points using the Total Station, press Store. If
using GPS, press Measure.
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11.3 Stake Out Points with Reference to a Line + [T

General description

PO Known

station

P1 Measured
point

P2 Point to be
staked

a Reference
line

b Line

006780.001 C Offset

Given:

e Instrument is connected and set up with known station and height.

- Points are active within the current job. Refer to Importing data to the
project step-by-step.

= Note that main workflow refers to Total Station. For GPS press
Measure to record a point.

Stake out points with 1. Select Stakeout from the Home Menu. o—0
reference to a line 1l

step-by-step

2. Select Reference
from the Toolbox.

Select an element to stakeout

3. Define the reference
line, then use the
Toolbar to define
any offset for the

line. Tap v to
accept.
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11.4

4. Select a point to ——
stake, and then F 5
press Measure. The 50|+ 2]
difference between
the measured point
and the point to be
staked is displayed,
with reference to
the line that was
defined.
5. Once the location —
is marked (in the ﬁ S
field) and stored, the =  50]+ 0.000]
next point can then
be selected, and the & \
process can repeat. | i
== GPS and Robotic Total Station approach:

As the target moves around, real-time measurement data and guid-
ance information is constantly displayed in the Information bar.
Once the point in the screen turns green, the point is staked within
tolerance. To record points using the Total Station, press Store. If
using GPS, press Measure.

Stake Out Points, Lines, Arcs with Reference to a Height
S GPS|

General description

How to Stake Out +[@3

19084001

PO
P1
P2

Known station
Measured point
Point to be staked

a, b Distance offsets
C Height offset
d Reference height
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Given:

« Instrument is connected and set up with known station and height.

- Data is active within the current job. Refer to Importing data to the
project step-by-step.

Stake out points with 1. Select Stakeout from the Home Menu. o—0
reference to a height 1l

step-by-step

2. Select Reference Height from the Toolbox.

The Toolbar for reference height is displayed.

] %j’[ 0.000
v Selected surface: sample_surface
2

o
o‘

3. Define the reference height by one of the following options:
«  Select a point with the desired height.
«  Select a surface. If necessary, use the Toolbar to define an offset
to the surface.
« Directly enter a reference height in the Toolbar. &4
Tap « to accept.

S @

4. Select a point, line or arc to stake. Press Measure.
The Cut & Fill value from the defined reference height to the measur-
ing position is calculated.
To store the point, tap Store.

o2

:

= Once the location is marked (in the field) and the point is stored,
the next element can then be selected, and the storing process can
repeat.
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11.5 Stake Out Lines and Arcs i3 + @3

General description

PO Known

station
P1 ... Layout
points
a Radius
b Offset

Given:

e Instrument is connected and set up with known station and height.

«  Points/lines/arcs are available in the current job. Refer to Importing data
to the project step-by-step.

= Note that main workflow refers to Total Station. For GPS press
Measure to record a point.

Stake out lines and 1. Select Stakeout from the Home Menu. o—0
arcs step-by-step 1l
2. - Define or select the line/arc to stake by tapping the relevant
elements.

To change the direction of the line, select flip % from the
Toolbox. Once the line is defined, press Measure.

[&)%50.000

Select an element to stakeout

Measure Store Point ID

3. - Once the target is within tolerance, it changes colour to green.
Press Store. Mark the staked position (in the field).
- This process can repeat along the same line. To stake another
line, tap the preferred line, and continue the process.
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© 52->51 ® 0.000
-110.000 ¢ 110.000

m 52->51® 0.000
%/999.000 ¥ -999.000

’ 52

= ) o ) 3
Measure Store Point ID Measure | Store Point ID

5= Define Measure Mode in the Status 1 menu.

=== GPS and Robotic Total Station approach:
As the target moves around, real-time measurement data and guid-
ance information is constantly displayed in the Information bar.
Once the point in the screen turns green, the point is staked within
tolerance. To record points using the Total Station, press Store. If
using GPS, press Measure.

Use Divide & Offset

The toolbox function Divide & Offset allows you to divide a line or arc into
step-by-step

segments. Based on a defined interval or number of segments, the function
automatically creates segment points that can be staked out. These segment
points can also be offset in one step.

If desired, you can add the created segment points to an existing or a new
stakeout list.

1. Select Stakeout from the Home Menu.

i Divide & Offset is also available in the Roading
application. ﬂﬂ

2. Select Divide & Offset from the Toolbox.

3. Select the line/arc for dividing and offsetting by
tapping the relevant element.
The Divide & Offset toolbar is displayed.

Define values for the line division
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4. Use the toolbar to define the values for line division and if neces-
sary, the values for offsetting the segment points. The map view is
updated accordingly to show a preview of the points to be created.

Start/End point

Start and end point define whether the whole line/arc or only a part
of it is divided into segments. If necessary, change the values of the
start and end point.

Tap Flip M to switch the start and end point of the line/arc.

Values for line division

The fields for defining the necessary number of segments and the
length of a single segment are interdependent. Enter a value for one
of the fields and the value of the other is updated accordingly.

Offset values
Tap this button to define the offset values for the
segment points.
== The button and the toolbar change their
appearance accordingly. Tap the button
again to define the values for line divi-
sion.
Enter values for the horizontal and vertical offset
to the selected line/arc.

Tap Flip to switch the vertical offset value
from positive to negative.

Codes
Tap the Code button to assign a code to the created segment
points. For information on codes, refer to 7.5 Point IDs and Codes .

Break Points

Activate this button to create so called "break
points", in addition to the segment points. Using

break points is especially helpful for polylines that

have many changes in direction or slope. A break

point is created at each change of direction.

Tap ¥ 1o store the created segment and break points.

6. Following screen is displayed:

m Create new or add to existing stakeout point list

‘New List1 ‘

Existing stakeout lists

= list1 11.12.2017 - 09:51:52
B list 2 11.12.2017 - 09:52:27
o= list 3 11.12.2017 - 09:52:52
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11.6

= To return to map view without creating a stakeout list for

the created points, tap Back.

« To add the created points to a new stakeout list, enter a name

and tap v

+ To add the created points to an existing stakeout list, tap the

respective row in the list.

A message is displayed, informing about the number of points added

to a new or existing stakeout list.
Tap OK to return to map view.

Stake Writer + [

General description

Using Stake Writer
step-by-step

224

Stake Writer allows for user-friendly marking of cut/fill values on the stakes.

The function is available in the applications:
«  Stakeout

See also: General Stake Out Toolbox Functions

- Cut&Fill

See also: General Cut/Fill Toolbox Functions

« Roading

See also: General Roading Toolbox Functions

e Slopes
See also: Toolbox functions

When you have loaded the project data and connected to the sensor you can

access the relevant application.

1. Select Stakeout from the Home Menu.

O—0

2. Select Stake Writer from the Toolbox.

1

A configuration screen appears to select the desired stake-writing method

and configure the stake dimensions.

3. Under Settings tap the button to turn Stake Writer On.

Stake Writer

Stake Writer On
From Ground I

From Top Of Stake ‘

User Defined

Cut Fill Interval 0.500

Bottom Spacing ‘0.200

Stake Length ‘ 1.000
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4. Under Writing Distance select between:
»  From Ground
«  From Top Of Stake
»  User Defined
With User Defined being the usual method not using any stake
marking assistance.

5. Under Stake Dimensions define the parameters as required.
i C
a d
a Stake Length
b b Bottom Spacing
¢ Top Spacing
d Range for applying the mark in

accordance with the defined Cut Fill
022787.001 | nterVa | .

- Enter the length of the stake used for stakeout, only available
for method From Ground.

- Enter an interval by which an easy-to-use Cut & Fill value shall
be calculated for the marking on the stake.

For example, a Cut Fill Interval of 0.5m implies that the soft-
ware calculates the mark to be at 0.5m intervals, that is either
at 0.0m or 0.5m or 1.0m or 1.5m etc. cut or fill.

The interval value can as well be set to 0.

- Enter values for Bottom Spacing and Top Spacing in order to
define a margin at the top and/or the bottom of the stake that
shall not be available for marking.

If the calculated Cut & Fill mark lies outside the given range, the
system issues a notification.

The bottom/top spacing can be set to 0, which implies that the
whole length of the stake will be available for applying the mark.

6. Tap ¢ in order to accept all settings and proceed with using Stake
Writer.
=3 Tap ”@ to reset any configurations to default. The Stake Writing
Method will be reset to From Ground.
7. In the Map View select the element to be staked out.
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226

Start measuring.
When the pole pos-
ition is inside toler-
ance tap Store.

-0.00
= e
= -

Store Point ID

For method From

Top Of Stake

a second measure-

ment on top of the

stake is needed.

- Measure and
store the
ground point.

- Drive the stake
into the ground.

- Place the pole
on top of the
stake and tap
Measure.

Drive the stake into the ground, place the
pole on top of it and press Measure.

The Point to be stored page is displayed:

Point to be stored

Fill 3.000

0288

Point ID ‘ SOpoint_C2_1
Easting 723585102
n—— S—

For Writing Distance

From Ground
Pole Height 1.700 |
Prism Type Leica Round b
Line 1.530
Offset -0.006
Fill 3.288

Point to be stored

Point Information

Point ID |sopoint_6_1
Easting 723587.516

Northina 724427 031

For Writing Distance

From Top Of Stake

Antenna Height ‘2.000 ‘
CQ Height 0.020
CQ Position 2D 0.015
CQ Position 3D 0.025
GDOP

No. of Satellites 15
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11.7

Paimito be stored For Writing Distance

User Defined
[ smewiewr |

Antenna Height ‘2.000 ‘

D €Q Height 0.020

v
CQ Position 2D 0.015
" " €Q Position 3D 0.025
Point ID |sopoint_6_1 GDOP

Easting 723587.516 No. of Satellites 15

Tap ¢ to store the point.

=x If the measurement fits to the defined Stake Dimensions the indic-

ator in the diagram shows o

If the calculated stake mark position lies outside the defined Stake
Dimensions (for example, beyond the range for applying the Cut &

Fill mark or beyond the defined Stake Length) then a warning A is
indicated in the diagram.

=< Stake Writer information is also displayed in the Point Information
screen.
On how to view detailed information on stored points refer to: Dis-
play point information

Staking Out Points Automatically

General description

Stake out a point on
ceiling, floor or wall

= This feature is available when using a Robotic Total Station.
Available for iCON build and iCON site Plus.

The Auto Staking tool allows you to stake out points automatically, such
as points on a ceiling, floor, wall or penetration points on walls. The tool is
especially intended for situations where the coordinates of the point to be
staked out do not fit to the already built area.

16202001

How to Stake Out +[@3 227



a Existing ceiling P3  Auxiliary point on floor

b Designed ceiling (not yet hl Height difference between
built) existing and designed ceiling

P1 Designed point to be staked h2 Height difference between
out designed ceiling and floor

P2 Auxiliary point on ceiling

1. Select Layout Points from the Home Menu.

Map screen is displayed. ﬂ
2. Select Auto Staking from the toolbox. O,
ol

3. Turn the telescope either to the ceiling, the floor or the wall where

the point should be staked out or marked.
Select the point and tap Start.

@
o p E\G:?ﬂ %]:[ 0.000 Please point the telescope to the desired
- 1 work surface and press "Start"
A=
FLOOR4 y FLOOR1 E
0] fl.oons ®
PIPE2-1 +
@
'@
PIPE ;-z
OO WALLL

CEILING3
’ =T
©

4, The instrument starts measuring and turns automatically to the
desired coordinates (X, Y) on the existing ceiling or floor.

®%40.000

AutoStaking in progress...

FLOOR4 \ FLOOR1L
A [0} 'FLOORS °
PIPE2-1 _+
O,
PIPEL-2

GO WALLL

CEILING3 @
@
LIRS ENEE

5. If the point is in tolerance, the solid laser pointer is switched on to
show the point position.
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= If the point is out of tolerance, a warning message is displayed.

« Tap Continue to continue the measurement.
If necessary, change the orientation of the telescope. For
example, it may not be possible to stake out a ceiling point due
to some objects being in the line of sight. In this case, point the
telescope to the floor instead.

« Tap Accept to accept the displayed deviation. The solid laser
pointer is switched on to show the point position.

6. Tap Store to store the measured point.

I You can stake out several points automatically, using the Stakeout

List function:

« Create a Stakeout List or activate an existing list. Refer to 2.6
Managing Stakeout Lists.

« In 5" or 7" display mode, activate Multiview and Stakeout Point
List to display the point list and the map side by side.

«  Select Auto Staking from the toolbox.

»  Select the first point in the list and tap Start.

work surface and press "Start"
A = \
© FLOOR1 3
LO0R4 ‘:‘ FLOOR1 E
© FLOOR4 ‘ ® © © ! =
PIPE2-1
© FLOORS5 ‘

PIPE% WALL1
B

CEILING3

(0]
@

mom e
1> For points on wall:

You can stake out several points on a wall automatically, using the

Stake to Wall function:

«  Configure the Measure bar to show Stake to Wall.

If Stake to Wall is active, all points are staked out on a wall. If
inactive, all points are staked out on the ceiling/floor.

«  Select a point, turn the telescope to the desired wall and start
the measurement. The selected point is projected to the existing
wall.

«  Select Stake to Wall in the Measure bar. The wall is defined by
the first two measurements and iterated with every new meas-
urement.

« To finish staking to a wall, select Stake to Wall in the Measure
bar again.
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Stake out a wall pen-
etration point

16255001

a Centreline of designed pipe X1 Horizontal offset in X direc-
b Designed pipe (not yet built) tion between existing and
¢ Designed wall (not yet built) designed wall
d Existing wall parallel to y1 Horizontal offset in Y direc-
designed wall tion between P1 and P2
P1 Penetration point on designed z; Vertical offset in Z direction
wall between P1 and P2
P2 Penetration point on existing
wall
> This procedure does not work for strongly curved walls or rough
surfaces!
1. Select Layout Lines from the Home Menu.
Map screen is displayed. E‘—
1= To stake out penetration points, the current job should contain a line
representing the centreline of the designed pipe or duct.
If necessary, measure a line or create a line using the "Connect
Points" tool.
2. Select Auto Staking from the toolbox. 0
&6
3. Turn the telescope to the existing wall where the penetration point

should be staked out or marked.
Select the line and tap Start.

L] TJVL 0.000 Please point the telescope to the desired
" work surface and press "Start"

FLOOR1

FLOOR4 N
\\ FLOORS

A
C

PIPE21  +

FIPEE& 'WALL1
i @
CEILING3
? EES
@
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4. The instrument starts measuring and turns automatically to the
desired penetration point on the existing wall.

=2 #%50.000
AutoStaking in progress...
FLOOR4 N\ FLOORL
“ @ ' FLOORS o @
C

PIPEZ:\l\ +
PIPE1- /
%\3 WALLL
]

CEILING3

: - |
©

o CECIEICE

5. If the point is in tolerance, the solid laser pointer is switched on to
show the point position.

= If the point is out of tolerance, a warning message is displayed.
«  Tap Continue to continue the measurement.
» Tap Accept to accept the displayed deviation. The solid laser
pointer is switched on to show the point position.

6. Tap Store to store the measured point.

: EZ @ 0.000
% -1.365| = 0.000

FLOOR4 AN FLOOR1
. [0} ' FLOORS @
c Vs ©

PIPE2L -+

MPE&
\‘“ WALL1 O
: s
©

CEILING3

CIEICNENET

Stake out points on With the Layout Objects application, it is possible to either stake out points
ceiling, wall or floor on ceilings, floors, walls or penetration points on walls. See also Stake out a
point on ceiling, floor or wall or Stake out a wall penetration point.

1. Select Layout Objects from the Home Menu. -
Map screen is displayed. [

2. Select Auto Staking from the toolbox.

3. Turn the telescope to the desired surface.
«  For a penetration point, select a line or the edge of an object.
The penetration point is laid out automatically.
« For a point on a ceiling, floor or wall, select a normal point,
endpoint of a line or point of an object.
Tap Start.
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LQ"SJ Luh[ 0.000 Please point the telescope to the desired
work surface and press "Start"

«§ o

Wall

Q B
2

4. The instrument starts measuring and turns automatically to the
desired point on the existing surface.

®%50.000

AutoStaking in progress...

g "o

Wall

QMR
<N

5. If the point is in tolerance, the solid laser pointer is switched on to
show the point position.

= If the point is out of tolerance, a warning message is displayed.

« Tap Continue to continue the measurement.
If necessary, change the orientation of the telescope. For
example, it may not be possible to stake out a ceiling point due
to some objects being in the line of sight. In this case, point the
telescope to the floor instead.

« Tap Accept to accept the displayed deviation. The solid laser
pointer is switched on to show the point position.

6. Tap Store to store the measured point.

i~ For points on ceiling/floor/wall:

You can stake out several points automatically, using the Stakeout

List function:

»  Create a Stakeout List or activate an existing list. Refer to 2.6
Managing Stakeout Lists.

« To display the Stakeout List toolbar, select Stakeout List from
the toolbox.

« In 5" or 7" display mode, activate Multiview and Stakeout Point
List to display the point list and the map side by side.

«  Select Auto Staking from the toolbox.

»  Select the first point in the list and tap Start.
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11.8

i~ For points on wall:
You can stake out several points on a wall automatically, using the
Stake to Wall function:

Configure the Measure bar to show Stake to Wall.

If Stake to Wall is active, all points are staked out on a wall. If
inactive, all points are staked out on the ceiling/floor.

Select a point, turn the telescope to the desired wall and start
the measurement. The selected point is projected to the existing
wall.

Select Stake to Wall in the Measure bar. The wall is defined by
the first two measurements and iterated with every new meas-
urement.

To finish staking to a wall, select Stake to Wall in the Measure
bar again.

Layout Objects

General description

Layout objects step-

by-step

S

The Layout Objects application allows you to import IFC files, including the
IFC attributes of the contained objects.

Based on the imported object models, the application allows you to lay out
corner points or edges of an object.

Given:

iCON site requires an additional license to use this application.

Sensor is connected and setup with known station and height.
IFC file with objects is available within the current job. Refer to Importing
data to the project step-by-step.

1.

Select Layout Objects from the Home Menu. -

Map screen is displayed. 5

=

The Layout Objects application is not
available when using the iCON software
on the iCON iCR80 or on an iCB.

Tap an object in the map view to select it. It is possible to select

multiple objects.
Tap Clear to deselect all selected objects.

I Alternatively, use the IFC Tree View for object selection. Refer to

Using IFC Tree View step-by-step (1.4.7 Special Options for IFC Files).
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Selected objects are highlighted in blue in the map
view and in yellow in the tree view. The displayed
corner points and edges of the objects are simu-
lated and serve only as reference for layout.

Select additional objects, point, line or

arc to layout

Basic Wall:Default Wall:
307819

Basic Wall:Default Wall:
319685

Basic Wall:Default Wall:
319743
Basic Wall:Default Wall:
319907

Basic Wall:Default Wall:
319992

Basic Wall:Default Wall:
320178

Basic Wall:Default Wall:
320297

Basic Wall:Default Wall:
320383

(K81 KN | KN ES IS RS ES| S

B3 ifewindow

e

For cylindrical objects such as pipes or columns, the following points

and lines are displayed to simplify the layout process:

«  Centreline of the object

«  Four lines representing the outer edges of the object.

e Start, end and centre point of each line

For rectangular objects such as walls, slabs or windows, the following

points and lines are displayed to simplify the layout process:

« Lines at the edges and centrelines of each surface

«  Centre points of each line

«  Centre points of each rectangular surface

e Centre point of the 3D shape

== If the shape of a rectangular object is for example inter-
rupted by holes or windows, only the corner points and
lines at the edges are displayed.
3. Select a corner point, centre point or edge of an object to be laid

out.
To lay out several points in sequence, select Stakeout List from the
toolbox. Refer to Stakeout List function.

I Attributes of the object to be laid out can be transferred to the

point information. Tap Attribute Info Config ‘?/ from within the Map
Handler>View panel and configure the attribute information. See
also: Displaying IFC attributes in the information bar. When you lay-
out the point the attribute information will be copied to the point
information as configured.
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= Activate Multiview and Stakeout Point List to display the point list
and the map side by side. It is possible to select the points for laying
out.

4. Follow the guidance to navigate the target to the selected point.
Once the target is within tolerance, it changes colour to green.
To store the selected point, press Store. Mark the laid out position
(in the field).

i..nt_0 Basic
© Basi..nt_1 Basic...0.ifc
© Basi..nt_2 Basic...0.ifc
© Basi..nt_3 Basic...0.ifc

© Basi..nt_4 Basic...0.ifc

© Basi..nt_5 Basic...0.ifc

X X X X X X

© Basi..nt 6 Basic...0.ifc

5= Define Measure Mode in the Status bar.

== GPS and Robotic Total Station approach:
As the target moves around, real-time measurement data and guid-
ance information is constantly displayed in the Information bar.
Once the point in the screen turns green, the point is set out within
tolerance. To record points using the Total Station, press Store. If
using GPS, press Measure.

Shift a control line 1. Select Layout Objects from the Home Menu. -
onto an IFC object Map screen is displayed. iz
= The Layout Objects application is not

available when using the iCON software
on the iCON iCR80.

2. iCON site: Tap the Favourites key and select
Setup.
iCON build: Tap the Setup key.

3. In the section Control Line select Anywhere.

4. Level instrument, then tap the next Wizard step i to proceed.
Map screen is displayed.

5. Follow the guidance to measure start and end point of the control
line.

A preview of the control line is displayed.

6. To shift the control line onto an IFC object, tap Shift.
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7. «  Select an IFC object and select a point of the object to define it
as alternative origin of the control line.
«  Select another point of the same or a different object to define
the direction of the control line.
«  Enter shift values in the Toolbar. To measure a Shift, press
Measure.

Enter or measure a Shift
Select point for alternative origin

8. .
Tap to toggle the orientation of the control line between north
and east.
Tap to cancel the shift of the control line.
Tap to confirm the shift.
9. Tap « to accept station position.
Stakeout List func- Within the Layout Objects application, the Stakeout List function allows you
tion to add points of the selected objects to the Stakeout Point List.

Stakeout List toolbar

Toolbar but- Description
ton

Tap this button to select all available points of the selec-
ted objects.
= The number of points available for selection is
defined by the number of selected IFC objects.

Tap this button to start the Window Selection mode.

This mode allows you to select or deselect several points

at once instead of tapping each of them separately. All

object points and other points located within the defined

selection area can be selected or deselected.

« Define a selection area by tapping as many points as
desired for the area corners.

e Tap ¢ to add the points within the selection area to
the point selection.

Activate I& and tap ¢ to deselect the points
within the selection area.
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Toolbar but- Description

Tap this button to deselect all selected points.

Tap this button to cancel.

Tap this button to add the selected points to the Stakeout
Point List.

|l | & 2

i In 7" display mode, activate Multiview and Stakeout Point List to
display the point list and the map side by side.

1. Tap an object in the map view to select it.
2. To display the Stakeout List toolbar, select
Stakeout List from the toolbox.
3. Use the Stakeout List toolbar to select points. Tap ¥ to add the

selected points to a new or existing Stakeout Point List.

Following screen is displayed:

m Create new or add to existing stakeout point list

‘New List1 ‘

Existing stakeout lists

] list1 11.12.2017 - 09:51:52
B list 2 11.12.2017 - 09:52:27
& list 3 11.12.2017 - 09:52:52

How to Stake Out +[@3 237



4. = To return to map view without creating a stakeout list for
the created points, tap Back.

+ To add the points to a new stakeout list, enter a name and

tap ¢.

« To add the points to an existing stakeout list, tap the respective

row in the list.

A message is displayed, informing about the number of points added
to a new or existing stakeout list.
Tap OK to return to map view.

11.9 General Stake Out Toolbox Functions + [
Description General
Function Description
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Stake Elevation

Stake out with reference to a height, which is

defined:

« by selecting an existing point,

- by entering the height directly,

« by selecting an area. The reference height
is automatically calculated to the balanced
height of the area.

Cut/Fill values in the Information bar are altered

according to the reference height applied.

Side View is a kind of cross-section view and

only available when using Stake Elevation.

Reference
Height

Stake out elements (points, lines, arcs) with ref-

erence to a height, which is defined:

« by selecting an existing point,

- by entering the height directly,

e by selecting a surface. The selected stake
out element is projected to the surface and
the reference height is set to the height
value of the surface.

Cut/Fill values in the Information bar are altered

according to the reference height applied.

Refer to 11.4 Stake Out Points, Lines, Arcs with

Reference to a Height .

Reference

Stake elements with reference to a line.

Flip

Switch the start point and end point of the act-
ive line.

Chainage

Activates the use of chainage.

Divide & Offset

Divide a line or arc into segments.

When using this function the Offset feature is
available as well. Therefore a line or arc can be
divided into segments and the segment points
be offset in one step.

Refer to Use Divide & Offset step-by-step.
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Function

Description

Offset

Offset an element to be staked.

Connect Points

Tap points to create a line between these
points.

Create Arc

Tap points to create an arc to be staked.

Create Point /
Line

Allows you to create a point or line by defining
direction and slope.

New Point

= Hr

Insert a point into the map by entering the
required coordinates or by scanning a QR-code.
This point can then be staked. The new point
can also be defined as Control Point.

o]

To start the QR-code scan tap
See also: Importing data using QR-
Scan step-by-step

Edit Point

After selecting a point from the map, permitted
values can be edited.

Auto Point
Selection

Set this option to On to have the next point to

stake selected automatically by the instrument

according to the settings:

+ Next from list: the next point from the list
of points to stake is selected automatically.

+ Nearest: the point closest to the last
staked point is selected automatically.

+ Nearest from list: the point from the list
that is closest to the last staked point is
selected automatically.

Stake Writer

Enable this option to get guidance on marking of
the stake.

For further details refer to: Using Stake Writer
step-by-step

Stakeout List

To use the Auto Point Selection function to
stake points automatically, it is necessary to
define the list of points using Stakeout List
first.

I With Multiview active, use Stakeout

Point List to get the points to be
staked displayed. It is possible to
select the points for staking out from
the list.

Undo

Undo previous action.

Delete

Remove points/lines/arcs.
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Layout Objects

Function Description
Object Info = Display the IFC attributes of a selected object.
e I If multiple objects are selected, this

function is not available.

Parallel Offset Offset a line to be set out.
\

Perpendicular A Create a perpendicular line to be set out.
Line |
AN
11.10 Information Bar Values 3 + @3
Description Type/lcon Description
Id Point ID of the stakeout element.

D)

East value of the last point measured.

North value of the last point measured.

Cut/Fill Cut/Fill value of the last point measured, com-

pared to the stakeout element.

H n Height of the last point measured.
Al

Chainage Chainage at the measured point along the selec-
ol ted reference line. With no reference line, the
value shows the chainage at the measured point

along the selected line.

dL Horizontal distance from the last point measured
to the stakeout point.

dLin Perpendicular distance from the last point meas-
ured to the north heading at the stakeout point.

dOff Perpendicular distance from the last point meas-
ured to the east heading at the stakeout point.

Lin Horizontal line value (2D) from the measured
point along the selected line.

Lin3D 3D line value from the measured point along the

selected line.
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Type/lcon

Description

Off

Offset value at measured point to the selected
line.

Proj.Lin

Line value at measured point along the selected
reference line.

Proj.Off

Offset value at measured point to the selected
reference line.

Proj. H. Diff

Height difference at measured point to the
selected reference line.

Reference-
Height

Reference height for staking out, that is defined
by entering a value or selecting a point or sur-
face.

VOff

Vertical offset value of the defined reference
surface.

Ref_Id

Reference ID of the stakeout element.

Ref E

East value of the stakeout point.

Ref_N

North value of the stakeout point.

Ref_H

Height of the stakeout point.

Ref _Lin

Line value of the stakeout point, along the
selected reference line.

Ref_Off

Offset value of the stakeout point, to the selec-
ted reference line.

Cod_Ref

Code of the reference point.

Attl_Ref

= |0 E

Attribute 1 of the reference point.

Attl0_Ref

-]
|I-:»l|

Attribute 10 of the reference point.

dHz

only: Horizontal angle between the current
line of sight and the stakeout point.
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Type/lcon

Description

Hz

only: Horizontal angle to the current target

measured point to the selected line. A negative

position.

Vv i only: Vertical/zenith angle to the current

‘ﬂ}@f target position.

sD ; only: Slope distance from the instrument to
the last point measured.

hD only: Horizontal distance from the instru-
E ment to the last point measured.

cQ 1D €A only: Coordinate quality value for the height
! information at the current position.

cQ 2D i [ only: Coordinate quality values for the plain
information at the current position.

cQ 3D ; LA only: Coordinate quality values for a com-

ﬁ*ﬁ bination of the height and the plain information

5 at the current position.

Gbop 8 only: Geometric dilution of precision quality

value at the current position.

ISlp Indicates the long slope at the measured point.

m Negative means down sloping in the line direc-
tion.
sSlp @ Indicates the side slope (cross slope) at the

value means downward sloping from the meas-
ured point to the selected line.
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12 How to Stake Out Surfaces gg @8
12.1 General Information + [

General description

How to stake out sur-
faces step-by-step

A Digital Terrain Model (DTM) can be staked for height values. The heights of
the measured positions are compared with the heights of the Terrain Model at
the same position. The height differences are displayed in the Information bar
in @ Cut/Fill format.

Staking a Terrain Model can be used for:

- Staking out where the Terrain Model represents the surface to be staked.

e Quality control purposes, where the Terrain Model represents the final
project surface.

P1 Point to be
staked

dl Cut/Fill

d2 Antenna/

target height

Given:

« Instrument is connected and set up with known station and height.

e Terrain Model active within the current job. Refer to Importing data to the
project step-by-step.

=< The Cut & Fill procedure is the same as in the Stakeout application,
except the heights to be staked are taken from the selected Terrain
Model.

=< Note that main workflow refers to GPS. For Total Station press
Measure, then Store.

Cut/Fill can be carried out in three ways:
- Manual Total Station

- Robotic Total Station

+ GPS

If using Manual Total Station, the Information bar is updated after each
point is measured.

If using Total Station in Continuous Mode, or if using GPS, real time meas-
urement data is displayed automatically in the Information bar.

1. Select Cut & Fill from the Home Menu. g
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2. - Tap the required Terrain Model.
- As the pole moves across the surface, real-time measurement
data is displayed in the Information bar.
= The Cut/Fill value is colour coded, depending on whether
the height is above-grade, below-grade, or on-grade,
when compared with the Terrain Model. Refer to Cut/Fill
colour indicators for details.

3. - Record points by tapping Measure. The colour of the stored
point indicates whether the point is in or out of height toler-
ance.

- The process can repeat.

i N D N fa
8 IR = &

752 % 0.750 044 2 0.000

4, - Cut & Fill offers a Foreman View, which displays the Cut/Fill
value in large letters and digits on a colour coded background.

- To activate, access View in the Map handler and tap Foreman.

- To return to standard view deactivate Foreman the same way.

044 2. 5.000 e 1.044 %2 5.000
3.956 | ‘ 3.956

CUT

¥ 3.956

Measure

= The Cut/Fill tolerance level can be selected in Tolerances, which is
m/ft
found in Units #=%
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Cut/Fill colour indicat- Indicator Description

ors Cut Indicates that the height measurement is
above the surface design. When colour
changes to green the measured position is
within the defined tolerance but still above
the surface design.
Fill Indicates that the height measurement is
& below the surface design. When colour
changes to green the measured position is
within the defined tolerance but still below
the surface design.
On Grade Indicates that the height measurement
@ exactly matches the surface design.
12.2 Cut & Fill Grid Logging
General description The grid logging function in Cut & Fill generates a
real-time coloured grid while moving along the sur-
face. The coloured grid gives an overview of the cur-
rent surface state.
Grid colour State of the existing surface
Red Above the design surface.
Blue Below the design surface.
Green Matching the design surface.
Grey Outside the design surface.
Requirements:
«  Cut/Fill Grid can only be used with a CC80 field controller and requires a
Surface Pilot licence.
Given:
« Instrument is connected and set up with known station and height.
«  Terrain Model active within the current job. Refer to Importing data to the
project step-by-step.
Grid logging step-by- 1. Select Cut & Fill from the Home Menu.
step %ﬂ
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2. Access View in the Map handler and tap Foreman
Settings.
+ Set Generate Cut/Fill Grid to On.
«  Enable vehicle or pole mode.
Refer to 1.4.8 Foreman Settings.

3. To start the grid logging process, tap Start Grid Log.
Move the vehicle with the mounted antenna/prism along the surface.

= It is not necessary to store points, the grid is logged auto-
matically.

V| 0.00071~ 0.600

= You can pause grid logging at any time. Tap Pause Grid Log. To
resume grid logging, tap Start Grid Log again.

i When moving over surface for which a grid is already logged, the grid
refreshes dynamically based on the new values of cut and fill.

Grid preview To allow a smooth real-time update of the logged grid, the currently visible

grid is limited. To display the full grid along the whole surface, enable Grid
Preview.

a Visible grid area (90 m by 90 m)

d — around the current position

b Current position

Surface within the visible grid area
d Surface outside the visible grid area

N

b——,
C [E—

d —

16627 001

1. Select Grid Preview from the toolbox.
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The full grid is displayed.

Table shows percentage values for the
surface area (total coverage, cut, on
grade and fill). Press accept to generate
the breaklines or cancel to exit.

To exit the preview and continue with grid logging, tap L .
« To save the current percentage values of the grid for the Grid

Logging report, tap . Refer to Save data for Grid Logging
report .

To create break lines, tap v

I Break lines are the lines along the surface where the grid changes
colour. The created break lines are stored as *.geo file and are avail-
able for staking out.

Description

Percentage value of the design surface covered by
the Cut/Fill Grid.

Percentage value of the grid where the existing sur-
face is above the design surface.

Percentage value of the grid where the existing sur-
face is matching the design surface.

Percentage value of the grid where the existing sur-
face is below the design surface.

Save data for Grid

. The Save for Report function allows saving the current percentage values
Logging report

of the logged grid along with a screenshot of the grid preview. The data

and screenshot are saved in a package. Multiple packages can be saved to
document the progress of the grid logging process. These packages can then
be included in a Grid Logging report.

= For information on how to create a Grid Logging report, refer to 19
How to Create a Report .
1. To save a package for reporting, tap the Save for =
Report button in the Grid preview. =r
LA
|
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2. Following screen is displayed.

Save

‘GridLogging-20201 021211752

3. « If necessary, edit the file name of the package to be saved.

To change the screenshot to be saved, tap 2 to return to Grid
preview. Pan, rotate or zoom the map view as required, then tap
the Save for Report button again.

4 To save the package, tap v
12.3 General Cut/Fill Toolbox Functions + @3
Toolbox functions Function Description

Automatic Log- Set Autologging to On/Off. Select the Log-
ging ging Mode from 3D Distance, Distance and/or
Height, Time, or Time over a point and define

the Interval. Store on demand allows you to
record measurements anywhere in between, if

enabled.
Reference ~a Stake out with reference to a line, which is
% defined by tapping elements on the screen. Line

and Offset values are displayed in the Inform-
ation bar. These values are derived from the
North and East values of the line. The height
value is derived from the height of the Terrain
Model.

A cross section can be defined perpendicular to
the current heading based on the walking path.
To fix the calculation of cross sections based on
the last heading tap Fix Heading.

Fix Heading

Start long sec- Activates a long-section view. A long-section

tion view is similar to a cross section view but along
the current direction of movement.
== Start long section is an optional fea-
ture. For enabling, Surface Pilot licence
is needed.
Offset Vertically offset the whole Terrain Model. Cut/
Fill values in the Information bar are altered

according to the offset applied.
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Function

Description

Stake Elevation

B

Stake out with reference to a height, which is

defined:

e by selecting an existing point,

« by entering the height directly, or

e or by selecting an area. The reference height
is automatically calculated to the balanced
height of the area.

Cut/Fill values in the Information bar are altered

according to the reference height applied.

Side View is a kind of cross section view and

only available when using Stake Elevation.

Stake Writer

Enable this option to get guidance on marking of
the stake.

For further details refer to: Using Stake Writer
step-by-step

Grid Preview

Displays the full Cut/Fill Grid of the whole sur-
face.

Manage Grid
Calculations

Allows you to view and delete already created

Grid Logging calculations.

+  To view details of a calculated result, tap the
arrow button to the right.

« To delete a calculated result, tap its name to

select it, ta < to accept and confirm the
p p

deletion.
12.4 Information Bar Values +[T3
Description Type/lcon Description
Id i Point ID of the stakeout element.
1{D)
E H East value of the last point measured.
N n North value of the last point measured.
H n Height of the last point measured.
Hz i only: Horizontal angle to the current target
E’ position.
Design Design height at the measurement position.
Actual Current height at the measurement position.
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Type/lcon Description
Surface Identifier of the design surface.
v i l.f only: Vertical/zenith angle to the last point
{ﬂ[}- measured.
Lin only: Distance along the control line.
Or with a reference line selected, distance along
the reference line.
Off ™ only: Offset to the control line.
Q Or with a reference line selected, offset to the
reference line.
H. Diff ; Height difference, from the measurement posi-
I tion to the projection point on the control line.

L Or with reference line selected, from the meas-
urement position to the projection point on the
reference line.

Code =g Code/layer for the next point to record.
=

sD i only: Slope distance to the last point meas-
ﬁ ured.

hD only: Horizontal distance to the last point

measured.

Cut/Fill Cut/Fill value of the last point measured.

Chainage Chainage at the measured point along the selec-
ﬁgf ted reference line.

Proj.Lin Line value at measured point along the selected

‘N reference line.

Proj.Off Offset value at measured point to the selected

N reference line.

Proj. H. Diff Height difference at measured point to the

.i. selected reference line.

V. Offset ; Vertical offset to the design surface.
cQ1D ! GPS] only: Coordinate quality value for the

height information at the current position.
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Type/lcon Description

cQ 2D GPS| only: Coordinate quality values for the plain

information at the current position.

CcQ 3D GPS) only: Coordinate quality values for a com-
bination of the height and the plain information
at the current position.

cboep €3 only: Geometric dilution of precision quality

value at the current position.
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13 How to Use Verification

13.1 General information
Necessary licence To use this application, the Verification licence must be active.
Verification The Verification application allows you to use surfaces, objects, point clouds

or patterns as a reference and compare them to measured (as-built) surfaces,
objects, point clouds or patterns.

For example, you can scan a floor and compare the measured surface against
the design surface of the floor.

To create point clouds for verification, you can use the Leica MS60 as a
scanner together with iCON or import point clouds from other sources. To
create grid scan point clouds or surfaces based on a point grid, you can use
an iCB/iCR or iCT together with iCON. Refer to How to Collect Data Using
Scanning .

The verification result is a graphical map, indicating
by colour the points where the as-built data corres-
ponds with or deviates from the design data. The
colour coding is according to the defined tolerance
and colour settings.

Refer to Tolerance settings and 13.3 Scale Options.
The verification result can be exported as a report.

The software creates extrema points for out-of-tolerance areas, and con-
tour lines to delimit the areas within and outside the tolerance. Contour
lines for areas above the tolerance are coloured red, contour lines for areas
below the tolerance are coloured blue.

Extrema points and contour lines can be stored in the database, in order to
stake out the points and areas which need to be reworked. Contour lines can
be staked out as polylines in the applications Stakeout and Layout Lines.

13.2 Verification Mlethods

Verification methods There are three different methods to verify data:

1. Verify already measured data without a reference
Select the measured data to be verified. The software automatically cre-
ates a verification plane using the average of the selected data, and com-
pares it to the selected data.
Refer to Verify data without a reference step-by-step.

2. Verify already measured data using a reference
Select the measured data to be verified, then select the reference data.
The software compares the selected data to the reference data.
Refer to Verify data using a reference step-by-step.

3. Define a reference and start measuring to verify data
Select the reference data, then start to measure points. The measured
points are directly compared to the defined reference data.
Refer to Verify data while measuring step-by-step.
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Verify data without = Make sure that the data to be verified is active within the current

a reference step-by- job.

step To reduce the amount of visible data, use the layer manager or
visibility filters.
See also: Reducing the Number of Visible Elements/Objects in Map
View

1. Select Verification from Home Menu.

Select data to verify or tap ref. button for The tOO/bar for Veri_
fcation is displayed

2. To select the data to be verified, tap at least three single points, a
point cloud or a grid-scan point cloud.
«  To select multiple points quickly using the Window Selection

©

mode, tap =4

« To add more data to the already selected data, tap the respect-
ive elements in the map. To deselect data, tap the selected
elements again.

To deselect all selected data at once, tap .

Select more data to verify, a reference or Selected data are
highighted in blue

colour.

2

When all data to be verified are selected, tap v

The software automatically creates a verification plane using the
average of the selected data.

A preview of the verification result is displayed, with the selected
data being compared to the verification plane.
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The heatmap shows
the verification plane
with the result over-
laid.

A quantity indicator
shows the percent-
age of the points in
tolerance and out of
tolerance, above and
below the verification

Change verification plane or Choose a
reference object

" To define another reference than the verification plane, tap . For

information on how to define a reference, refer to Verify data using
a reference step-by-step.

= To change the settings of the colour scale or the tolerance settings,
tap and hold the scale. Refer to 13.3 Scale Options.

4. « To define the orientation of the reference plane, tap the
respective toolbar button:

) mVertical
) EHorizontal

) Tilted
The preview is updated accordingly.

To return to the previous step, tap x .
«  To store the verification result, tap Store.

The Save screen is
displayed.

Save

‘ Verification_20211107202618 ‘

Extrema Points and ContourLines for

Layout
D Save Heatmap result point cloud

5. « If necessary, edit the file name.
« To store extrema points and contour lines, activate the respect-
ive checkbox.
« To store the heatmap result as a coloured point cloud, activate
the respective checkbox.

To return to the previous step, tap X .

To accept and store the verification result, tap v

I To export the verification result in a report, return to Home Menu
and select Reports. Refer to: 19 How to Create a Report .
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Verify data using
a reference step-by-
step

Make sure that the data to be verified is active within the current
job.

To reduce the amount of visible data, use the layer manager or
visibility filters.

See also: Reducing the Number of Visible Elements/Objects in Map
View

Select Verification from Home Menu.

Select data to verify or tap ref. button for The tOO/bar for Veri-
fcation is displayed.

To select the data to be verified, tap at least three single points, a
point cloud or a data base.
+ To select multiple points and point clouds quickly using the

Window Selection mode, tap

+ To add more data to the already selected data, tap the respect-
ive elements in the map. To deselect data, tap the selected
elements again.

To deselect all selected data at once, tap .

Select more data to verify, a reference or Selected data are
highighted in blue

colour.

To define a reference for verification, tap ()
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The toolbar changes
to display the
options for reference
selection.

Reference data is
highlighted in orange
colour.

4, There are several options to define a reference:

« Tap a surface, object or point cloud to define it as reference.

« To define horizontal reference planes, select or measure a
single point or enter a height value.

+ To define a vertical reference plane, select or measure two
points. The orientation of the plane is defined by the line
through these points.

+ To define a tilted reference plane, select or measure three
points. The points can be measured points, surface points,
points on IFC objects or points from any imported point file.

More options:

To shift a vertical or tilted reference plane, tap and enter
the shift parameters.

To clear the defined reference, tap .
« To return to the previous step and select more or different data
A

o
[ Banp=?

to be verified, tap i&

To accept the defined reference and continue, tap v

The verification result is displayed, with the selected data being com-
pared to the reference data.

The heatmap shows
the reference object
with the result over-
laid.

A percentage indic-
ator shows the per-
centage of the points
in tolerance and out
of tolerance, above
and below the refer-
ence data.

I To change the settings of the colour scale or the tolerance settings,
tap and hold the scale. Refer to 13.3 Scale Options.

6. .

To return to the previous step, tap x .

To store the verification result, tap v
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The Save screen is
displayed.

| Verification_20211107202811 |

Vv Extrema Points and ContourLines for
Layout
Save Heatmap result point cloud -

7. « If necessary, edit the file name.
« To store extrema points and contour lines, activate the respect-
ive checkbox below the preview.
«  To store the coloured heatmap result as point cloud, activate
the respective checkbox below the preview.

To return to the previous step, tap b .

To accept and store the verification result, tap v,

I To export the verification result in a report, return to Home Menu
and select Reports. Refer to 19 How to Create a Report .

Verify data while = Make sure that the data to be verified is active within the current
measuring step-by- job.
step To reduce the amount of visible data, use the layer manager or

visibility filters.
See also: Reducing the Number of Visible Elements/Objects in Map

View
1. Select Verification from Home Menu.

The toolbar for Verification is displayed. @
2. To define a reference for verification, tap

By

[La] @@} = Select data to verify or tap ref. button for The .tOO/bar Changes
retrnes to display the

options for reference
selection.

A

@::

How to Use Verification 257



3. There are several options to define a reference:

« Tap a surface, object or point cloud to define it as reference.

« To define horizontal reference planes, select or measure a
single point or enter a height value.

« To define a vertical reference plane, select or measure two
points. The orientation of the plane is defined by the line
through these points.

+ To define a tilted reference plane, select or measure three
points. The points can be measured points, surface points,
points on IFC objects or points from any imported point file.

More options:

To shift a vertical or tilted reference plane, tap and enter
the shift parameters.

To clear the defined reference, tap .

4. .
To accept the defined reference and continue, tap v
eI 20000 Map view changes to
: 42171+ 1.8200 Mmeasure mode.
7z 2.343 Configure the meas-
ure bar as needed.
(o |2 0
5. Measure and store as many points as desired.

The colour of the measured points indicates the deviation from the
defined reference. The info panel displays the point coordinates and
the perpendicular distance to the reference.

To select a different reference, tap X

To close the measure mode, tap v

= To export the verification result in a report, return to Home Menu
and select Reports. Refer to 19 How to Create a Report .

13.3 Scale Options

Define scale colours = To access the colour scale settings, tap and hold the colour scale in
and tolerance set- the result screen within the Verificationapp.

tings

Define the scale colours and the tolerance settings to be used for verification
in the screen Scale Options.
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Scale Options

Verification Colour Scale Tolerances Setting

Simple

Precise 0.008
Simple Alternative Medium 0.016
Advanced Tolerant 0.080

Advanced Alternative

Verification Colour Scale

« Simple
This scale has three colours according to three value ranges, with green
representing the values within the desired tolerance range.

« Simple Alternative
Same as the simple scale, but with alternative colours for colour-blind
people.

+ Advanced
This scale has seven colours according to seven value ranges, with
green representing the values within the desired tolerance range.

« Advanced Alternative
Same as the advanced scale, but with alternative colours for colour-
blind people.

== The default setting for colour scale is Simple.

Tolerances Setting

Select from the three pre-defined tolerance sets: Tolerant, Medium or
Precise. If available, select a user-defined tolerance set.

To change the tolerance settings, refer to Tolerance settings (in chapter 2.7
Settings).
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14 How to Stake Out Roads g +@3

14.1 Stake Out Road Lines +[@3
General description = The Roading application is used to place marks in the field along pre-

determined road lines or cross-sections. These predetermined road
lines are the lines to be staked.

PO Known

station
P1 ... Layout line
006792 001 a Offset

The road lines to be staked can be uploaded as a file to a project. Refer to
Importing data to the project step-by-step for more information.

This chapter explains how to stake out road lines using GPS and Total Sta-
tion.

Given:
« Instrument is connected and set up with known station and height.
« Road model active within the current job. Refer to Importing data to the
project step-by-step.
= Note that main workflow refers to Total Station. For GPS press
Measure to record a point.

= Roading is an optional application for the CC80 controller. Ask your
agency or your Leica Geosystems representative for information
about licensing.

Stake out road lines 1. Select Roading from the Home Menu. HHJ

2. - Map screen is displayed. Select the road line to stake, then
follow the guidance to navigate the target to the road line. Once
the line is defined, press Start.

- Once the target is within tolerance, it changes colour to green.
Press Store.
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2520 v, 0.139
3.462

Start Freeze Point ID Freeze Point ID

3. Mark the staked position (in the field).

1= This process can be repeated along the same line. To stake another
line, tap the preferred line, and continue the process.

14.2 Stake Out Cross-Sections + @3

General description

PO Known
station
P1 .. P9 Point to
be
staked

Given:

« Instrument is connected and set up with known station and height.
« Road model active within the current job. Refer to Importing data to the
project step-by-step.

= Note that main workflow refers to Total Station. For GPS press
Measure to record a point.

Stake out cross-sec- 1. Select Roading from the Home Menu.
tions step-by-step ﬂi

Map screen is displayed.
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Select the road line
to stake, then follow
the guidance to nav-
igate the target to
the road line.

Store Freeze Point ID

CIEIESESE

Once a measurement is available, select
Cross Section view from the Map Handler. ﬁa

The view mode
changes into cross-
= Theoretic section. The target
o is shown against the
current cross-section
of the selected road

\ .
ﬂ\o_s_, / model.

Store Freeze Point ID

To change view mode back to map view, deselect Cross Section
view from the Map Handler.

If a cross-slope ele-
ment is selected the

09 v 1.611
- dc. -3,378 | ast )

De
mo

pole icon shows the = Theoretic
Cut/Fill colours. If it

a point is stored i
it is colour coded 7 7
based on Cut/Fill col- ‘ \_8_/

our and tolerance \”—8—’— i

settings. 7

Store Freeze Point ID

To fix the heading
in the cross-section

view, tap

EIEIENENEE

To select cross slopes directly from the map, enable Road Shading
in Viewing Options.

To offset an individual string line or a cross-
slope select Offset Element.

Select the element required for offset, then enter an Offset value.

Use Flip to switch the offset value from positive to negative.
P
Tap in order to define a vertical offset for the element.

To define a perpendicular offset tap .
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S
£3 0.500 | IS

Tap v to accept.

14.3 General Roading Toolbox Functions +[@3

Description Function

Description

Divide & Offset

Divide a line or arc into segments.

When using this function the Offset feature is
available as well. Therefore a line or arc can be
divided into segments and the segment points
be offset in one step.

Refer to Use Divide & Offset step-by-step.

Active Layer

Select the active layer of the current active road
line model.

Centerline

Allows the user to change the centreline of the
road model. The result is @ new XML road model
based on the new centreline.

You can switch between both road models by
selecting one or the other *.xml file via the Map
View Manager.

Offset

Offsets the whole model by entered value.

Create cross
section

Create cross-sections using different methods.

Offset Element

Offsets the selected element, for example cross-
slopes or individual string lines, by entered value
in map and cross-section view.

Fixed Slope

Hold and extend the slope of a selected cross-
slope element.

Define Corridor

Corridor function for cross-sections. Define the
limiting values of the corridor.

= Cross-section calculation is restrained

by the defined corridor.

= Useful for curvy roads.
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Function Description

Create Road Convert exisiting reference data into a roading
file.

Resulting file format: *.xml

Refer to Convert reference data into a roading

file step-by-step.

e

Stake Writer Enable this option to get guidance on marking of
the stake.
For further details refer to: Using Stake Writer

step-by-step

[=

Undo @ Undo previous action.

Delete Remove points/lines.
Convert reference Road alignments in DXF format cannot be used by the Roading application or
data into a roading by Leica machine control software platforms.

file step-by-ste
P=bY P The Create Road tool allows you to convert existing reference data into a

roading model.

The created road file can be exported to a USB stick or to Leica ConX for
transferring to other field controllers or to Leica machine control systems.
(Refer to 2.2 Import, Export, or Delete Data.)

== Given:
Reference model is active within the current job.

Map screen is displayed.

2. Select Create Road from the toolbox.
(&)

3. Follow the Wizard steps.

1. Select Roading from the Home Menu. ﬂﬂ

®%50.000
Define direction and chainage

N A
AN

Select a line to be used as road line. If necessary, define direction
and chainage of the road line in the toolbar.

Tap the next Wizard step m to proceed.
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Select a reference file to convert the lines into road stringlines.
If no reference file is selected, the software creates a road line in
* xml format. If a reference file is selected, the software creates a
road model in *.xml format.

Tap the next Wizard step m to proceed.

Select individual lines for the road creation. To ensure that all selec-

ted lines have the same start-end point direction, tap .

Select a surface to perform a vertical transformation.

Vertical transformation is optional; it allows shifting the model to an
existing surface when the reference file has zero or no height inform-
ation. If vertical transformation is not required, proceed without
selecting a surface.

Tap « to proceed.

If necessary, change the file name.
Tap ¢ to convert and save the roading file.

14.4 Information Bar Values + [
Description Type/lcon Description

Point ID of the last point measured.

D

East value of the last point measured.

North value of the last point measured.

Height of the last point measured.

Cut/Fill

Cut/Fill value of the last point measured.

@fl=J =]

Chainage

Indicates the chainage of the measured point on
the centreline.

only: Horizontal angle to the last point
measured.

only: Vertical/zenith angle to the last point
measured.

only: Slope distance to the last point meas-
ured.

only: Horizontal distance to the last point
measured.
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Type/lcon Description

iCh ; Indicates the chainage of the measured point on
(Y the selected stringline.

dCL ’ Indicates the perpendicular distance from the
fi[MB centreline to the measured point. A negative
L value means that the point is to the left of the
line.
dsL ; Indicates the perpendicular distance from the

stringline to the measured point. A negative
value means that the point is to the left of the
line.

s
w
-

Indicates the cross section slope at the meas-
ured point. Negative means sloping down from
the road centreline.

sSlp

ISlp Indicates the long slope at the measured point.
Negative means down sloping in the line direc-

tion.

Inner distance. Indicates the distance from the
measured point to the inner edge of the current
element (the edge closest to the centreline).

Din

Outer distance. Indicates the distance from
the measured point to the outer edge of the
element (the edge most far away from the
centreline).

Dout

sdi Indicates the sloped distance from the measured

point to the inner edge of the element.

Sdo Indicates the sloped distance from the measured

point to the outer edge of the element.

dHix Side distance to the point in the current chain-
age where current height intersects the theor-
etic road profile. For example, useful when build-

ing up a road bank.

Layer ’ Indicates the layer of the stringline model that is
used as a reference.

dHSL Indicates the height difference at the meas-
ured position to the selected stringline. Negative

means above, positive below the stringline.

Offset Model Indicates the applied vertical offset value.

HHLE

Offset Element Indicates the applied vertical offset value.

-,
m
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Type/lcon

Description

dHPO

Perpendicular height difference from the meas-
ured position to the slope. A negative value
means that the measured position is above the
design.

cQ 1D

GPS| only: Coordinate quality value for the
height information at the current position.

cQ 2D

GPS] only: Coordinate quality values for the plain
information at the current position.

cQ 3D

GPS] only: Coordinate quality values for a com-
bination of the height and the plain information
at the current position.

GDOP

GPS| only: Geometric dilution of precision quality
value at the current position.

How to Stake Out Roads + @3

267



15 How to Use Differential Milling @g

General description Differential Milling allows you to carry out milling tasks by using a GPS/
GNSS antenna and the CC80 field controller in the following way:
«  Mount the antenna on the milling machine.
«  Connect the iCON software to the antenna and configure the milling
machine.
e Load the design surface or road.
+ Load the existing surface (as-built).

The software calculates the left and right cut values and the cross slope of the
design model at the current GPS/GNSS position as well as ahead of the milling
machine.
5= If the drum width is shorter than the machine width, mount the GPS/
GNSS antenna within the drum width.

18396001

a Drum position
b GPS/GNSS antenna position

Requirements:
«  Differential Milling can only be used with the CC80 field controller running
iCON site software and requires a Milling Pilot licence.

Given:

+  GPS/GNSS antenna is connected to the iCON site software.

« A coordinate system is loaded to the project.

«  For Roading: A road model and a surface are loaded in the project.
For Cut & Fill: Two surfaces are loaded in the project.

Milling step-by-step 1. Select Cut & Fill or Roading from the Home Menu. E E
2. Access View in the Map handler and tap Foreman T
Settings. &
|
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= For information on the available settings, refer to section Milling

machine mode.

«  For the icon type, select Milling Machine.

«  The maximum cutting depth value is empty by default. If no value
is entered, the height deviation is not checked.
If necessary, enter the maximum cutting depth of the milling
machine.
If the height deviation is greater than the defined cutting depth,
a warning is displayed in milling view.

« Define the Vehicle Configuration settings. Make sure to enter
the correct dimensions of the milling drum.

Tap « to accept the settings and return to the map.

= When using the Cut & Fill application, import two surface files (*.trm,
*.dxf or *.xml), one for the existing surface and one as design
information.

== When using the Roading application, import a surface file (*.trm,
*.dxf or *.xml) for the existing surface and a road model (*.Imd or
*.xml) as design information.

3. To activate the existing surface and the design
surface or design road, select Differential Milling [@
from the toolbox. .

The "Differential milling" screen is displayed.

Differential milling

T e
Design road Selectroad  Station interval 2.000 ‘
Existing surface Select surface

Offset design road 2 0.000

Offset existing surface | ¢ 0.000

4. « Tap Design surface to load the terrain model of the design road
surface.

« Tap Existing surface to load the terrain model of the existing
road surface.

« If necessary, enter a vertical offset for the loaded terrain mod-
els.

« Define the Station interval. This value defines the distance
interval for which the software calculates the next cut and cross
slope values. The map scale is adapted to the entered value.

Tap « to accept the settings and return to the map.
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The map is displayed in Milling view.

#18.373 «._0.036
$1 0.020 ¥ 0.025
-2.508

% -2.508 ||W/| 0.016 |0 V| 0.018 |

Measure | PointlD

I

= In Milling view, the map is not interactive. To allow for interaction,
activate Multiview. Refer to section Multiview.

5. Drive the milling machine along the surface.
The software constantly calculates the left and right cut values and
the cross slope value of the design road surface at the current
machine position. In addition, the software calculates the values at
two further positions ahead of the machine, each at the distance of
the defined station interval.
These predicted points are fixed in position, as if they were spray
marks from a surveyor. However, you can configure the information
bar to show real-time values ahead of the machine that update as
you drive. Refer to the next section Information bar values.
For instructions on how to configure the information bar, refer to the
section Information bar.

> gl Al

18235001

a Model of design surface
b  Model of existing surface
c Station interval

6. To exit Milling view, select Differential Milling
from the toolbox. Tap reset |« and tap ¢ to m
accept. B

Cut value indication in map view:

V| 0.021 |

Cut down the existing surface by the displayed cut value.
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Automated Differen-
tial Milling

The cut value is greater than the defined maximum cut-
M ting depth. The area has to be milled again.

Existing surface matches the design surface.
®)| o0.000

[ Milling is not possible, as existing surface is below the
&‘ 0.017 design surface. A warning is displayed in the information
bar.

If the cut value cannot be calculated, the field for cut
2'3‘ value is left empty.

Using automated differential milling, iCON site sends the Cut and Cross Slope
information directly to the Machine Controller.

Automatic Milling is available for the following Wirtgen machines:

e Large Milling machines with LevelPro Il controller 2011-2019y, W200-
W250 models

e Large Milling machines with LevelPro Active controller 2019>, W200-
W250Fi models

«  Compact Milling machines with LevelPro Plus controller 2018>, W100-
W150 models

1. In order to configure the connection to the B_T
Milling machine select Devices from the
Home Menu.
= Assumption is that the controller

is already connected to the posi-
tioning sensor.

" @ »
Ta p a nd SE|ECt Profiles m New Profile
AUX| | |a F\/ DEVI ces. Positioning Devices - Positioning Devices >
Aucxiliary Devices 14
3. Select CAN Bus and ,
Profiles New Profile
tap ¥ to establish Pesiioning bevess e
connection to the Modet: cANBus b
d eVI ce. :_ i EAERD Profile Name: CAN ‘
X .
|
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Information bar val-
ues

272

Tap J to add the Profiles
device to the list of
active profiles.

Communication
=~ iCG60 Read only Mode Simulation »
g; iCR70 3213678
CANIlink wireless 235

ST

Connection is established via Bluetooth.

0016 | & W
;
-3.001 |

0.016

The status bar shows

the @ icon when
connected.

¥ 0.016 ¢ 0.016
% -3.001

When there is an error in the connection the icon turns to “’*‘.

== The activation of the Automatic Milling mode is done on the Wirtgen
Machine Controller.

Type/lcon

Description

Cross Slope

B
-
.
-

position.
5

Cross slope angle of the design model at the current

Depending on the current active setting
for slope display, this value may also be
displayed as H:V, V:H or %.

Left Cut/Fill

Left Cut/Fill value over the current position. The

g value is calculated from the difference of the exist-
ing model to the design model.
Right Cut/ =D Right Cut/Fill value over the current position. The
Fill v value is calculated from the difference of the exist-
ing model to the design model.
Next Cross ~ (Calculated cross slope angle of the design model
Slope Aib ahead of the machine at the distance of the defined
station interval.
Next Left P Calculated left Cut/Fill value ahead of the machine at
Cut/Fill VA the distance of the defined station interval.
Next Right = Calculated right Cut/Fill value ahead of the machine
Cut/Fill Av at the distance of the defined station interval.
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Type/lcon

Description

Next* Cross

Calculated cross slope angle of the design model
ahead of the machine at twice the distance of the
defined station interval.

Calculated left Cut/Fill value ahead of the machine at
twice the distance of the defined station interval.

Slope B.__'L;
Next* Left P

Cut/Fill VB
Next* Right =
Cut/Fill Bv

Calculated right Cut/Fill value ahead of the machine
at twice the distance of the defined station interval.
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16

How to Handle Volumes g3 + @3

16.1

Create a Surface +[€3

General description

Create a surface step-

by-step

274

Measuring a stockpile surface for volume calculation

006783.001

P1la, P1D, ... Boundary points
P23, P2b, ... Surface points

Measuring a surface with the use of breaklines

21550_001

Surface
Boundary point
Boundary
Breakline point
Breakline
Surface point

D anNn oo

I Requirements for creating a surface by measuring points:
« Instrument is connected and set up.

I Requirements for creating a surface with existing points:
«  Map contains the points for the surface creation.
«  Only points with an elevation can be used for the creation of
surfaces.

== The main workflow refers to GPS. For Total Station press Measure,
then Store.
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1. Select Volumes from the Home Menu.

2. Select New Surface from the Toolbox.

The toolbar for sur-
face creation is dis-
played in map view.

Measure Point ID Code

Tap to activate Window Selection mode.

Tap to deselect all points.
Tap to create a boundary.
Tap to create breaklines.

Tap to cancel surface creation.

Tap to finish surface creation.

3. To define the new surface, measure as many points as required or
tap existing points in the map to be included in the surface.

= only: To setup the instrument in another location, for example
in order to measure further points behind a stockpile, tap the Setup

key I% from favourites container ﬁ The Station Setup screen
opens. Refer to 4 How to Setup a Total Station for information
about station setup. After the station setup is complete, the soft-
ware returns to the Volumes application and measurements can be
continued.
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4. To select several eX|st|ng points at once instead of tapping each

one of them, tap LZ2&
The toolbar for W/ndow Selection is displayed.

14 13 ! 1@ 13

s @

e | @
e @ a | e @ @
v © @ © © I © @ @ ©
RO OO0 4 ! RO OO0 4
©ps o © » Oys o ©
® 00 @ ] ® 060 @
- °QO L. GQQ /
:6!) 5% ag @
a @, @ u ©,; ©
OG G oa &
@ © ®@ ©
(0] (0]

» Define the selection area by tapping as many points as desired
for the area corners.

To deselect several points, activate 15k
define the area for deselection.

To cancel Window Selection, tap X

To accept the selection, tap v
All points inside the defined area are selected automatically.

To define a boundary, tap Eadl.

The toolbar for boundary creation is displayed.

«  Measure points or tap relevant points on the screen to connect
all boundary points.

e To close the boundary, tap the start point again.

To clear all boundary points, tap .

To discard any changes of the boundary, tap X .
« To stop the boundary line and start it over another point,

tap SR
«  To finish the boundary and return to surface creation screen,

v -1.2000 Played in orange col-
our.

Open boundary
points are high-
lighted by an orange
box:

LZHEI

" 1'600I The boundary is dis-

Measure Point ID Code

-—-
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6. . i
To define a breakline, tap K=l

The toolbar for breakline creation is displayed.
«  Measure points or tap relevant points on the screen to connect
all breakline points.

To clear all breakline points, tap .

To discard any changes of the breaklines, tap 2 4 .

To stop the breakline and create a new one, tap .
« To finish the breakline and return to surface creation screen,

v -1.2000 Played in green col-
our.

- 1'600I A breakline is dis-
)

" —

Measure Point ID Code

== During surface creation, you can also use the following tools from
the Toolbox, if needed:
+ Automatic Logging
This tool allows you to densify the surface by automatically
measuring surface points. Refer to 7.4 How to Store Points
Automatically .
+ Intersection
This tool allows you to create an intersection point where a
breakline crosses the surface boundary or another breakline.
«  Shift Point
This tool allows you to shift a surface point.
Refer to 16.6 Volumes Toolbox Functions .

To finish surface creation, tap v
The "Save" screen is displayed.

To save the surface, enter the desired name and tap v

A The surface is cre-
Select Edit surface or Calculate volume .
from toolbox ated and displayed
on the map.
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16.2 Measure Volume and Make a Stockpile Calculation +[@3

Measure volume and i Requirements:
make_ a stockpile cal- e Surface file available in active job. It can be either previously cre-
culation step-by-step ated in the Volumes application (refer to 16.1 Create a Surface

), or imported as a reference (refer to Importing data to the
project step-by-step).

- To display different surfaces use Map view manager, refer to
Map View manager.

1. Select Volumes from the Home Menu.

2. Select a surface for measurement.

from toolbox

3. Select Calculate Volume from the Toolbox.

For the calculation method, select Stockpile.

.J-\

The calculated
volume of the selec-

Volume Calculation

IR o < fce alon
= EN oo 2EEE itk measuremegnt
“&mma - wmye  0ata is displayed.
Perimeter (m) 62.715
Highest elevation (m) 3.200
Lowest elevation (m) 0.000
Balanced site elev. (m) 1122

5. If needed, adapt the Expansion value: enter a positive ( = swell) or
negative ( = shrink) percentage value of the calculated volume.
The calculated volume is adapted immediately.
To accept the result, tap «. The "Save” screen is displayed.

6. To save, enter the desired name and tap «.
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16.3

Calculate Volumes to an Elevation +[@3

General description

Calculate volumes to
an elevation step-by-
step

o R

006784.001 h Elevation

Given:

Surface file available in active job. It can be either previously created in
the Volumes application (refer to 16.1 Create a Surface , steps 1 &
2), or imported as a reference (refer to Importing data to the project
step-by-step).

1.

Select Volumes from the Home Menu.

2

Tap the displayed surface to select it.

I= To display different surfaces use Map view manager, refer to Map

View manager.

Select Calculate Volume from the Toolbox.

m Volume Calculation

Calculation Method

Cre 3

Stockpile Surface to Elevation

ME S vy

Surface to Point Surface to Surface

)

Select Surface to Elevation in the Calcula-
tion Method screen.
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Screen for volume
calculation is dis-

Volume Calculation

|
ayed.
Elevation W 11.000 v 35.9281~ 69.928 P y
Offset Surface 4. 0.000 ‘ Total (m?) AN 34.000

Surface Area (m?) 251.857

Perimeter (m) 25.120

Enter the desired elevation.
+ If needed, enter the desired offset value for the selected sur-

face. To return back to the calculation screen, tap v
The volume is recalculated according to the new elevation and
displayed along with measurement data.

e If needed adapt the Expansion for Cut, Fill or both values: enter
a positive (= swell) or negative (= shrink) percentage value of
the calculated volume.

The calculated volume is adapted immediately.

For the graphical representation, you can set the Tolerance value
according to your needs.

All parts within the tolerance band are displayed in green, cut or

fill segments are shown matching the Cut/Fill colour indicators. By
default, the tolerance value is set to 10% of the difference between
the maximum Cut and the maximum Fill value.

To view the graphical representation, tap Cut/Fill Map. To return

back to the calculation screen tap v

The Cut/Fill Map

Cut/Fill map

A o el |nformation including

the graphic is also

part of the Volumes
report.

v 9.000

(¢} 1.600

7.000

A
T

To finish volume calculation, tap ¥ _The "Save" screen is displayed.

To save, enter the desired name and tap v

Select Surface to Point as a volume calculation method to calculate
the volume according to the height value of a specific point.

Select Surface to Surface as a volume calculation method to cal-
culate the volume between two separate surfaces. The calculated
volume is based on where the two surfaces overlap.
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16.4 Shift a Surface + [

Requirement:
Surface file available in active job. It can be either previously cre-
ated in the Volumes application (refer to 16.1 Create a Surface ),
or imported as a reference (refer to Importing data to the project
step-by-step).

To display different surfaces, use Map view manager. Refer to Map

Select Volumes from the Home Menu.

View manager.

Select an existing surface or create a sur-
face.

Select Edit surface or Calculate volume
from toolbox
4

Select Shift Surface from the Toolbox.
The toolbar for shifting surfaces is displayed
in map view.

Shift a surface step- =
by-step
5
1.
2.
3.
4.

To define the shift, either select a source point and a target point in
the map, or enter shift values to define the east, north and height
shift.

A preview of the
shifted surface is
displayed.

«  To switch source and target point or to invert the shift values,

tap .

« To clear the selected points or the entered shift values,

tap .

To cancel surface shift, tap x.

To accept and shift, tap . The "Save" screen is displayed.
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To save the surface, enter the desired name and tap v

——— [ he shifted surface
s created and dis

played in the map

view.
16.5 Define a Pond Fitting in an Existing Surface +[@3

General description

Existing surface
Pond outer edge*
Pond inner edge*
Pond floor*

Offset to floor lines*
Berm width*

Outer berm slope
angle*

Relative height dif-
ference

- | D AN oo

* Values to enter during Dimensioning process. For pond inner edge and
pond outer edge only the height is entered.

Given:

e Instrument is connected and set up.

e Surface file available in active job.

«  Known dimensions of the pond to be established.

= Note that main workflow refers to GPS. For Total Station press
Measure, then Store.

Define a Pond fitting 1. Select Volumes from the Home Menu.
in an existing surface ;

step-by-step
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Tap the displayed surface to select it.

box.

NewSurfaca  EditSurface

o,
o &

Calculate

ShiftSutace  Grioens

To display different surfaces use Map view manager.

S
4.
m Select pattem to proceed
Default Pattern
Pattern_60x45.ptr

Select the pattern according to your needs. During first-time use,
only the Default Pattern is available.

heights. Enter values for offset to floor
lines, berm width and outer berm slope.

5 . ) 2.000 [ Select pond floor lines and enter lengths.
&
[T 000

Select corner points and apply relative

7
H

000
25000
000
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Now dimension all necessary elements, as shown in the illustration
before:
« Define length and width of the pond floor.
Enter a relative height value for each of the four floor corner
points separately. These heights can vary.

Enter offset value to the floor lines at .
This value is the distance from the floor lines to the pond inner
edge.

«  Enter a relative height value for the pond inner or pond outer
edge. The same height is applied to all eight corner points.

Define the berm width at =

{

Define the outer berm slope angle at .

Save

C:/BuildAg: /7b128...N/bin/wil

Pattern1_60x45 .ptr

After defining all these values, you can save this pond as a user-
defined pattern. Tap Save, enter a name and tap «. In this case, the
software automatically proceeds to the next step.

Otherwise tap the next Wizard step m to proceed.

Define where to place the pattern at.
Pick the line that is used as insertion line.

Pick Insertion line.

A =

m T -

Proceed to the next step to apply the pattern:
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Select two points or a line to apply the

Define offsets and change the volume
tolerance if needed.

N 0.000

A 0.000

ol a8 5.000 ||

I
]

=

Select two points or a line as the reference line. If needed,

use M to switch the start point and end point of the active
line.

Use to flip the pattern across the reference line.

Enter an offset value along the line at 8] and offset value to

the line at IS , if needed.

- -
Define the volume calculation tolerance at BAEM. The smaller this
value is, the longer the calculation needs.
When finished, tap ¢ to accept.

9. Enter a name for the surface in the next screen, and tap ¢ to save.
Then enter a name for the pond geometry and tap ¥ to save.

10. In the final screen, the newly created pond is shown applied to the
selected surface.

I The newly created surface, including the pond, can now be used for
staking out, but the data can also be exported for machine use .
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16.6

I Example of the surface with pond, used in
Cut & Fill.

Measure Point ID

Volumes Toolbox Functions +[@3

Toolbox functions

286

Function

Description

New Surface

Measure as many points as required to create a
surface.

Edit Surface

Tap to edit a selected surface.
"Edit Surface" contains the same tools and func-
tions as "New Surface".

Calculate
Volume

Allows you to calculate the volume based on a
surface.

Manage Calcu-
lations

Allows you to view and delete already created

Volume calculations.

« To view details of a calculated result, tap the
arrow button to the right.

« To delete a calculated result, tap its name to
select it and tap ¢ to confirm deletion.

Merge Surfaces

Allows you to create a surface out of two or

more existing surfaces.

«  Select Merge Surfaces from the Toolbox.

e Select at least two existing surfaces to be
merged.

e To merge the surfaces, tap «.

Shift Surface

Allows you to create a surface by shifting an
existing surface.

Calculate Pit/
Pond

Allows you to define a pond fitting in an existing
surface.
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Toolbox Functions in Surface Creation Mode

Function

Description

Automatic Log-

ging

Set Autologging to On/Off. Select the Log-
ging Mode from 3D Distance, Distance and/or
Height, Time, or Time over a point and define
the Interval. Store on demand allows you to
record measurements anywhere in between, if
enabled.

Intersection

b4

Select a first line or two points for it. Select a
second line or two points for it.

At the position where the two lines are crossing,
store the upper or lower intersection point.

Shift Point

B

Allows you to shift the position of a point in all
three dimensions by entering shift values.

16.7 Information Bar Values I3 + @3
Description Type/lcon Description
Id ’ Point ID of the current point to record.
1{D)
E H East value at the current target position.
N n North value at the current target position.
H n Height at the current target position.
Code gy Code/layer for the next point to record.
=
Hz i only: Horizontal angle to the current target
E’ position.
v i 1.,« only: Vertical/zenith angle to the current
{ﬂL} target position.
sD i only: Slope distance to the last point meas-
é ured.
hD only: Horizontal distance to the last point
measured.
Surface Name of the selected surface.
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Type/lcon

Description

cQ1D GPS| only: Coordinate quality value for the
height information at the current position.

cQ 2D GPS| only: Coordinate quality values for the plain
information at the current position.

cQ3b €3 only: Coordinate quality values for a com-
bination of the height and the plain information
at the current position.

GDOP GPS| only: Geometric dilution of precision quality

value at the current position.
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17 How to Handle Slopes gg+&@3

General description Slopes is an application that allows to stake out regular slopes and batter
boards.

In general, the user defines a sloped reference plane. Afterwards positions can
be measured on the site and these measured positions are compared with the
sloped reference plane.

The application can be used for:

« Checks on a defined slope: The operator moves around the sloped area
and takes measurements to check if the current status is ok, below or
above the designed surface.

- Staking and mounting the batter board: To mark the design slope by
installing a board onto two pegs, that has the same slope as the design
and is exactly in the sloped designed plane.

- Finding the Daylight line: The intersection of the current real surface
and the designed surface is called Daylight line. This line is exactly the
place where the excavator needs to start digging off the ground to build
the designed slope.

« Finding the Daylight point: In this case a sloped line is used instead of
a sloped plane. The daylight point and how to get to this position are the
values of interest and can be used for inclined pile ramming or drilling.

The following is a step-by-step guide to using some of the key functions

in Slopes: a single line as reference together with a regular slope definition.
Afterwards the Daylight line can be marked and a batter board built up, start-
ing at that location.

Given:
e Instrument is connected and setup with known station and height.

= Note that main workflow refers to Total Station. For GPS press
Measure to record a point.

How to handle slopes 1. Select Slopes from the Home Menu. .
step-by-step ‘
2. Select the reference element.
The reference element can be a point, a line segment, an arc or a
polyline.
3. Define the slope.

Define the inclination of the slope _'—i' .

Inclination can be %, V:H, H:V or Elev. Angle, depending on the
current active setting for slope display.

Set the horizontal length - or the height [l of the slope.
The input can be toggled via the button.

If needed, set a horizontal and/or vertical offset N /2 for
the slope.
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g

A

A0

Tap to erase all entered values.

To change the direction of the slope (seen from start point to end

To change between increasing &4
the corresponding key.

Define the start and end points of the
base line

Tap |
the start and/or
end point of the
baseline.

Tap v to accept.

& & 110.000
\ -
\ 2
B 200.000 | {3

Once the slope is defined, tap v 1o accept.

The slope definition is stored within the application. When the next
element is selected, for example an arc or a line, the start and/or
end point of the baseline are reset while the slope is kept.

After defining the slope measurements can be started.

- Once a measurement is available, calculated values are dis-
played. The most important values are Cut/Fill as the height
difference between the measured point and the defined slope,
and the dHix value for the distance to the daylight line at the
height of the measured point.

- To change to cross-section view mode select Cross Section
from the Map Handler. The target is shown against the current
cross-section of the defined slope.
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How to define Slope
Lines & Model

BT .,

Measure  Point ID

segments WV or an

interval value [ to
create slope lines.

1. Select Slopes from the Home Menu. l
2. Select a line and define the slope. See also: How to handle slopes
step-by-step
3. From the Toolbox select Slope Lines &
Model.
The Map screen
is then displayed
showing the pro-
posed sloping lines.
& et
4. Enter the number of

Tap to erase all entered values.

How to Handle Slopes + @3
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Tap to create
a surface from the
defined slope.

=] Define values for the slope lines

Tap Eéad to calculate
the baseline of the

slope and the offset
line of the baseline.

-
Tap Kdnl to create
articulation lines in
the corners.

Define values for the slope lines
O

[
7N
c )

Tap ¢ 1o save the

slope lines and sur-
face model.

& -19.687] &+ -33.000

% 151.807
A 13313
dHix -13.338

000

——
- ure Point ID

The model will be stored as an *.xml file.
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Surface, baselines

Turn all On / Off [~ and Slope lines are
~  N11 Druids G...aul road.xml @ Stored on Separate
C layers.

- Slopelines-...7122752.xml @

i } Show Points

Slope_Lines_Slop...g_20210927122752

SlopeLines-Roa..0927122752.m [df]

AII

4//////

Base_line_Slope..10927122752.13d [ef |

Offset Line_So..10927122752.3d [] [&]

2|

R IEILENET

I The created file can be further used in other applications such as
Stakeout or Cut & Fill.

Toolbox functions Function

Description

Reference

Allows the user to select a reference line (for
example the centreline of a road model). The
information bar can be configured to show
chainage and offset values to the defined refer-
ence line.

Battered Pile

Allows the settings for tilted pile ramming and
delivers information for the Daylight point and
the referenced angle.

Edit Slope

Edit values of the defined slope, including hori-
zontal and vertical offset.

Slope Lines &
Model

Allows the user to create:

- 3D lines at desired intervals along the
defined slope mode

- the baseline and the offset line of the slope
model

- the surface defined by the slope model

Connect Points

Tap points to create a line or a polyline.

Stake Writer

Enable this option to get guidance on marking of
the stake.

For further details refer to: Using Stake Writer
step-by-step

Undo Undo previous action.
Delete Remove points/lines/arcs.
Information bar val- Type/lcon Description Pos.
ues = Pos. stands for the position in the following illustration.
|
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Type/lcon Description Pos.

Id ’ Name of the selected refer-

E@ ence line.

East value at the current tar-
get position.

North value at the current
target position.

Height at the current target
position.

Cut/Fill Cut/Fill value and colour j
indicator of the last point
measured, compared to the

design slope.

Design Design height at the meas- m

urement position.

Horizontal line value, from
measurement position to the
beginning of the sloped ref-
erence plane.

Lin

H. Diff Height difference, from the f
measurement position to the
beginning of the sloped ref-

erence plane.

Off Horizontal offset, from the g
measurement position to the
beginning of the sloped ref-

erence plane.

dHix Horizontal distance to the k

design slope.

dHPO Perpendicular height differ-  j/p
ence from the measured

position to the slope.

Max Maximum height for the n

defined slope.

Slope Slope angle of the reference |

slope.

= Depending on the
current active set-
ting for slope dis-
play, this value can
also be symbolised
as h:v, v:h, or %.
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Type/lcon Description Pos.
VOff ’ Vertical offset, as set in the C
1 slope definition.
HOff ’ Horizontal offset, as set in b
the slope definition.
Ref_Off i Horizontal distance from the b+g
baseline of the slope to the
! current target position.
Ref _Lin Line value at current target o]
position, along the baseline
of the slope.
dH_Ref ’ Height difference from the c+f
¢ baseline of the slope to the
— current target position.
ID of the selected baseline of a

Ref_Id

the slope.

Chainage at the measured
point along the selected ref-
erence line.

Line value at measured point
along the selected reference
line.

Offset value at measured
point to the selected refer-
ence line.

Height difference at meas-
ured point to the selected
reference line.

Define a code/layer for the
next point to record.

only: Horizontal angle
to the current target posi-
tion.

only: Vertical/zenith
angle to the current target
position.

only: Slope distance to
the last point measured.

Chainage

Proj.Lin ‘Q

Proj.Off X

Proj. H. Diff

Code =

i

V s
L=

sD .

T B

only: Horizontal dis-

tance to the last point meas-
ured.

How to Handle Slopes + @3
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Type/lcon Description Pos.
cQ1D

(GPS| only: Coordinate quality
value for the height informa-
tion at the current position.

cQ 2D [ only: Coordinate quality

values for the plain informa-
tion at the current position.

cQ 3D (GPS) only: Coordinate qual- -

ity values for a combination
of the height and the plain
information at the current
position.

GDOP [ only: Geometric dilution

of precision quality value at
the current position.

006794003

a Baseline (1 -> 2) | Elevation angle

b  Horizontal offset m Design height at current posi-
c \Vertical offset tion

d Reference slope n  Maximum height for the

e Sloped reference plane defined slope

f  Reference height offset o Line value at current target

g Reference offset position, along the baseline

h  Horizontal design value p Height difference, with calcu-
i Vertical design value lation perpendicular method

j Cut/Fill value chosen

k  dHix value: horizontal distance

to the design slope

296 How to Handle Slopes + @3



18

How to Use Machine Calibration

Machine calibration
workflow

The calibration screen

The

iCON site software offers a simple workflow for a Machine calibration.

Calibration results are automatically stored in the internal memory of the con-
troller. Additionally, the results can be saved to a USB stick. Transferring the
results to the machine control system using a USB stick helps to decrease
installation time.

The

The
=

MC Calibration application is available for:
Single-Boom Excavator

Dual-Boom Excavator

Wheel Loader

Snow Groomer

On-Cab Dozer

Tower Mounted Driller/Body Mounted Driller
Tower Mounted Piler/Body Mounted Piler

different workflows are described in the following chapters.

Before starting the machine calibration, ensure that the machine is
placed on a flat solid surface where it cannot move or sway.

Take care to use correct settings for Prism Type and Prism Height
when measuring the machine.

Always adhere to the instructions in the display.

When the calibration is done, enter or load the calibration results
to the machine. Do not move the machine before the values are
entered in the machine control system.

For excavators, more calibration options are available. Refer to 18.3
Additional Calibration Options for Excavators .

The

calibration screen is intended to guide you through the calibration pro-

cess. The screen consists of two sections:

Map screen (left section): This section displays a photorealistic picture
of the machine and the position of the points to be measured. You can
zoom and pan the picture if necessary.

Instructions and navigation (right section): This section displays
instructions as well as a detailed picture of the current point to be meas-
ured. Once all points in the current step are measured, tap Next to pro-
ceed to the next step.
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Example:

Start calibration with machine rotated as
in picture. The bucket should be kept in
the air in such a way that the machine
does not sway. Measure R1.

EDEE

18.1 Machine Calibration for Single Boom Excavators
Machine calibration = Make sure to set up the total station at a position that allows meas-
for single boom uring all points. Ideally, this position is at the front right side of the
excavators step-by- excavator about 10-15 m away from the machine.

step 1. Select MC Calibration from the Home Menu.

2. Select Single-Boom Excavator.

Calibration Options

Hidden Point

Measure hidden boom point A off

DogBone

DogBone Points off

Boom Sensors

Boom Sensor Points off

Boom Sensor Side Left b

Stick Sensor Point

The Calibration
Options screen is dis-
played.

If you want to calibrate the excavator including the additional
options, set the desired option to On.
For more information, refer to 18.3 Additional Calibration Options

for Excavators .

To accept, tap v

i Always adhere to the instructions in the display.

The calibration screen is displayed.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

I To remeasure points, tap the relevant point in the map screen and
confirm the warning message.
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6. Tap Next to proceed to the next calibration step. Follow the instruc-
tions on the screen.
Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

== Repeat until all points have been measured successfully.
You can go back to a previous step to remeasure points or to meas-
ure missing optional points. Select Back from the toolbox.

7. When all points have been measured successfully, the Machine calib-
ration results screen is displayed.

To accept, tap v

8. Before saving the calibration results, you can set the file location
and change the default file name.
To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v

To cancel the saving process and remeasure points, tap X
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results are
displayed.

= To display the calibration results again, select MC Calibration from
the Home Menu and tap Calibration Results.

18.2 Machine Calibration for Dual Boom Excavators
Machine calibration 1. Select MC Calibration from the Home Menu.
for dual boom excav-
ators step-by-step AL
2. Select Dual-Boom Excavator.

: Calibration Options
Measure hidden boom point A
DogBone Points
Boom Sensor Points
Boom Sensor Side Left b
Boom2 Sensor Side Left b The Ca /Ibra t’on

Options screen is dis-
played.

If you want to calibrate the excavator including the additional
options, set the desired option to On.

For more information, refer to 18.3 Additional Calibration Options
for Excavators .

To accept, tap ’/.

= Always adhere to the instructions in the display.

4. The calibration screen is displayed.
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18.3

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

To remeasure points, tap the relevant point in the map screen and
confirm the warning message.

Tap Next to proceed to the next calibration step. Follow the instruc-
tions on the screen.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

Repeat until all points have been measured successfully.
You can go back to a previous step to remeasure points or to meas-
ure missing optional points. Select Back from the toolbox.

When all points have been measured successfully, the Machine calib-
ration results screen is displayed.

To accept, tap ‘/.

Before saving the calibration results, you can set the file location
and change the default file name.

To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v

To cancel the saving process and remeasure points, tap X
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results are
displayed.

To display the calibration results again, select MC Calibration from
the Home Menu and tap Calibration Results.

Additional Calibration Options for Excavators

Excavator calibration

options

300

For excavators, the following extra calibration options can be included into the
full calibration procedure:

Hidden Point

DogBone

Boom Sensors

Measure Swing Boom Rotation Point

Stick Sensors (for example laser catcher)

DogBone and laser catcher can also be calibrated in a separate calib-
ration procedure.
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Hidden Point calibration

Whenever possible, calibrate the excavator by measuring point A. If point A is
not accessible, use the Hidden Point function.

16094.001

= Before starting the calibration procedure, make sure to set up the
total station at the correct distance. A correct setup allows you to
measure point AB1 which can be quite high. To obtain good results,
ensure that the points AB1, AB2 and AB3 are not measured close to

each other.

1. Fold the stick gently and lift the boom as high as possible. Measure
point ABI.

2. Lower the boom as low as possible. Ensure that the stick is folded.

Measure point AB2.

3. Lift the boom, position the stick vertically and put the bucket gently
on the ground. Measure point AB3.

I When calibrating a dual-boom excavator, ensure to keep the angle
between first and second boom the same while measuring AB1, AB2
and AB3.

DogBone calibration

When DogBone calibration is enabled, an extra step to measure the relevant
DogBone Points is added to the calibration procedure.
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Measure Swing Boom Rotation Point

When the Measure Swing Boom Rotation Point calibration option is
enabled, an extra step is added to the calibration procedure, in order to meas-
ure the boom rotation point in addition to the usual calibration points.

= Before starting the calibration, ensure that the boom is aligned with
the machine body so that no swing is applied.

Calibration of Boom Sensors and Stick Sensors

1= The stick sensor can be for example a laser catcher.

1. To include the Boom Sensors and Stick Sensors in the calibration
procedure, set the options to On.

Boom Sensors

Boom Sensor Points

Boom Sensor Side Left p

Stick Sensor Point

Stick Sensor Side Left p

== To calibrate the sensors correctly, make sure to set the side of the
Boom Sensor Points/Stick Sensor Point to Left or Right.

= Left side:
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18.4

=

Right side:

Machine Calibration for Wheel Loaders

Machine calibration
for wheel loaders
step-by-step

1. Select MC Calibration from the Home Menu. &;1
s |
2. Select Wheel Loader.
The calibration screen is displayed.
3. Enter pitch angle and roll angle.
To start calibration, tap v
= Always adhere to the instructions in the display.
4. Aim telescope to target point. Measure and store the target point
using the measure bar buttons.
I~ To remeasure points, tap the relevant point in the map screen and
confirm the warning message.
5. Tap Next to proceed to the next calibration step. Follow the on-
screen instructions.
Aim telescope to target point. Measure and store the target point
using the measure bar buttons.
== Repeat until all points have been measured successfully.
You can go back to a previous step to remeasure points or to meas-
ure missing optional points. Select Back from the toolbox.
6. When all points have been measured successfully, the Machine calib-
ration results screen is displayed.
To accept, tap v
7. Before saving the calibration results, you can set the file location and

change the default file name.
To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v

To cancel the saving process and remeasure points, tap 2 4 .
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results will be
displayed.
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18.5

= To display the calibration results again later, select MC Calibration
from the Home Menu and tap Calibration Results.

Machine Calibration for Snow Groomers

Important notes

304

Calibration setup

Before starting the calibration procedure, make sure to set up the
total station at a location from which you can measure all necessary
points. Fully extend the blade wings.

18151 001

It is recommended to use the Leica CPR111 TrueZero prism (761712)
for the calibration process.

Setting the cutting angle of the blade

18148001

1. Fully extend the blade wings and level the blade.

2. To set the cutting angle, pitch the blade until the main blade and
the blade wings are all at the same height and parallel to the
ground.

= Make sure that the blade is set to the correct cutting angle, as this
angle has a significant influence on the quality of the calibration
results.
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Measuring the GNSS positions

GNSS positions must be measured correctly. Before measuring the GNSS posi-
tions, make sure that you have entered the correct prism height. Take into
account the height of the thread.

18137.001

a Value of prism height to be entered in the software
b  True prism height
¢ Height of the thread

Machine calibration 5= Make sure the snow groomer is correctly set up for calibration. Refer
for snow groomers to section Important notes (Page 304).
step-by-step 1. Select MC Calibration from the Home Menu. &;1
|
2. Select Snow Groomer.
3. The Calibration Options screen is displayed.

Calibration Options

Measuring side Left b

Measure winch

»  Define the measuring side.
« If you want to calibrate the snow groomer including the winch,
set Measure winch to On.

To accept, tap ‘/.
The calibration screen is displayed. Refer to section The calibration
screenfPage 297).

= Always adhere to the instructions in the display.
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18.6

4. Enter pitch angle and roll angle.
To start calibration, tap v
a Roll angle (negative)
b Pitch angle (negative)
5. Aim telescope to target point. Measure and store the target point

using the measure bar buttons.

To remeasure points, tap the relevant point in the map screen and
confirm the warning message.

Tap Next to proceed to the next calibration step. Follow the instruc-
tions on the screen.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

Repeat until all points have been measured successfully.
You can go back to a previous step to remeasure points or to meas-
ure missing optional points. Select Back from the toolbox.

7. When all points have been measured successfully, the Machine calib-
ration results screen is displayed.
To accept, tap v

8. Before saving the calibration results, you can set the file location and

change the default file name.
To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v

To cancel the saving process and remeasure points, tap 2 .
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results are dis-
played.

To display the calibration results again, select MC Calibration from
the Home Menu and tap Calibration Results.

Machine Calibration for On-Cab Dozers

Setting up the dozer

306

1. Place the Machine on a flat surface.
Do not move the tracks of the machine during calibration.
2. Set the total station at a distance of 25-30 m

away from the machine in order to measure all the
necessary points, especially the rear GNSS position.
Make sure to measure all the machine points in 4 :
one set_up. Do not move the total station during e,
calibration. o
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Machine calibration
for dozers step-by-
step

Make sure that the blade is levelled and aligned
with the tracks. [T 1
( l.ln

Make sure that the blade is perpendicular to the
machine direction.

19445-001

Mount the GNSS antennas as close as possible to
the centre axis of the machine and at least 1 m
apart from each other.

Mount a prism or a tape at the centre of the blade to measure the
ARP points (arm rotation point). Make sure you measure always the
same spot with 0 m prism height.

When measuring the TP point, make sure to add the track thickness
to the prism height offset.

Select MC Calibration from the Home Menu.

En

| Bl |

Select On-Cab Dozer. N
The calibration screen is displayed. Refer to section
The calibration screen. 3

Always adhere to the instructions in the display.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

To remeasure points, tap the relevant point in the map screen and
confirm the warning message.

Tap Next to proceed to the next calibration step. Follow the on-
screen instructions.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

Repeat until all points have been measured successfully.
You can go back to a previous step to remeasure points. Select Back
from the toolbox.
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18.7

When all points have been measured successfully, the Machine calib-
ration results screen is displayed.

To accept, tap ’/.

Before saving the calibration results, you can set the file location and
change the default file name.

To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v

To cancel the saving process and remeasure points, tap X .
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results are dis-
played.

To display the calibration results again, select MC Calibration from
the Home Menu and tap Calibration Results.

Machine Calibration for Pilers and Drillers @3

Important notes

308

=

Depending on where the prisms/GNSS are located on the machine,
different parts of the machine must be measured.

Tower mounted machines

The prisms/GNSS are located on top of the tower.

Body mounted machines
The prisms/GNSS are located on the main body of
the machine.

IS

Before starting the machine calibration, ensure that the machine is
placed on a flat solid surface where it cannot move or sway. Ensure
that the tower is plumbed.

As it is not possible to measure all the required points using one instrument
setup, it is required to move the total station to another location during the
calibration process.

Before starting any piler or driller calibration

a)
b)
9]

Connect to a total station and ensure that it is levelled.

Set the tolerances to Precise.

Measure at least three to four control points around the machine.
Ensure the points are visible from the left, from the right and from the
front side of the machine.
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a Setup 1, right
side of
machine

b Setup 2, left
side of
machine

c Setup 3, front
side of
machine

19958.001

Setting up a tower- = Place the machine on a solid and flat surface.
mounted piler Do not move the tracks of the machine during calibration.

1. Extend the machine (boom and stick) to the maximum horizontal
reach if you measure the machine length (ML point).

Ensure that the tower is plumbed.

To measure the points visible from the right side of the machine:
Set up the total station at the right-hand side of the machine at

a distance so that it is possible to measure all the required points
(approximatelly 10 - 15 m away).

4. Place prisms/tapes at the following points on the machine.

Point C3 located along the center axis of
the boom.

19853.001

Point A located on the hinge joint.

=

19854001

(ma 'S 1

Point TD located at the bottom of the
tower.

(mm

19968001
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Optionally:

Point ML at the back of the machine.
Ensure the machine (boom and stick) is
extended to the maximum horizontal reach
if this point needs to be measured.

Optionally:
Point TC1 at the center of the tool.
Use a reflective tape or a mark on the tool.

‘ A =
(mm -

19970.001

To measure the points visible from the front side of the machine:
Setup the total station at the front side of the machine at a dis-
tance so that it is possible to measure all the required points, espe-
cially the point at the top of the tower.

Place prisms/tapes at the following points on the machine.

Point C1 along the central vertical axis of
the tower. Use a reflective tape or a mark
on the tower to measure.

Ensure that point C1 is aligned with C3.

19851 001

Point C2 along the central vertical axis of

the tower. The point must be located at

the top of the tower.

Use a reflective tape or a mark on the

tower to measure.

Ensure that point C2 is aligned with C1 and ’
C3.

19852 001

Two prisms on the top of the tower. Pos1
is the left prism (from drivers perspective)
and Pos2 is the right prism.

Ensure that the correct prism type is
applied to the measurements.

Ensure that the correct prism height is
applied if the the machine is to be used
with GNSS sensors.

19971 001
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Setting up a tower-
mounted driller

Place the machine on a solid and flat surface.
During the calibration, do not move the tracks on the left-hand side
of the machine (where the tool is visible).

Extend the machine (boom and stick) to the maximum horizontal
reach if you measure the machine length (ML point).

Ensure the tower is plumbed.

To measure the points visible from the side of the machine:

Setup the total station at the side of the machine where the tool is
visible, at a distance so that it is possible to measure all the required
points (approximatelly 10 - 15 m away).

If the tool is visible from the left side of the machine, setup the
total station on the left-hand side of the machine. Otherwise setup
the total station on the right-hand side of the machine.

Place prisms/tapes at the following points on the machine:

Point C3 located along the center axis of
the boom.

19974001

Point A located on the hinge joint.

Point TD located at the bottom of the
tower.

19976.001
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Point TC1 at the center of the tool. Use
a reflective tape or a mark on the tool.

19978001

Optionally:

Point ML at the back of the machine.
Ensure the machine (boom and stick)
is extended to the maximum horizontal
reach if this point needs to be meas-
ured. sy

19977001

To measure the points visible from the front side of the machine:
Setup the total station at the the front side of the machine at a
distance so that it is possible to measure all the required points
(especially the point at the top of the tower).

Place prisms/tapes at the following points on the machine.

Point C1 along the central vertical axis
of the tower. Use a reflective tape or a
mark on the tower to measure.

Ensure that point C1 is aligned with C3.

19972 001

Point C2 along the central vertical axis of
the tower. The point must be located at
the top of the tower.

Use a reflective tape or a mark on the
tower to measure. Ensure that point C2
is aligned with C1 and C3.

Ensure that point C2 is aligned with C1
and C3.

19973001
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Point TC2 at the center of the tool. Use
a reflective tape or a mark on the tool.

19979.001

Two prisms on the top of the tower.
Posl is the left prism (from drivers per-
spective) and Pos2 is the right prism.
Ensure that the correct prism type is
applied to the measurements.

Ensure that the correct prism height is
applied if the the machine is to be used
with GNSS sensors.

19980.001

Tower-mounted piler/  |f the boom is too short and C3 cannot be meas-

driller with short ured, enable the short boom option and measure

boom the points Refl and Ref2 located on the side of the
machine.

Refl is the front point and Ref2 the rear point.

19981 001

It is important to have the boom and tower aligned with the machine
body.
The points Refl and Ref2 must be also aligned with the boom.

a b
@:ﬁ'@"l‘*“' a Tool
N b GNSS antenna 2
© c GNSS antenna 1
d Reference point 1
< e Reference point 2
Setting up the piler/ 1. Place the machine on a solid and flat surface.
driller - Do not move the tracks of the machine during calibration.

Body mounted Ensure that the tower is plumbed.

To measure the points visible from the right side of the machine:
Set up the total station at the right-hand side of the machine at a
distance so that it is possible to measure all the required points.

4. Place prisms/tapes at the following points on the machine:
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Two prisms on the machine body. Pos1

is the left or rear prism and Pos2 is the

right or front prism. N
Ensure that the correct prism type is il M
applied to the measurements.

Ensure that the correct prism height is
applied if the the machine is to be used
with GNSS sensors.

If an MPR122 is used, apply 5 cm for the
prism height.

20223.001 1

Point C1 along the central axis of the
boom.

Point C2, along the central axis of the
boom.

Point C3, along the central axis of the
stick.

I Ensure that C1, C2 and C3 are
aligned.

Point A at the boom joint.

= If point A cannot be measured
directly, enable Hidden Boom
Joint option and measure the
stick joint at five different pos-
ition. Refer to 18.3 Additional
Calibration Options for Excav-
ators .

. (\L

evveeve=_— ———

19859 001

Points B and B2 located at the boom and
stick joints.

[ evwveeww=—— ——— ——

19862 001

Point B2 is optional, but must be meas-
ured when the driller has dual boom.

19863001
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Point C located at the hinge joint.
If @ piler has no stick, this measurement
can be skipped.

19866 001

Point TD located at the bottom of the
tower.

20224001

Optionally:
Point TU located at the rotation point of
the tower.

20264_001

For drillers only:

Optionally:

Point SL located at the swing rotation
center. Ensure that the correct prism
type and prism height are applied to the

e

[ evwveevw=—— ——— -

}d
measurement. ) Pr—
= When the machine supports |
. . L J

swing rotation, ensure that \ i

the boom is aligned with the

tracks before starting the cal- 19872.001

ibration.
Optionally:

Point GH at the machine tracks. Ensure
to add the track thickness to the prism
height value.

'Y

Eeewesewe - ———

_/
19871001
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Optionally:
Point ML at the back of the machine.

Point TC1 at the center of the tool. Use
a reflective tape or a mark on the tool.

== For drillers: Point TC1 is man-
datory to be measured. If
the tool is not visible from
the right-hand side, perform a
new setup at the side that can
be measured.

For pilers: Point TC1 is optional.

20265.001

5. To measure the points visible from the front side of the machine:
Setup the total station at the the front side of the machine at a
distance so that it is possible to measure all the required points.

6. Place prisms/tapes at the following points on the machine.

For drillers only:
Point TC2 at the center of the tool. Use
a reflective tape or a mark on the tool.

20266001
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For pilers only:

Point TF along the central axis of the
tower. Use a reflective tape or @ mark on
the tower.

19868_001

Optional for drillers only:

Point HR located along the central axis
of the tower. If the towers central axis is
aligned with the booms central axis, this
measurement can be skipped.

19867_001

Short boom If the boom is too short and C1, C2, C3 cannot

be measured, enable the short boom option. Meas-

ure the points Refl and Ref2 on the side of the

machine.

Refl is the front point and Ref2 the rear point.

= Boom and tower must be aligned with the

machine body.
Points Refl and Ref2 must be aligned with

20267.001

the boom.
a
=
®.~E§; ; Tool
= Reference point 1

Reference point 2
GNSS antenna 2
GNSS antenna 1

I
19959.001 e

T an oo

Non-rotating If the machine cannot rotate 360°, enable the relevant option in the configur-

machines ation screen.
= Place the machine on a solid and flat surface.

The machine must be levelled and the tower be plumbed.
Machine calibration 5= By default, the tolerance setting for a setup is 1.2 cm in position
for pilers/drillers and 1.6 cm in height. For an accurate calibration, stricter tolerances
step-by-step are recommended. Set the tolerances to Precise. Refer to Tolerance

settings.

1. Measure the control points around the machine. Refer to 4.3 Setup

Anywhere with Given Coordinates .
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Select MC Calibration from the Home Menu.

=

Ty

Select the calibration method.
The calibration screen is displayed. Refer to section The calibration
screen.

Always adhere to the instructions in the display.

Aim the telescope to the target point. Measure and store the target
point using the measure bar buttons.

To remeasure points, tap the relevant point in the map screen and
confirm the warning message.

Tap Next to proceed to the next calibration step. Follow the on-
screen instructions.

Aim telescope to target point. Measure and store the target point
using the measure bar buttons.

Repeat until all points for the first setup have been measured suc-
cessfully.

You can go back to a previous step to remeasure points. Select Back
from the toolbox.

To setup the total station at another location, follow the
instructions of the next step carefully. Otherwise the calibra-
tion has to be repeated from the beginning.

Before moving the total station, tap the i? Favourites key and
access Setup screen.

Move the total station to the second setup point and perform a
Coordinates - Anywhere setup by measuring the control points.
Refer to 4.3 Setup Anywhere with Given Coordinates .

Repeat measuring all other calibration points.

When all points have been measured successfully, the Machine calib-
ration results screen is displayed.

To accept, tap v

Before saving the calibration results, you can set the file location and
change the default file name.

To store the results onto a connected USB stick, tap Save to and
choose USB.

To save the results, tap v,

To cancel the saving process and remeasure points, tap X
After successfully measuring points again, execute a recalcula-
tion using Calculate from the Toolbox. The new results are dis-
played.

To display the calibration results again, select MC Calibration from
the Home Menu and tap Calibration Results.
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19 How to Create a Report g3 +E3
19.1 General Information + [

Available report types

How to configure the
template of a report

type

Following report types are available:
«  Checks

«  Verification

« Data Collection

e GNSS Base Setup

e GNSS Setup

e  GridLogging

e Quantify

« Roading

.  Stakeout

e TPS Setup

« Volume

= You can configure the template of a report type according to your

needs. Refer to How to configure the template of a report type.

=< GridLogging is only available with the Surface Pilot licence.
Verification is only available with the Point Cloud licence.

1. Select Reports from the Home Menu.
Reports Select Report Type
Report Settings Checks )
Data Collecti )
Default b
GNSS Base Setup )
File Format PDF »
GNSS Setup )
Layout Config Default b
Grid Logging )
Company Sample Construction
Quantify )
Roading )
4
2. To configure the template of a report type, tap the arrow button

) beside the name of the report type.

The column selection screen for the respective report type is dis-
played.
= The screenshot shows an example for Checks. Other
applications have different values to select/show.
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Reports Checks - Column Selection

Report Type Checks ~ | Project Details [\/
Job verautt » [ T
~ | Point v
File Format PDF » —
~  Radial v
Layout Config Default » —
~ | Polygonal/Block v
Company Sample Construction p E—
~ | Reference Line Point v
~ | Pointto line v

oy

3. « To display or hide the available columns of an information type,
tap the down/up arrow.
+ To select or deselect the desired columns to be displayed, tap
the check box of the respective column names.

« Tap .

4. To save the changes of the report template, tap «.

How to configure the

! : It is possible to configure the report to include a specific logo, address, contact
company information

details and footer. You can create several company profiles and apply them to
the report as needed.

1. Select Reports from the Home Menu.

2. To create, edit or delete a company profile, tap Company.

The Select Company screen is displayed.

Reports Select Company

Report Settings .
Sample Construction

Report Type >

Job Default p

File Format PDF »

Layout Config Default p

Company Sample Construction

To edit an existing company profile, tap the arrow button )
beside the company name.

The Company Details Configuration screen is displayed.

» To create a company profile, tap .

The Company Details Configuration screen is displayed.

4. Enter the necessary information below Company Information.
= Enter at least a company name.
To clear all entries, tap [i15.
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Reports

Company Details Configuration

Report Settings Company Information

> Company Name

Default » Address

File Format PDF » City

Company Sample Construction State/Province

\

\

\

Layout Config Default » Zip/Postal Code ‘
\

Country ‘

(

« To delete the selected company profile, tap

o.

I You can add a company logo as .jpeg or .png file. Save such files in

the internal memory or in the root directory of a removable data
storage device.

Logo size:
e Minimum: 10 x 10 pixels
«  Maximum: 102 x 1024 pixels

To add a company logo, scroll down to Company Logo.

« To display the available files, tap Company Logo.

« To set the source of the logo file, tap Search in.

« To display the preview of a logo file, tap the file name.
« To select the displayed logo file, tap «.

Select Logo

Search in Internal Memory Internal Memory
“ Removable Disk (E:)
No Logo

company_details_border.PNG >

company_header.PNG 4

company_logo.PNG 4

footer_border.PNG >

L 8

Select Logo

Storage location

feica
Search in Internal Memory b =

| Geosystems
[ A
No Logo
company_details_border.PNG 4
company_header.PNG 4

company_logo.PNG

footer_border.PNG 4
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== You can add a footer as .jpeg or .png file. Save such files in the
internal memory or in the root directory of a removable memory
device.
The procedure is the same as for a company logo.
Footer size:
¢ Minimum: 300 x 1500 pixels
«  Maximum: 10% of the height of the text or width size

6. To save the company profile, tap « .
The company profile is automatically selected for use in the next
report.
How to create a 1. Select Reports from the Home Menu.
report step-by-step ll_:EnI

The currently act-

Reports Select Report Type .
ive report set-
R Checks > tings are dis-
Report Type
Data Collection ) P layed'
Job Default »
GNSS Base Setup )
File Format PDF »
GNSS Setup )
Layout Config Default »
Grid Logging )
Company Sample Construction )
Quantify )
Roading )
U4
2. To start creating a report, tap the desired report type.

= TPS Setup respectively GNSS Setup and GNSS Base
Setup can only be used onboard a TPS with display, or
on the controller with the appropriate instrument being
connected.

3. The current active job is selected by default.
Tap Job to select another job containing the data for the report.

4. To define the desired file format of the report, tap File Format.
Available file formats:
e TXT, CSV, PDF and HTML
e For TPS onboard: TXT, CSV and HTML

5. To define the layout of a report in PDF or HTML format, tap Layout
Config.

== For information on configuring the layout for PDF data, refer to
19.2 How to Create a PDF Report.

To select the desired company profile, tap Company.

7. To create the report, tap «.
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19.2

i Depending on the report type, more settings are displayed.

«  For Data Collection, GNSS Base Setup, GNSS Setup,
Quantify, Roading, Stakeout or TPS Setup no additional set-
tings are required. Proceed to the next step.

«  For Checks, GridLogging, Volume and Verification, a list with
all available data is shown. Select the packages to be included in
the report.

- For Volume: If it is sufficient to get an idea of the coordin-
ates and to have short report in the end select Five Points
instead of All Points.

- For Verification: If it is not necessary to show all extrema
points in the report, select Ten Points instead of All
Points.

Tap ¢ to accept.

8. Select the storing location.
«  The data storage device can be the internal memory or a remov-
able data storage device.
« The location can be either the global Reports folder or the
Reports folder within a project.

i In the Save screen, you may change the default name to a user-
entered one.

9. To accept and save the report, tap ¢

i Depending on the file format selected, a preview is shown of what is
stored as Report file.
Tap « to accept.
The file is created at the chosen location.

i If the report template is configured to include images, the report
file and the images linked to the points are exported together into
the same directory. The images are in the subdirectory "Capturedim-
ages".

How to Create a PDF Report

General description

PDF is a special type of report that allows you to export selected information
in a nice layout.

The PDF report is printable but not editable.

For Checks and Volumes, the tables are shortened. Any information about
prism/antenna height, codes, satellites, quality and similar is not shown. If this
information is needed, create a report in another file format or create a Data
Collection report.

Necessary driver

For CC80 controllers delivered with v5.0 or higher, the necessary driver is
already installed.

For CC80 controllers upgraded to v5.0 or higher, download and install the
necessary driver (Component_PDFReports.exe) from myWorld under the sec-
tion CC8x Controller.

= Before installing the driver, make sure that iCON is not running.
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Generating a PDF
report

19.3

1. Select Reports from the Home Menu.

The currently active report type is displayed.

2. Tap Job to select another job containing the data for the report.
= The current active job is selected by default.
3. Select PDF as file format.

Configure the layout:
Tap Layout Config.
 No. of Data per Block: In the report, the information for a
point is broken up into several lines. Define the number of
points for which all information is shown before a new block
of points begins.
Example: When using 10, all information of the first 10 points
shown in one block
¢ No. of Columns: Define the number of columns. Up to 9
columns can be configured.
- PDF Elide at and TXT Elide at: Define the maximum number
of characters shown per column.
Default for PDF: 30, default for TXT Elide: 25
If an entry exceeds the defined number of characters, "..." is
added.
e To cancel the configuring process, tap ¥.
« To reset to default settings, tap 5.
To accept, tap ¢ .

Reports Layout Configuration

Report Settings No. of Data per Block ‘ 10

Report Type >
No. of Columns ‘7

Job Default »
PDF Elide at

File Format PDF »

TXT Elide at

Layout Config Default

Show Notes

Company Sample Construction »

To select the desired company profile, tap Company.

Tap v.

A preview is shown of what is stored as report file. Tap «.

O N oW

Select the storing location.
You may change the default name to a user-entered one.
Tap v.

How to Create a Quantifier Report

General description

324

Quantify is a special type of report that allows you to attribute costs to
surveyed points, lines, areas and volumes. Based on an imported cost file,
the software calculates the job costs according to the quantity of surveyed
features and the accordingly defined prices.
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Cost file
A cost file contains the following information:

Code

Name of the code. The name stands for the survey feature to which the
code is applied.

Description

Further description of the code.

Cost

Cost rate for the survey feature. Such rates are normally defined by con-
tract.

Entity Code

Type of entity to be used for quantifying. See code explanation in the
header of the cost file.

Example: If a line is measured using a code specified for the entity "point",
the line is not taken into account in the Quantifier report.

Attribute

Up to ten attributes can be defined for a code.

Basic steps for generating a Quantifier report

Start a new job.

Import a cost file containing the necessary codes for quantification.
Survey the applicable features to be included into the Quantifier report by
assigning the respective codes.

Generate and export a Quantifier report based on the contents of the job.

Importing a cost file
as codelist

== A sample cost file (sample pricelist. comma.csv) is included in the

system folder: "...\Documents\Leica Geosystems\iCON\Codes".

Save a copy and edit the cost file (*.csv) to your needs.

Import the cost file as a codelist.

&
-
i For information on importing data, refer to 2.2 Import, Export, or
Delete Data.
After import, edit the currency settings accord- m/ft
ing to your needs. Select Units from the Home
Menu.

Tap Currency and enter the currency name. Tap ¢ to save changes.

Measuring features
for quantification

There are two options to include measured features in the quantification pro-
cess:

Automatic quantification

Measured features are automatically included by assigning a code to the
measured feature.

This option applies to points, lines, polylines measured with a line code,
and closed polylines measured with an area code.

User-defined quantification

Measured features are added manually when generating the Quantifier
report.

This option applies to areas and volumes.

Refer to Generating a quantifier report.
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Automatic quantification

1. Create a new job.
In the "Create new job" wizard, activate the imported code list for
quantification.

2. In the Home Menu, select the desired application for measuring
points, lines, polylines or areas.
Map screen is displayed

i Configure the Measure bar to display Code. Refer to Measure bar.

3. Before measuring a feature, assign the respective code from the
cost file to include the feature in the quantification process. Tap
Code in the Measure bar and select a code from the list.
For detailed information, refer to Defining Code for Each Stored
Point .

i When all applicable items are measured, you can generate a Quanti-
fier report. Refer to Generating a quantifier report.

Generating a quanti- 5= Ensure that the active job contains the imported cost file.
fier report

1. Select Reports from the Home Menu.

Following screen is displayed:

Reports Select Report Type

R t Setti
) i Checks )

Report Type

Data Collection )
Job Default »

GNSS Base Setup )
File Format PDF »

GNSS Setup )
Layout Config Default »

Grid Logging )

Company Sample Construction p

Quantify )

Roading )

I Ensure that the selected job contains Quantify data.
If the selected job does not contain the required data, tap Job to
select another job containing the data for the report.

Select the desired file format.

3. To start creating the report, select Quantify and tap ¢ to accept.
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The screen for data selection is displayed.

Reports

Report Settings All

Quantify

Quantify - Selection

QUANTIFY b

File Format PDF )

Closed Polylines

Layout Config Default » Al

Company sample Construction » [l (=TSN
&3 SURF1.TRM

&3 SURF3.TRM )

4. Select a line to add the information to the report.
To select or deselect all list items, tap All.

To enable correct quantification of areas and volumes, assign a code
from the cost file:

Tap the arrow button ) beside the name of the respective area
or volume.

Following screen is displayed:

Code/Price/Type/Description

(© Concrete 35.20 Area Concrete Area

© meadow 30.00 Area area

Tap the desired code.

The screen for data selection is displayed again. )
A symbol beside the name of the area or volume
indicates that a code is assigned.

Tap ¥ when finished with data selection.

6. Select the storing location.

You may change the default name to a user-entered one.
Tap ¢.
=

The data storage device can be the internal memory or a
removable data storage device.

The location can be either the global Reports folder or the
Reports folder within a project.

7. The report is created at the chosen location.
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20 How to Use Cloud Services
20.1 How to Use Leica ConX
20.1.1 General Introduction
Description With a connection between the CC80 controller and the Leica ConX web page,
Leica ConX offers:
« View: Enables a remote user to access the controller to view or control
iCON site.
« Sync: To exchange data between the controller and a remote web page.
«  Track: Enables a remote user to track the current position of the sensor.
= To use this functionality an account is needed for the Leica ConX web
page. The license is handled on the controller. Ask your agency or
your Leica Geosystems representative for information about licensing
and how to get an account.
= An Internet connection on the controller is needed, either using a
LAN cable, a wireless local area network connection (WLAN/WiFi), or a
3G/4G modem.
20.1.2 Installing a SIM Card
= For information about how to insert a SIM card in the CC80 controller, please
refer to the documentation provided with the controller.
= - Keep the card dry.
e Use it only within the specified temperature range.
« Do not bend the card.
e Protect the card from direct impacts.
SO Failure to follow these instructions could result in data loss and/or permanent
damage to the card.
20.1.3 Operation
Leica ConX setup To use the Leica ConX functionality, perform following setup works in the
step-by-step given order:
1. Establish an Internet connection on the CC80 controller
OR

328

Establish an Internet connection on the total station
2. Pair the controller/total station to the Leica ConX web page
3. Connect the controller/total station to Leica ConX

Establish an Internet connection on the CC80 controller

1. Establish an Internet connection, using one of the following options:
« LAN cable
«  Wireless local area network connection (WLAN/WiFi)
+  3G/4G modem

== The Internet connection on the controller must be set up from Win-
dows, not from iCON site.

I WLAN/WIiFi connection cannot be used, when a sensor is already
connected with WLAN.
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When using the 3G/4G modem, open the Computer Settings >
Networks dialog and select the modem connection to be used.

If the iCON site software was exited, select iCON from the Start
menu within Windows to reenter.

(e

Ensure a correct Internet connection, by checking the wireless con-
nections icon in the Windows task bar.

Establish an Internet connection on the total station

=

Ensure that a SIM card is inserted.

Select Internet from the Home Menu.

Tap Connect/Disconnect and set either Mobile Data or WiFi to
On.

Before starting to connect to the Internet, ensure that the settings
are correct. Tap Settings.

Connection using Internal modem
«  Enter the PIN.
«  Tap Provider List, select a provider from the list and tap «.

== If Autoselection is set to On, the provider is selected

automatically.

= If Auto-Connect is set to On, the Internet connection is

established automatically after every restart.

= If APN is set to On, enter the APN ID and the password.

Connection using WiFi

«  Minimise or exit iCON site software.

»  Within Windows desktop, select Start\Settings\Network and
Dial-Up Connections to open the Network Connections dia-
logue.

« Hold the stylus on the TIWLNAPI1 icon. Select Enable from the
context menu. Close the dialogue.

« In the Windows taskbar, double-click the network icon. Switch
to the Wireless Information tab. Select a network from the list
and enter the network key.

«  To connect, click ok.

Once the connection is established, the network icon in the
taskbar turns blue.

«  Select iCON from the Start menu within Windows to reenter.

To start the Internet connection, select Connect/Disconnect again
and tap Start.

How to Use Cloud Services
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I The section "Progress" displays the status of
the device and the Internet connection.

Internet Connection
Connect/Disconnect ) Conncetion ﬁ
.
Settings >
Device TSPLS8E
Network No SIM

Note: It is required to restart the sensor in case you
want to switch the SIM card.

Pair the controller/total station to the Leica ConX web page

== This is only necessary for the first time the device is connected to
the Leica ConX web page.
For the first-time connection, continue with 1. to 3., otherwise pro-
ceed to Connect the controller/total station to Leica ConX

1. On the controller/total station:

Select Clouds m from the Home Menu.

+ Tap Leica ConX Settings. Set Host to conx.leica-geosys-
tems.com. Tap Start to start the pairing process.

« Aninformation screen is displayed, showing the pairing code. Be

sure to leave this screen open.

Settings

Host Ea»geosystems,com
Pairing Start | Pairing initiated
Device Not paired Leave this dialog open and enter the
following pairing code
| setngs ] s
Auto-Connect ' :
on the Leica ConX website.
Allow Tracking
Cancel

Allow Remote Control »

Project Notifications m
I .
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2.

On the remote computer:

«  Start a web browser. Google Chrome is recommended for best
performance.

+ (o to the Leica ConX web page: conx.leica-geosystems.com.

« Use your User name and Password to log in.

To use this functionality an account is needed for the
Leica ConX web page. The licence is handled on the con-
troller. Ask your agency or your Leica Geosystems repres-
entative for information about licencing and how to get an
account.

. Now create a Unit:

Select the Company or create a new one.

Select the Project, that the Unit should be assigned to. If
no project is available, create a project first.

Tap Configure, and select Units.

Tap the + icon.

Enter the desired Unit Name and set the Unit Type to Field
Crew. If desired, use Note to enter additional information.
Tap Next.

Set Equipment Type to iCON field. Tap Add Equipment to
create a Unit with the current settings.

+  To pair the instrument and the created (Web) Unit, enter the
pairing code displayed on the controller and tap Pair.
« Tap Finish to accept.

How to Use Cloud Services
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3.

On the controller/total station:

«  The pairing screen should have been replaced by a confirma-
tion that the pairing was successful. The device is now paired/
registered on the web page, and ready to connect.

« Tap OK to confirm the information.

+ The Leica ConXSettings screen is displayed. Ensure to set
Auto-Connect, Allow Tracking, Allow Remote (only control-
ler) and Project Notifications (only controller) according to the
intended use.

= Refer to Leica ConX settings for more information.

« Tap « to accept.

Settings

Host Fa»geosys(ems.com
Pairing complete
O 9 P Device Paired
paired to the Leica ConX server.
Auto-Connect [ on |
OK
Allow Tracking m
Allow Remote Control »

Project Notifications m

Connect the controller/total station to Leica ConX

1.

Select Clouds from the Home Menu. E

Tap Leica ConX Connect/Disconnect.

Tap Start.

After a successful connection, tap ¥ to accept.

Leica ConX Connection Connection

Connect/Disconnect > Connection Connection ﬁ

Settings >

Leica ConX Webpage
Device LAN Device LAN
Internet Connected Internet Connected
Leica ConX Not Connected Leica ConX Connected

The device is connected to the Leica ConX web page now and ready
for View, Sync and Track.

Sync, which provides file transfer to/from the Leica ConX web page,
is done using the normal Import and Export functions in iCON site.
Once connected to the Leica ConX web page, there will be a Leica
ConX entry in the list of Sources/Targets.

Connect/Disconnect 1.

Select Clouds from the Home Menu. E
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2. - Tap Leica ConX Connect/Disconnect.
- To connect the paired controller to the Leica ConX web page,
tap Start. To disconnect when already connected, tap Stop.
Tap « to accept.

Leica ConX Connection

Connect/Disconnect > Connection “
Settings >
Leica ConX Webpage

Device LAN

Internet Connected

Leica ConX Connected

Leica ConX settings 1. Select Clouds from the Home Menu. E

2. Tap Leica ConX Settings.

= Tap Leica ConX Webpage to open the Leica ConX web
page automatically in a web-browser.

3. « Set Auto-Connect to On, to connect the controller automatic-
ally to the Leica ConX web page after every startup of iCON site.

« To allow the software to send the position of the paired con-
troller to the Leica ConX web page, set Allow Tracking to On.

« Set Allow Remote to:

- View, to allow a remote user to connect and view the iCON
site software on the controller.

- Control, to allow a remote user to connect and control the
iCON site software on the controller.

- No, to block any remote user from connecting to the con-
troller.

«  Set Project Notifications to On, to receive a message every
time a new file is uploaded to the Leica ConX web page.

«  Set Sync data to On, to transfer the measured data to the
Leica ConX web page. The synchronisation of the measured data
takes place once every minute. To ensure correct transfer of
data, activate a valid coordinate system in the project on the
Leica ConX web page.

= When using a TPS, also assign a valid coordinate system

to the unit on the Leica ConX server. When using GPS, this
step is not required.
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Leica ConX Settings

ConnectDisconnect )

Host Ea-geosystems.com
Settings >
Leica ConX Webpage
Device Paired
Auto-Connect m
Allow Tracking m
Allow Remote Control »
Project Notifications

4. Tap « to accept.

i  If the settings for Allow Remote have been changed, Leica ConX
will automatically reconnect to the paired computer after tapping «

i Depending on the settings, different Status icons are displayed.
Refer to Cloud Services - status icons for more information.

i>= Refer to the Help function available on conx.leica-geosystems.com
for information about using the different functions on the Leica
ConX web page.

20.2 How to Use Autodesk BIM 360 Docs
How to connect to BIM 360 Docs is an online file storage and sharing platform from Autodesk.
BIM 360 Docs This service allows you to download or upload standard files, such as PDF,

DXF, DWG or IFC.

= BIM 360 Docs can only be used with the CC80 controller and requires
the BIM 360 licence.

= In order to connect to BIM 360 Docs, the account administrator
must add the Leica iCON app from the Autodesk App Store to
the Autodesk account. Additionally, iCON users must be added as
"project administrator” to the BIM 360 Docs project which they
would like to access for downloading or uploading files. Refer to the
Autodesk user guide.

= For further details refer to the following website:
https://leica-geosystems.com/products/construction-tps-and-gnss/
software/software-partners/autodesk/bim360docs

1. Select Clouds from the Home Menu. E
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2. Tap BIM 360 Settings.
Following screen is displayed:

Clouds Autodesk BIM 360

Bim 360 Autodesk BIM 360

Logout Start

3. To connect to the BIM 360 service, tap Start.
The Autodesk authorisation screen is opened in the default web

browser.
4. Log in to Autodesk with your credentials.
If necessary, create an account.
5. After login, following screen is displayed:
Authorize application "\

TestingApp is requesting permission for the following
information:

prodaccountl

Data

ALLOW

DON'T WANT TO AUTHORIZE? CANCEL

To establish a connection, tap Allow.

6. Once the connection has been established, you can go back to iCON
and import or export data to the BIM 360 server.

= Once logged in, you can repeatedly access your documents online
without having to log in each time.
In the background, the iCON software receives an authentication
token which is given to the BIM 360 server to get a refresh token.
The refresh token is saved in the Projects folder in iCON.
You can choose to save your login details using cookies on the
default web browser on your device.

7. When a connection to BIM 360 is established, then BIM 360 is avail-
able as a data source for import and export.
«  For instructions on how to import data, refer to Importing data
to the project step-by-step.
«  For instructions on how to export data, refer to Exporting data
step-by-step.
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20.3

= Speaf'cally for importing BIM 360 data:
As data source for import, select BIM 360. The iCON software
detects the companies on your account.
«  Select a company and a project at the same time from the list.
The folders within the selected project become available.
«  Select the file to import.

= Speaf'cally for exporting BIM 360 data:
For Destination, select BIM 360.
»  Select a folder on the BIM 360 server where the data is exported
to.
«  Select a project from the list.
»  Select the format.

e Tap «.
« Define a file name.
e Tap ¢.

How to Use Procore

How to connect to

Procore

336

Procore is a construction project management software which allows larger
teams of construction companies, project managers, contractors, and so on,
to collaborate on projects and share access to documents, planning systems
and data. It is designed to support input from many sources including forwar-
ded e-mails and PDFs. The customer is charged for this service on a per
project basis instead of a per user basis.

All file types which iCON supports can be downloaded or uploaded.

= Procore requires the Procore licence.
1. Select Clouds from the Home Menu. E
2. Tap Procore Settings.

Following screen is displayed:

Clouds Procore Drive

Connect/Disconnect Authorise iCON “

Settings Logout Start

Leica ConX Webpage

Bim 360

Procore

3. To connect to the Procore service, tap Start.
The Procore authorisation screen is opened in the default web
browser.

4. Log in to Procore with your credentials.

If necessary, create an account.

5. Once the connection has been established, you can go back to iCON
and import or export data to the Procore server.
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I Once logged in, you can repeatedly access your documents online
without having to log in each time.
In the background, the iCON software receives an authentication
token which is given to the Bricsys 24/7 server to get a refresh
token. The refresh token is saved in the Projects folder in iCON.
You can choose to save your login details using cookies on the
default web browser on your device.

6. When a connection to Procore is established, then Procore is avail-
able as a data source for import and export.
«  For instructions on how to import data, refer to Importing data
to the project step-by-step.
«  For instructions on how to export data, refer to Exporting data
step-by-step.

i Specifically for importing Procore data:
« As data source for import, select Procore. The iCON software
detects the companies on your account.
«  Select a company and a project at the same time from the list.
The folders within the selected project become available.
«  Select the file to import.

I~ Specifically for exporting Procore data:
»  For Destination, select Procore.
« Select a folder on the Procore server where the data is exported
to.
«  Select a project from the list.
«  Select the format.

e Tap v.

«  Define a file name.

e Tap v.
20.4 How to Use Bricsys 24/7
How to connect to Bricsys 24/7 is a construction project management software which allows
Bricsys 24/7 larger teams of construction companies, project managers, contractors, and

so on, to collaborate on projects and share access to documents, planning
systems and data. It is designed to support input from many sources including
forwarded e-mails and PDFs. The customer is charged for this service on a per
project basis instead of a per user basis.

All file types which are supported by iCON can be downloaded or uploaded.
= Bricsys 24/7 requires the Bricsys 24/7 licence.

1. Select Clouds from the Home Menu. E
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2. Tap Bricsys 24/7 Settings.
Following screen is displayed:

Clouds Bricsys 24/7

Username ‘

Bricsys 24/7

Authorise iCON

Password

Logout

3. Enter your login data.
If necessary, create an account.

4. To connect to the Bricsys 24/7 service, tap Start.
The Bricsys 24/7 authorisation screen is opened in the default web
browser.

5. Once the connection has been established, you can go back to iCON
and import or export data to the Bricsys 24/7 server.

= Once logged in, you can repeatedly access your documents online
without having to log in each time.
You can choose to save your login details using cookies on the
default web browser on your device.

6. When a connection to Bricsys 24/7 is established, then Bricsys 24/7
is available as a data source for import and export.
«  For instructions on how to import data, refer to Importing data
to the project step-by-step.
«  For instructions on how to export data, refer to Exporting data
step-by-step.

= Speaf'cally for importing Bricsys 24/7 data:
As data source for import, select Bricsys 24/7. The iCON soft-
ware detects the companies on your account.
« Select a company and a project at the same time from the list.
The folders within the selected project become available.
«  Select the file to import.

= Specifically for exporting Bricsys 24/7 data:
«  For Destination, select Bricsys 24/7.
+  Select a folder on the Bricsys 24/7 server where the data is
exported to.
«  Select a project from the list.
+  Select the format.

e Tap «.

« Define a file name.

e Tap ¢.
20.5 How to Use Bluebeam Studio
How to connect to Bluebeam Studio is a construction project management software which allows
Bluebeam Studio larger teams of construction companies, project managers, contractors, and

so on, to collaborate on projects and share access to documents, planning
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systems and data. It is designed to support input from many sources including
forwarded e-mails and PDFs. The customer is charged for this service on a per
project basis instead of a per user basis.

All file types which are supported by iCON can be downloaded or uploaded.

IS
1.

Bluebeam Studio requires the Bluebeam Studio licence.

Select Clouds from the Home Menu. E

2.

Tap Bluebeam Studio Settings.
Following screen is displayed:

Clouds Bluebeam Studio

Buetean s
Authorise iCON “

Logout

N 4

To connect to the Bluebeam Studio service, tap Start.
The Bluebeam Studio authorisation screen is opened in the default
web browser.

Log in to Bluebeam Studio with your credentials.
If necessary, create an account.

Once the connection has been established, you can go back to iCON
and import or export data to the Bluebeam Studio server.

Once logged in, you can repeatedly access your documents online
without having to log in each time.

In the background, the iCON software receives an authentication
token which is given to the Bluebeam Studio server to get a refresh
token. The refresh token is saved in the Projects folder in iCON.
You can choose to save your login details using cookies on the
default web browser on your device.

When a connection to Bluebeam Studio is established, then Blue-

beam Studio is available as a data source for import and export.

«  For instructions on how to import data, refer to Importing data
to the project step-by-step.

«  For instructions on how to export data, refer to Exporting data
step-by-step.

Specifically for importing Bluebeam Studio data:

» As data source for import, select Bluebeam Studio. The iCON
software detects the companies on your account.

«  Select a company and a project at the same time from the list.
The folders within the selected project become available.

»  Select the file to import.
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= Speaf'cally for exporting Bluebeam Studio data:
For Destination, select Bluebeam Studio.
«  Select a folder on the Bluebeam Studio server where the data is
exported to.
«  Select a project from the list.
«  Select the format.

e Tap v.
« Define a file name.
e Tap «.
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21 Check & Adjust
21.1 Overview
Description Leica Geosystems instruments are manufactured, assembled and adjusted to

Electronic adjustment

Mechanical
adjustment

Precise
measurements

Check & Adjust

the best possible quality. Quick temperature changes, shock or stress can
cause deviations and decrease the instrument accuracy. It is therefore recom-
mended to check and adjust the instrument from time to time. This check
and adjust can be done in the field by running through specific measurement
procedures. The procedures are guided and must be followed carefully and
precisely as described in the following chapters. Some other instrument errors
and mechanical parts can be adjusted mechanically.

The following instrument errors can be checked and adjusted electronically:

l, t Compensator longitudinal and transversal index errors

[ Vertical index error, related to the standing axis

C Horizontal collimation error, also called line of sight error
a Tilting axis error

ATR ATR zero point error for Hz and V - option

If the compensator and the horizontal corrections are activated in the instru-
ment configuration, every angle measured in the daily work is corrected auto-
matically.

The following instrument parts can be adjusted mechanically:
«  Circular level on instrument and tribrach

«  Optical plummet - option on tribrach

« Allen screws on tripod

To get precise measurements in the daily work, it is important:

e To check and adjust the instrument from time to time.

- To take high precision measurements during the check and adjust proced-
ures.

e To measure targets in two faces. Some of the instrument errors are elim-
inated by averaging the angles from both faces.

During the manufacturing process, the instrument errors are carefully determ-
ined and set to zero. As mentioned above, these errors can change and it is
highly recommended to redetermine them in the following situations:

« Before the first use

- Before every high precision survey

e After rough or long transportation

e After long working periods

e After long storage periods

e If the temperature difference between current environment and the tem-
perature at the last calibration is more than 20 °C
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Summary of errors to
be adjusted electron-
ically

21.2

Instrument error Effects Effects Elimination Automatic-
Hz \' with two ally correc-
face ted with
measure- proper
ment adjustment

C - Line of sight error v - 4 v

a - Tilting axis error v - 4 4

| - Compensator - 4 4 4
index error

t - Compensator v - v v
index error

i - Vertical index - v v v
error

ATR Collimation error v/ v - v

Preparation

21.3

Before determining the instrument errors, the instrument has
to be levelled using the electronic level.

The tribrach, the tripod and the underground should be stable
and secure from vibrations or other disturbances.

N The instrument should be protected from direct sunlight to

/}.\\\ avoid thermal warming.

// It is also recommended to avoid strong heat shimmer and air
turbulence. The best conditions are early in the morning or
with overcast sky.

Before starting to work, the instrument has to become acclimatised to the
ambient temperature. Take at least 15 minutes into account or approximately
2 minutes per °C of temperature difference from storage to working environ-
ment.

Even after adjustment of the ATR, the crosshairs may not be positioned
exactly on the centre of the prism after an ATR measurement has been
completed. This outcome is a normal effect. To speed up the ATR measure-
ment, the telescope is normally not positioned exactly on the centre of the
prism. These small deviations/ATR offsets, are calculated individually for each
measurement and corrected electronically. This means that the horizontal and
vertical angles are corrected twice: first by the determined ATR errors for Hz
and V, and then by the individual small deviations of the current aiming.

Combined Adjustment (I, t, i, c and ATR)

Description

342

The combined adjustment procedure determines the following instrument
errors in one process:

l, t Compensator longitudinal and transversal index errors
[ Vertical index error, related to the standing axis
C Horizontal collimation error, also called line of sight error
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ATR Hz ATR zero point error for horizontal angle option
ATRV ATR zero point error for vertical angle option

Combined adjustment

procedure step-by- ) . . .
step I Itis recommended to use a clean Leica circular prism as target. Do

not use a 360° prism.

The following description explains the most common settings:

1. «  For ATR calibration connect the device with the g8 T
Instrument.

« Select Devices from the Home Menu.
«  Select your instrument and tap the arrow.

== When being connected to an iCON iCR50, iCON iCR70 or iCON iCR80S
or to an iCON iCT30 via the controller, or when using the onboard
software of any iCON driven TPS, the TPS calibration report function
is available. For information on the calibration report, refer to Calib-
ration report .
The calibration report can also be exported. Refer to Exporting data
step-by-step.

2. Select Sensor Calibration.

»  Select the incl. ATR Calibration option if you like to calibrate
the ATR. For ATR callibration a Leica round prism is needed. For
Angle callibration no prism is required.

- If applicable, tap Report to view a list of all calibration reports.
Tap the name of a report to show the respective calibration
results.
If no calibration reports are available yet, the button is greyed
out.

To start calibration, tap v
Follow the wizard which guides through the calibration.

Sensor Sensor Calibration

Level/Compensator ) D incl. ATR Calibration
Sensor Calibration > Note:
Atmospheric Correcti... » Only use a Leica round prism to calibrate
the ATR
Reset Sensor >
Report iCR70_321536_... »
3. « Aim the telescope accurately at a target at about 100 m dis-

tance. The target must be positioned within £ 9°/+ 10 gon of the
horizontal plane. Start the procedure in telescope face one.

»  Press the measurement keys to measure and to continue to the
next step.

»  Motorised instruments change automatically to face one after
tapping on the next measurement.

«  For ATR calibration the target must be a Leica round prism.

= The fine pointing has to be performed manually in both
faces.
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Vertical angle 9.002 Aim the telescope accurately at a target from

about 100m distance. The target must be
Note: Fine aim the instrument positioned within + 10 gon of the horizontal
every time before measuring plane.

l 1st Measurement in Face | ‘

| 2nd Measurement in Face || ‘

| 3rd Measurement in Face | ‘

| 4th Measurement in Face | ‘

Tap m in the wizard to get to the next page.

» Aim the telescope accurately at a target at about 100 m distant
or less if not possible. The target must be positioned at least
27°/30 gon above or beneath the horizontal plane.

«  Press the measurement keys to measure and to continue to the

next step.

Motorised instruments change automatically to the other face.

= The fine pointing has to be performed manually in both
faces.

Vertical angle 30.889 Aim the telescope accurately at a target from
about 100m distance or less if not possible.

Note: Fine aim the instrument The target must be positioned at least 30 gon

every time before measuring above or beneath the horizontal plane. ,, ,7-

i 1st Measurement in Face | l

‘ 2nd Measurement in Face | |

‘ 3rd Measurement in Face | |

‘ 4th Measurement in Face |l |

X

Adjustment Accuracy

After pressing the last [i
stored to the instrument.

in the wizard, the results are shown and

e,

Compensator longitudinal index error

Qld: 0.0000 New: 0.0000
Compensator transversal index error

Qld: 0.0000 New: 0.0000
Vertical index error

Old: 0.0000 New: 0.0000
Tilt axis error

Qld: -0.0007 New: -0.0145
Line of sight error

Old: -0.0001 New: 0.0020

Tap v to get back to the Devices page.
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Calibration report The purpose of the calibration report is a documentation of the results of the

field calibration. The report proofs the quality of the equipment for quality
insurance.

At the end of the sensor calibration, a report (*.calibration) is created auto-
matically. The report contains all calibration values.

The report is stored on the hard drive of the controller (for instruments with
keyboard unit only):

« Local Disk (C:) » Users > Public > Public Documents > Leica Geosystems > iCON > Reports

~ Name Date modified Type Size

MachineCalibration 19.11.2018 13:46 File folder
TPS Calibration 29.11.2018 08:53 File folder

The reports and results of past calibrations can also be exported.

Select Export from the Home Menu. Tap within the section Details and select
TPS Calibration.
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Software Licence Agreement/Warranty

Software Licence

Agreement

Open source informa-

tion

346

This product contains software that is preinstalled on the product, or that

is supplied to you on a data carrier medium, or that can be downloaded

by you online according to prior authorisation from Leica Geosystems. Such
software is protected by copyright and other laws and its use is defined and
regulated by the Leica Geosystems Software Licence Agreement, which covers
aspects such as, but not limited to, Scope of the Licence, Warranty, Intellectual
Property Rights, Limitation of Liability, Exclusion of other Assurances, Govern-
ing Law and Place of Jurisdiction. Please make sure, that at any time you

fully comply with the terms and conditions of the Leica Geosystems Software
Licence Agreement.

Such agreement is provided together with all products and can also be
referred to and downloaded at the Leica Geosystems home page at

Hexagon — Legal Documents or collected from your Leica Geosystems distrib-
utor.

You must not install or use the software unless you have read and accepted
the terms and conditions of the Leica Geosystems Software Licence Agree-
ment. Installation or use of the software or any part thereof, is deemed to
be an acceptance of all the terms and conditions of such Licence Agreement.
If you do not agree to all or some of the terms of such Licence Agreement,
you must not download, install or use the software and you must return

the unused software together with its accompanying documentation and the
purchase receipt to the distributor from whom you purchased the product
within ten (10) days of purchase to obtain a full refund of the purchase price.

The software on the product may contain copyright-protected software that is
licensed under various open source licences.

Copies of the corresponding licences

« are provided together with the product (for example in the About panel of
the software)

+ can be downloaded on http://opensource.leica-geosystems.com/icon

If foreseen in the corresponding open source licence, you may obtain the
corresponding source code and other related data on http://opensource.leica-
geosystems.com/icon.

Contact opensource®@leica-geosystems.com in case you need additional
information.
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